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Welcome to MicroEJ developer documentation. Browse the following chapters to familiarize yourself with MicroEJ
Technology and understand the principles of app and platform development with MicroEJ.

The Glossary chapter describes MicroEJ terminology.
The Overview chapter introduces MicroEJ products and technology.
The Application Developer Guide presents Java applications development and debugging tools.

The Platform Developer Guide teaches you how to integrate a C Board Support as well as simulation config-
urations.

The Kernel Developer Guide introduces you to advanced concepts, such as partial updates and dynamic app
life cycle workflows.

The Tutorials chapter covers a variety of topics related to developing with the MicroEJ ecosystem.
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CHAPTER

ONE

MICROEJ GLOSSARY

This glossary defines the technical terms upon which the MicroEJ Virtual Execution Environment is built.

Add-On Library A MicroEJ Add-On Libraryis a pure managed code (Java) library. It runs over one or more MicroEJ
Foundation Libraries.

Abstraction Layer An Abstraction Layer is the C code that implements a Foundation Library’s low-level APIs over
a board support package (BSP) or a C library.

Application A MicroEJ Application is a software program that runs on a Powered by MicroEJ device.

Standalone Application MicroEJ Standalone Application is a MicroEJ Application that is directly
linked to the C code to produce a MicroEJ Mono-Sandbox Firmware. Itis edited using MicroEJ
SDK.

Sandboxed Application A MicroEJ Sandboxed Application is a MicroEJ Application that can run
over a MicrokEJ Multi-Sandbox Firmware. It can be linked either statically or dynamically.

System Application A MicroEJ System Application is a MicroEJ Sandboxed Application that is
statically linked to a MicroEJ Multi-Sandbox Firmware, as it is part of the initial image and
cannot be removed.

Kernel Application A MicroEJ Kernel Application is a MicroEJ Standalone Application that imple-
ments the ability to be extended to produce a MicroEJ Multi-Sandbox Firmware.

Architecture A MicroEJ Architecture is a software package that includes the MicroEJ Core Engine port to a target
instruction set and a C compiler, core MicroEJ Foundation Libraries (EDC, [BON], [SN/], [KF]) and the MicroEJ
Simulator. MicroEJ Architectures are distributed either as evaluation or production version.

Core Engine MicroEJ Core Engine is a scalable runtime for resource-constrained embedded devices running on
32-bit microcontrollers or microprocessors. MicroEJ Core Engine allows devices to run multiple and mixed
Java and C software applications.

Firmware A MicroEJ Firmware is the result of the binary link of a MicroEJ Standalone Application with a MicroEJ
Platform. The firmware is a binary program that can be programmed into the flash memory of a device.

Mono-Sandbox Firmware A MicroEJ Mono-Sandbox Firmware is a MicroEJ Firmware thatimple-
ments an unmodifiable set of functions. (previously MicroEJ Single-app Firmware)

Multi-Sandbox Firmware A MicroEJ Multi-Sandbox Firmware is a MicroEJ Firmware that imple-
ments the ability to be extended, by exposing a set of APIs and a memory space to link MicroEJ
Sandboxed Applications. (previously MicroEJ Multi-app Firmware)

Foundation Library AMicroEJ Foundation Libraryis a library that provides core or hardware-dependent function-
alities. A Foundation Library combines managed code (Java) and low-level APIs (C) implemented by one or
more Abstraction Layers through a native interface (SNV/).

Mock A MicroEJ Mock is a mockup of a Board Support Package capability that mimics an hardware functionality
for the MicroEJ Simulator.
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Module Manager MicroEJ Module Manager downloads, installs and controls the consistency of all the dependen-
cies and versions required to build and publish a MicroEJ asset. It is based on Semantic Versioning specifi-
cation.

Platform A MicroEJ Platform integrates a MicroEJ Architecture, one or more Foundation Libraries with their re-
spective Abstraction Layers and the board support package (BSP) for the target Device. It also includes asso-
ciated MicroEJ Mocks for the MicroEJ Simulator.

SDK MicroEJ SDK allows MicroEJ Firmware developers to build a MicroEJ-ready device, by integrating a MicroEJ
Architecture with both Java and C software on their device.

Simulator MicroEJ Simulator allows running MicroEJ Applications on a target hardware simulator on the devel-
oper’s desktop computer. The MicroEJ Simulator runs one or more MicrokEJ mock that mimics the hardware
functionality. It enables developers to develop their MicroEJ Applications without the need of hardware.

Studio MicroEJ Studio allows application developers to write a MicroEJ Sandboxed Application, run it on a Virtual
Device, deploy it on a MicroEJ-ready device, and publish it to a MicroEJ Forge instance.

Virtual Device A MicroEJ Virtual Device is a software package that includes the simulation part of a MicroEJ
Firmware: runtime, libraries and application(s). It can be run on any PC without the need of MicroEJ Stu-
dio. In case a MicroEJ Multi-Sandbox Firmware, it is also used for testing a MicroEJ Sandboxed Application
in MicroEJ Studio.
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CHAPTER

TWO

OVERVIEW

2.1 MicroEJ Editions

2.1.1 Introduction
MicroEJ offers a comprehensive toolset to build the embedded software of a device. The toolset covers two levels
in device software development:

+ MicroEJ SDK for device firmware development

+ MicroEJ Studio for application development

The firmware will generally be produced by the device OEM, it includes all device drivers and a specific set of Mi-
croEJ functionalities useful for application developers targeting this device.

QA Platform Firmware @ Application | ;1 ulator
Sources

Sources
MICROEJ. 5DK MICROEJ Studic
Firmware Developer Host Application Developer Host
Import Build
Virtual
Device
Build
I
Target Local Deploy
- MICROEJ
- irmware | ——— APPLICATION
Build Flash — (7) —
L7 Install N Publish

MICROEJ.Forge

Fig. 1: MicroEJ Development Tools Overview

Using the MicroEJ SDK tool, a firmware developer will produce two versions of the MicroEJ binary, each one able
to run applications created with the MicroEJ Studio tool:

+ A MicroEJ Firmware binary to be flashed on OEM devices;
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« AVirtual Device which will be used as a device simulator by application developers.
Using the MicroEJ Studio tool, an application developer will be able to:

« Import Virtual Devices matching his target hardware in order to develop and test applications on the Simu-
lator;

« Deploy the application locally on an hardware device equipped with the MicroEJ Firmware;

« Package and publish the application on a MicroEJ Forge Instance, enabling remote end users to install it on
their devices. For more information about MicroEJ Forge, please consult https://www.microej.com/product/
forge.

2.1.2 Determine the MicroEJ Studio/SDK Version

In MicroEJ Studio/SDK, go to Help > About MicroEJ SDK menu.

In case of MicroEJ SDK 4.1 .x, the MicroEJ SDK version is directly displayed, suchas 4.1.5:

A About MicroEl® SDK

MicroEl® SDE

Version 4.1.5

Copyright ©2016-2018 1527 5.4, All Rights Reserved.

Use of this program is subject to Microk) License Agreement.

MicroE)® SDK is built on Eclipse, licensed under the terms of the Commen Public
License (CPL).

MicroEl® 50K and the MicreEl) logos are tradernarks of MicroE) 5.4,

CSEHOFPFS I EBwEDF

3 . .
@ Installation Details

In case of MicroEJ SDK 5. x , the value displayed is the MicroEJ SDK distribution, suchas 19.05 or 20.07:

2.1. MicroEJ Editions 5
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= About MicroEl

Copyright ©2018-2020 Microb) Corp. All Rights Reserved.

Use of this program is subject to MicroE) License Agreement.

MicroE)® SDK is built on Eclipse, licensed under the terms of the Common
r Public License (CPL).

MicroEl® 5DK and the MicrokE) logos are trademarks of MicroB) Corp.

CSEOFPF O JE WS

® Installation Details

To retrieve the MicroEJ SDK version that is currently installed in this distribution, proceed with the following steps:
o Clickonthe Installation Details button,
o Clickonthe Installed Software tab,

+ Retrieve the version of entry named MicroEJ SDK (or MicroEJ Studio).

K Installation Details

Installed Software |nstallation History Features Plug-ins Coenfiguration

Name Version Id Provider
@= C/C++ Development Tools SDK 9.4.3.201802261533  org.eclipse.cdt.sdk.feature.group Eclipse COT
[k C/C++ GCC Cross Compiler Support 9.4.3.201802261533  org.eclipse.cdt.build.crossgec.feature.group  Eclipse COT
[ C/C++ GDB Hardware Debugging 9.4.3.201802261533  org.eclipse.cdt.debug.gdbjtag.feature.gro... Eclipse COT
[{f- Eclipse Checkstyle Plug-in 6.8.0.201507251301  net.sf.eclipsecs.feature.group http:/Yeclipse-cs.sfu
@ Eclipse Runner Feature 1.34 com.eclipserunnerfeature feature.group Eclipse Runner Tean
@: Eclipse SDK 4.7.3.M20180330-06... org.eclipse.sdk.ide Eclipse.org
@: Eclipse XML Editors and Tools 3.9.2,:201803221834  erg.eclipse.wstxml_uifeaturefeature.group Eclipse Web Tools P
@: Git integration for Eclipse 4.9.2.201712130930-r  org.eclipse.egit.feature.group Eclipse EGit
@: JAutodoc 1.13.0 net.sf,jautodec.feature feature.group Martin Kesting
(= Markdown Editor 0.2.3 markdown.editor.feature.feature.group Winterwell
i i Joldeded?00728-1506  com.is2t.microej.mpp-feature feature.gro...  MicroEl
5.2.0 com.is2t.microej.sdk.feature.feature.group  MicroEJ
- LLUZ0I00728-1306  com.is2t.microgj.mpp.product.feature.fea.. MicroE)
@ Mylyn WikiText 3.0.792001711172000  erg.eclipse.mylynwikitext_featurefeature.... Eclipse Mylyn
@: PMD Plug-in 4.0.5720141105-1906  net.sourceforge.pmd.eclipsefeature.group PMD Project
@: Sonarlint for Eclipse 4.0.0.201810170711  org.sonarlint.eclipse featurefeature.group  SonarSource

2.1. MicroEJ Editions 6
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2.2 Licenses

2.2.1 License Manager Overview

MicroEJ Architectures are distributed in two different versions:

« Evaluation Architectures, associated with a software license key. They can be downloaded at https://
repository.microej.com/architectures/.

« Production Architectures, associated with a hardware license key stored on a USB dongle. They can be re-
quested to our support team.
The license manager is provided with MicroEJ Architectures and then integrated into Platforms, consequently:

« Evaluation licenses will be shown only if at least one Evaluation Architecture or Platform built from an Eval-
uation Architecture has been imported in MicroEJ SDK.

« Production licenses will be shown only if at least one Production Architecture or Platform built from a Pro-
duction Architecture has been imported in MicroEJ SDK.

See sections MicroEJ Architecture Import and MicroEJ Platform Import for more information.

The list of installed licenses is available in MicroEJ SDK preferences dialog page in Window > Preferences >
MicroEJ :

= Preferences l el X

type filter text MicroEJ & i
Checkstyle -
Copyright

- Data Management MicroEl repository
EasyantdEclipse

> Help

> IceTea

» Install/Update
Instant Messaging

> Ivy

> Java

4 MicrokEl
Architectures

Naming Convention

General settings for MicroEl development:

CAPvruntime-Mew_configuration'repo Browse... I | Refresh

Licenses

m

License Id Edition License Tags Expiration Date  Packs Add...
'_ XFRYS-J2MSN-Y3MAS-RBK46 | 5TD 1S2T_J8F5C o 2020-12-31

Remove

Platforms
Platforms in workspace
Updates

I Restore Defaultsl [ Apply ]

|\/'_7\| [ QK ] I Cancel I

Fig. 2: MicroEJ Licenses View

2.2.2 Evaluation Licenses
This section should be considered when using Evaluation Architectures, which use software license keys. Amachine

UID needs to be provided to activate an Evaluation license on the MicroEJ Licenses Server. The machine UIDisa 16
hexadecimal digits number.

Get your Machine UID

Retrieving the machine UID depends on the kind of MicroEJ Platform being evaluated.

2.2. Licenses 7
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If your MicroEJ Platform is already imported in Package Explorer and built with MicroEJ Module Manager, the Mi-
croEJ Architecture has been automatically imported. The machine UID will be displayed when building a MicroEJ
Standalone Application on device.

[INFO 1 Launching in Evaluation mode. Your UID is XXXXXXXXXXXXXXXX.
[ERROR] Invalid license check (No license found).

Otherwise, a MicroEJ Architecture or Platform should have been manually imported from the MicroEJ SDK prefer-
ences page. The machine UID can be retrieved as follows:

« Goto Window > Preferences > MicroEJ ,

« Select either Architectures or Platforms ,

« Click on one of the available Architectures or Platforms,

« Pressthe GetUID button to getthe machine UID.

Note: To accessthis GetUID option, at least one Evaluation Architecture or Platform must have been imported
before (see License Manager Overview).

Copy the UID. It will be needed when requesting a license.

& UID successfully generated @

Your UID was successfully generated.

Your UID is:  |A856470297673E28

Fig. 3: Machine UID for Evaluation License

Request your Activation Key

« Go to MicroEJ Licenses Server https://license.microej.com.

« Clickon Create a new account link.

« Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and log in with your new account.

+ Click on Activate a License .
« Set Product P/N: to 9PEVNLDBU6IJ.
« Set UID: to the machine UID you copied before.

« Clickon Activate .

« The license is being activated. You should receive your activation by email in less than 5 minutes. If not,
please contact contact our support team.

2.2. Licenses 8
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« Once received by email, save the attached zip file that contains your activation key.

Install the License Key

If your MicroEJ Platform is already imported in Package Explorer and built with MicroEJ Module Manager, the license
key zip file must be simply dropped to the ~/.microej/licenses/ directory (create it if it doesn’t exist).

» ThisPC » Local Disk (C:) » Users » user » .microgj » licenses
MName Date modified Type Size
REW2Z-XSTRL-5ZYUE-K33DCzip 30/08/2020 12:27 Compressed (zipp... 1KB

Fig. 4: MicroEJ Shared Licenses Directory

Note: The MicroEJ SDK Preferences page will be automatically refreshed when building a MicroEJ Standalone
Application on device.

Otherwise, the license key must be installed as follows:
+ Go back to MicroEJ SDK.

« Selectthe Window > Preferences > MicroEJ menu.

« Press Add... .

« Browse the previously downloaded activation key archive file.

« Press OK. A new license is successfully installed.

+ Go to Architectures sub-menu and check that all Architectures are now activated (green check).
« Your MicroEJ SDK is successfully activated.

If an error message appears, the license key could not be installed. (see section Troubleshooting). A license key can
be removed from the key-store by selecting it and by clicking on Remove button.

Troubleshooting
Consider this section when an error message appears while adding the Evaluation license key. Before contacting
our support team, please check the following conditions:

+ Key is corrupted (wrong copy/paste, missing characters, or extra characters)

+ Key has not been generated for the installed environment

+ Key has not been generated with the machine UID

« Machine UID has changed since submitting license request and no longer matches license key

+ Keyhasnotbeen generated for one of the installed Architectures (no license manager able to load this license)

2.2. Licenses 9
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= Invalid activation key w

The key could not be installed in this environment. Possible reasons are:

- key is corrupted,

- key is valid but does not match any available license manager(s), (Works for an
other edition),

- key has not been generated for this machine,

- old key version.

Fig. 5: Invalid License Key Error Message

2.2.3 Production Licenses

This section should be considered when using Production Architectures, which use hardware license keys stored
on a USB dongle.

= 12345678

Fig. 6: MicroEJ USB Dongle

Note: If your USB dongle has been provided to you by your sales representative and you don’t have received an
activation certificate by email, it may be a pre-activated dongle. Then you can skip the activation steps and directly
jump to the Check Activation on MicroEJ SDK section.

Request your Activation Key

+ Goto license.microej.com.
« Clickon Create a new account link.

« Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and login with your new account.

« Clickon Activate a License .

« Set Product P/N: to The P/N on the activation certificate.

2.2. Licenses 10
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« Enter your UID: serial number printed on the USB dongle label (8 alphanumeric char.).
+ Clickon Activate and check the confirmation message.

+ Click on Confirm your registration .

+ Enter the Registration Code provided on the activation certificate.

o Clickon Submit .

« Your Activation Key will be sent to you by email as soon as it is available (12 business hours max.).

Note: You can check the My Products page to verify your product registration status, the Activation Key avail-
ability, and download the Activation Key when available.

Once the Activation Key is available, download and save the Activation Key ZIP file to a local directory.

Activate your USB Dongle

This section contains instructions that will allow you to flash your USB dongle with the proper activation key.
You shall ensure that the following prerequisites are met :

« Your operating system is Windows

+ The USB dongle is plugged and recognized by your operating system (see Troubleshooting section)

« No more than one USB dongle is plugged into the computer while running the update tool

« The update tool is not launched from a network drive or a USB key

The activation key you downloaded is the one for the dongle UID on the sticker attached to the dongle (each
activation key is tied to the unique hardware ID of the dongle).

You can then proceed to the USB dongle update:
« Unzip the Activation Key file to a local directory
« Enter the directory just created by your ZIP extraction tool.
« Launch the executable program.

« Accept running the unsigned software if requested (Windows 10)

2.2. Licenses 1
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update.exe

Publisher: Unknown
File origin: Hard drive on this computer

Show more details

« Clickonthe - button (no password needed)

[#] Update Tool

F.en[character string)

k.ey

Cancel

Fig. 7: Dongle Update Tool

+ On success, an Update successfully message shall appear. On failure, an Error key or no proper
rockey message may appear.

2.2. Licenses 12
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Check Activation on MicroEJ SDK

update_E24C0785

l L Update successfully

oK

Fig. 8: Successful Dongle Update

Note: Production licenses will be shown only if at least one Production Architecture or Platform has been imported

before (see License Manager Overview).

» Go back to MicroEJ SDK,

« Goto Window > Preferences > MicroEJ ,

« Goto Architectures or Platforms sub-menuand checkthatall Production Architectures or Platforms are

now activated (green check).

type filter text Platforms = - -
BasyantdEclipse . Add or remove platforms.
> Help
. lceTea Platforms, Virtual Devices and Architectures:
> Install/Update . Name Version  Lic... Select All
Instant Messaging []4€3 FRDM-KL46Z Jakarta Kickstart 135
> vy & LpCt Deselect All
. lava O | rchitect:re: CMO
4 Microfl [1€F STM: Hardware Part Number: Jakarta Import...
. 14 5TM: Compilation Toolchain: CMO_ARMCC
Architectures (163 sT™: Name: KickStart Uninstall
Maming Conventior 16 sT™: Provider: I52T
oy, Version: 135 Get UID
i g 7 Core Engine Architecture: 14
Platforms in worksp 3 sTM: =
Updates O ] Usage Level:[fev"]
[1€¥ STM: Technology Version: 1.6
> Mylyn []€3 vLcr License Tag{/52T_JFsC
Planning 43 YLCo Build Label: 20750407-1647
» Plug-in Development Path: .microgrepositories\Full\1.64sd002

Troubleshooting

Fig. 9: Platform License Status OK

This section contains instructions to check that your operating system correctly recognizes your USB dongle.

GNU/Linux Troubleshooting

For GNU/Linux Users (Ubuntu at least), by default, the dongle access has not been granted to the user, you have to
modify udev rules. Please create a /etc/udev/rules.d/91-usbhdongle.rules file with the following contents:

2.2. Licenses
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ACTION!="add", GOTO="usbdongle_end"
SUBSYSTEM=="usb"”, GOTO="usbdongle_start”
SUBSYSTEMS=="usb", GOTO="usbdongle_start"”
GOTO="usbdongle_end"

LABEL="usbdongle_start"
ATTRS{idVendor}=="096e" , ATTRS{idProduct}=="0006" , MODE="0666"

LABEL="usbdongle_end"

Then, restart udev: /etc/init.d/udev restart

You can check that the device is recognized by running the 1susb command. The output of the command should
contain a line similar to the one below for each dongle: Bus 002 Device 003: ID 096e:0006 Feitian
Technologies, Inc.

Windows Troubleshooting

If the dongle activation failed with No rockey message, check there is one and only one dongle recognized with
the following hardware ID :

HID\VID_0Q96E&PID_0006&REV_0109

Go to the Device Manager > Human Interface Devices and check amongthe USB Input Device entries that
the Details > Hardwarelds property match the ID mentioned before.

If the dongle activation was successful with Update successfully message but the license does not appear in
MicroEJ SDK or is not updated, try to activate again by starting the executable with administrator privileges:

»  GF2N-HMLPM-94M55-Te3KG

s

Marme Date modified

Mj licensexml 18/03/2020 14:16

EY update.exe B B
Open

m Run as administrator I

VirtualBox Troubleshooting

In a VirtualBox virtual machine, USB drives must be enabled to be recognized correctly. Make sure to enable the
USB dongle by clicking on it in the VirtualBox menu Devices > USB.

To make this setting persistent, go to Devices > USB > USB Settings... and add the USB dongle in the USB
Devices Filters list.

2.2. Licenses 14
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2.3 MicroEJ Runtime

2.3.1 Language

MicroEJ is compatible with the Java language version 7.

Java source code is compiled by the Java compiler' into the binary format specified in the JVM specification’. This
binary code needs to be linked before execution: .class files and some other application-related files (see MicroEJ
Classpath) are compiled to produce the final application that the MicroEJ Runtime can execute.

MicroEJ complies with the deterministic class initialization (<clinit>) order specified in [BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

2.3.2 Scheduler
The MicroEJ Architecture features a green thread platform that can interact with the C world [SNI]. The (green)
thread policy is as follows:

« preemptive for different priorities,

« round-robin for same priorities,

« “priority inheritance protocol” when priority inversion occurs.?

MicroEJ stacks (associated with the threads) automatically adapt their sizes according to the thread requirements:
Once the thread has finished, its associated stack is reclaimed, freeing the corresponding RAM memory.

2.3.3 Garbage Collector

The MicroEJ Architecture includes a state-of-the-art memory management system, the Garbage Collector (GC).
It manages a bounded piece of RAM memory, devoted to the Java world. The GC automatically frees dead Java
objects, and defragments the memory in order to optimize RAM usage. This is done transparently while the MicroEJ
Applications keep running.

2.3.4 Foundation Libraries

Embedded Device Configuration (EDC)
The Embedded Device Configuration specification defines the minimal standard runtime environment for embed-
ded devices. It defines all default API packages:

« java.io

« java.lang

+ java.lang.annotation

« java.lang.ref

« java.lang.reflect

! The JDT compiler from the Eclipse IDE.
2 Tim Lindholm & Frank Yellin, The Java™ Virtual Machine Specification, Second Edition, 1999
3 This protocol raises the priority of a thread (that is holding a resource needed by a higher priority task) to the priority of that task.

2.3. MicroEJ Runtime 15
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+ java.util

Beyond Profile (BON)

[BON] defines a suitable and flexible way to fully control both memory usage and start-up sequences on devices
with limited memory resources. It does so within the boundaries of Java semantics. More precisely, it allows:

+ Controlling the initialization sequence in a deterministic way.

« Defining persistent, immutable, read-only objects (that may be placed into non-volatile memory areas), and
which do not require copies to be made in RAM to be manipulated.

« Defining immortal, read-write objects that are always alive.

+ Defining and accessing compile-time constants.

2.4 MicroEJ Libraries

A MicroEJ Foundation Library is a MicroEJ Core library that provides core runtime APIs or hardware-dependent
functionality. A Foundation library is divided into an APl and an implementation. A Foundation library APl is com-
posed of a name and a 2 digits version (e.g. EDC-1.3) and follows the semantic versioning (http://semver.org)
specification. A Foundation Library API only contains prototypes without code. Foundation Library implementa-
tions are provided by MicroEJ Platforms. From a MicroEJ Classpath, Foundation Library APIs dependencies are
automatically mapped to the associated implementations provided by the Platform or the Virtual Device on which
the application is being executed.

A MicroEJ Add-On Library is a MicroEJ library that is implemented on top of MicroEJ Foundation Libraries (100%
full Java code). A MicroEJ Add-On Library is distributed in a single JAR file, with a 3 digits version and provides its
associated source code.

Foundation and Add-On Libraries are added to MicroEJ Classpath by the application developer as module depen-
dencies (see MicroEJ Module Manager).

YOUR APPLICATIONS

ADD-ON LIBRARIES
FOUNDATION LIBRARIES

Java code

=

Fig. 10: MicroEJ Foundation Libraries and Add-On Libraries

MicroEJ Corp. provides a large number of libraries through the MicroEJ Central Repository. To consult its libraries
APIs documentation, please visit https://developer.microej.com/microej-apis/.

2.5 MicroEJ Central Repository

2.5.1 Introduction

The MicroEJ Central Repository is the module repository distributed and maintained by MicroEJ Corp. It contains
Foundation Library APls and numerous Add-On Libraries.

2.4. MicroEJ Libraries 16
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2.5.2 Use

By default, MicroEJ SDK is configured to connect online MicroEJ Central Repository. The MicroEJ Central Repository
can be downloaded locally for offline use. Please follow the steps described at https://developer.microej.com/

central-repositoryy/.

You can also manually browse the repository at https://repository.microej.com/modules/.

2.5.3 Content Organization

The following table describes how are organized the modules natures within the repository.

Table 1: MicroEJ Central Repository Organization

Organization

Module Nature

ej.api, com.microej.api

Foundation Library API

com.microej.architecture

MicroEJ Architecture

com.microej.pack

MicroEJ Pack

ej.tool, com.microej.tool

Tool or Add-On processor

Any other

Add-On Library

2.5.4 Javadoc

To consult the APIs documentation (Javadoc) of all libraries available in the repository, please visit https://

repository.microej.com/javadoc/microej_5.x/apis/.

2.6 Embedded Specification Requests

MicroEJ implements the following ESR Consortium specifications:

[BON] | http://e-s-r.net/download/specification/ESR-SPE-0001-BON-1.2-F.pdf

2.7 MicroEJ Firmware

2.7.1 Bootable Binary with Core Services

[SNI] http://e-s-r.net/download/specification/ESR-SPE-0012-SNI_GT-1.2-H.pdf
[SP] http://e-s-r.net/download/specification/ESR-SPE-0014-SP-2.0-A.pdf o
[MUI] | http://e-s-r.net/download/specification/ESR-SPE-0002-MICROUI-2.0-B.pdf
[KF] http://e-s-r.net/download/specification/ESR-SPE-0020-KF-1.4-F.pdf N

A MicroEJ Firmware is a binary software program that can be programmed into the flash memory of a device. A
MicroEJ Firmware includes an instance of a MicroEJ runtime linked to:

« underlying native libraries and BSP + RTOS,

« MicroEJ libraries and application code (C and Java code).

2.6. Embedded Specification Requests
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YOUR APPLICATIONS
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ADD-ON LIBRARIES
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Fig. 11: MicroEJ Firmware Architecture

2.7.2 Specification

The set of libraries included in the firmware and its dimensioning limitations (maximum number of simulta-
neous threads, open connections, ...) are firmware specific. Please refer to https://developer.microej.com/5/
getting-started-studio.html for evaluation firmware release notes.

2.8 Introducing MicroEJ SDK

MicroEJ SDK provides tools based on Eclipse to develop software applications for MicroEJ-ready devices. MicroEJ
SDK allows application developers to write MicroEJ Applications and run them on a virtual (simulated) or real de-
vice.

This document is a step-by-step introduction to application development with MicroEJ SDK. The purpose of
MicroEJ SDK is to develop for targeted MCU/MPU computers (loT, wearable, etc.) and it is therefore a cross-
development tool.

Unlike standard low-level cross-development tools, MicroEJ SDK offers unique services like hardware simulation
and local deployment to the target hardware.

Application development is based on the following elements:

« MicroEJ SDK, the integrated development environment for writing applications. It is based on Eclipse and is
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ SDK ( 20.10 ) is built on top of
Eclipse 2020-06.

2.8. Introducing MicroEJ SDK 18
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+ MicroEJ Platform, a software package including the resources and tools required for building and testing an
application for a specific MicroEJ-ready device. MicroEJ Platforms are imported into MicroEJ SDK within a
local folder called MicroEJ Platforms repository. Once a MicroEJ Platform is imported, an application can be
launched and tested on Simulator. It also provides a mean to locally deploy the application on a MicroEJ-
ready device.

+ MicroEJ-ready device, an hardware device that will be programmed with a MicroEJ Firmware. A MicroEJ
Firmware is a binary instance of MicroEJ runtime for a target hardware board.

Starting from scratch, the steps to go through the whole process are detailed in the following sections of this chapter

« Download and install a MicroEJ Platform

« Build and run your first Application on Simulator

« Build and run your first Application on Device

2.9 Introducing MicroEJ Studio and Virtual Devices

MicroEJ Studio provides tools based on Eclipse to develop software applications for MicroEJ-ready devices. Mi-
croEJ Studio allows application developers to write MicroEJ Applications, run them on a virtual (simulated) or real
device, and publish them to a MicroEJ Forge instance.

This document is an introduction to application development with MicroEJ Studio. The purpose of MicroEJ Studio
is to develop for targeted MCU/MPU computers (loT, wearable, etc.) and it is therefore a cross-development tool.

Unlike standard low-level cross-development tools, MicroEJ Studio offers unique services like hardware simula-
tion, deployment to the target hardware and final publication to a MicroEJ Forge instance.

Application development is based on the following elements:

+ MicroEJ Studio, the integrated development environment for writing applications. It is based on Eclipse and
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ Studio (19.05) is built on top of
Eclipse Oxygen (https://www.eclipse.org/oxygen/).

+ MicroEJ Virtual Device, a software package including the resources and tools required for building and test-
ing an application for a specific MicroEJ-ready device. A Virtual Device will simulate all capabilities of the
corresponding hardware board:

Computation and Memory,

Communication channels (e.g. Network, USB....),

Display,

User interaction.

Virtual Devices are imported into MicroEJ Studio within a local folder called MicroEJ Repository. Once a Vir-
tual Device is imported, an application can be launched and tested on Simulator. It also provides a mean to
locally deploy the application on a MicroEJ-ready device.

«+ MicroEJ-ready device, a hardware device that has been previously programmed with a MicroEJ Firmware. A
MicroEJ Firmware is a binary instance of MicroEJ runtime for a target hardware board. MicroEJ-ready devices
are built using MicroEJ SDK. MicroEJ Virtual Devices and MicroEJ Firmwares share the same version (there is
a 1:1 mapping).

The following figure gives an overview of MicroEJ Studio possibilities:

2.9. Introducing MicroEJ Studio and Virtual Devices 19


https://www.eclipse.org/oxygen/

MicroEJ Documentation, Revision ed46acae

- 9 Simulator
-\ = MICROE} ,‘ g\ .
. - Test
MICROEJ Studio

MICROEJ
APPLICATION

MICROEJ.Forge

Fig. 12: MicroEJ Application Development Overview

2.10 Perform Online Getting Started

MicroEJ Studio Getting Started is available on https://developer.microej.com/5/getting-started-studio.html.
Starting from scratch, the steps to go through the whole process are:
1. Setup a board and test a MicroEJ Firmware:
« Select between one of the available boards;
« Download and install a MicroEJ Firmware on the target hardware;
« Deploy and run a MicroEJ demo on board.
2. Setup and learn to use development tools:
» Download and install MicroEJ Studio;
« Download and install the corresponding Virtual Device for the target hardware;
« Download, build and run your first application on Simulator;

« Build and run your first application on target hardware.

The following figure gives an overview of the MicroEJ software components required for both host computer and

target hardware:
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MicroEJ - MicroEJ
Virtual Device Firmware
(.vde)

Q Software

MICROEJ Studio (-exe) (binary)
l Install I Install I Flash
$
. —
Your Workstation Local Target
with Simulator Deploy
Download
& Install
» | @ MICROEJ forge
Publish [ 2~

Fig. 13: MicroEJ Studio Development Imported Elements

2.11 GitHub Repositories

Alarge number of examples, libraries, demos and tools are shared on MicroEJ GitHub account: https://github.com/
MicroEJ.

Most of these GitHub repositories contain projects ready to be imported in MicroEJ SDK. This section explains the
steps to import them in MicroEJ SDK, using the MWT Examples repository.

Note: MicroEJ SDK Distribution includes the Eclipse plugin for Git.

First, from the GitHub page, copy the repository URI (HTTP address) from the dedicated field in the right menu
(highlighted in red):
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O Why GitHub? ~~ Team Enterprise Explore Marketplace Pricing Sign in ‘ Sign up |
& MicroE) / ExampleJava-MWT ®Watch | 2 TrStar | 1 Yok 0
<> Code Issues Pull requests Actions Projects Security Insights

$ master - P 1branch  © 2 tags Go to file About

These projects provide examples
Q privron Merge branch ‘develop’ into ‘master’ .. BJ Clone @ for MWT

HTTPS  GitHub CLI
: - e e (FF [ Readme
com.microej.example.mwt.basic ix api minor version @ignc https://github.con/MicroEl/Exanplela | 7]
com.microej.example.mwtbutt..  Fix api minor version @ignc  Use Git or checkout with SVN using the web URL. BB View license
com.microej.example.mwt.hello...  Fix api minor version @ignc
Et] Open with GitHub Desktop
. Releases
com.microej.example.mwt.mvc Fix api minor version @ignc
: - o - X B D load ZIP @ 2 tags
com.microej.example.mwtslidi..  Fix api minor version @igne & ownloa
[ .gh-copyright.template Move mwt example from foundation libraries @ignore_branc... 3 years ago
N e AT e A 1 e e o e e . Packages

In MicroEJ SDK, to clone and import the project from the remote Git repository into the MicroEJ workspace, select
File > Import > Git > Projectsfrom Git wizard.
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® |mport

Select

Import one or more projects from a Git Repository. Iﬁ

Select an import wizard:

type filter text

= General

= C/C++

= CV5
v = Git

S0 Projects from Git

= Install
= MicroEl
= Plug-in Development
[= Run/Debug
= Tasks
= Teamn
= XML

® < Back Finish Cancel

Click Next , select CloneURI ,click Next and paste the remote repository address in the URI field. For
this repository, the address is https://github.com/MicroEJ/ExampleJava-MWT.git. If the HTTP address is a valid
repository, the other fields are filed automatically.
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® |mport Projects from Git
Source Git Repository GIT
Enter the location of the source repository. :_‘:n‘
Location
URJ: ?| https:.-"fgithul:l.cum.-"MicrDElexampI&lava-M‘."H"T.giﬂ | Lacal File...
Host: | github.com |
Repository path: | /Microbl/Examplelava-MWT.git |
Connection
Protocol: | https
Authentication
User | |
Password: | |
[ ]5tore in Secure Store
® = Back Finish Cancel

Click Next , selectthe master branch, click Next and acceptthe proposed Local Destination by clicking Next

once again.

2.11. GitHub Repositories
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® |mport Projects from Git

Local Destination

GIT

Configure the local storage location for Examplelava-MWT. E‘
Destination

Directory: | IC:\Users\user\git\Examplelava-MWT | Browse
Initial branch: K master v

[]Clene submodules

Configuration

Remote name: | crigin

® < Back Finish Cancel

Click Next once more and finally Finish . The Package Explorer view now contains the imported projects.

£ Package Explorer &2 ‘Eg Type Hierarchy % ™

w '[c‘.gl- com.microgj.example.mwt.basic [Examplelava-MWT master]
& src/main/java
B\ Module Dependencies module.ivy [*]
[ src
[%} CHANGELOG.md
5 LICEMSE.txt
ke moduleivy
[#} README.md
'[c".gl- com.microgj.example.mwt.button [Examplelava-MWT master]
'_,fé com.microg).example.rmwt.helloworld [Examplelava-MWT master]
'[;_—'é com.microgj.example.mwt.mve [Examplelava-MWT master]

1—.;‘- com.microg).example.mwt.slidingwidget [Examplelava-MWT master]
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If you want to import projects from another (GitHub) repository, you simply have to do the same procedure using
the Git URL of the desired repository.

2.12 System Requirements

MicroEJ SDK and MicroEJ Studio

+ Intel x64 PC with minimum :
- Dual-core Core i5 processor
- 4GB RAM
- 2GB Disk

« Operating Systems :

Windows 10, Windows 8.1 or Windows 8

Linux distributions (tested on Ubuntu 18.04 and 20.04) - As of SDK 20.10 (based on Eclipse 2020-06),
Ubuntu 16.04 is not supported.

Mac OS X (tested on version 10.13 High Sierra, 10.14 Mojave)

« Java:

JRE or JDK 8 (OpenJDK or Oracle JDK)

2.13 Get Support

If any questions, feel free to contact our support team with the following information (the table below is an exam-
ple):

Delivery Name

MicroEJ SDK Distribution 20.07 / Version 5.2.0 (see Determine the MicroEJ Studio/SDK
Version)

MicroEJ Architecture ARM Cortex-M4 / IAR / Evaluation | Production (see MicroEJ Architecture)

Platform 1.0.0

Application 1.2.4

Module Repository https://repository.microej.com/packages/repository/2.5.0/microej-5_
0-2.5.0.zip (see MicroEJ Central Repository)

C compiler IAR 8.40.1

Host Operating System Windows 10 (see System Requirements)
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CHAPTER

THREE

APPLICATION DEVELOPER GUIDE

3.1 Introduction

The following sections of this document shall prove useful as a reference when developing applications for MicroEJ.
They cover concepts essential to MicroEJ Applications design.

In addition to these sections, by going to https://developer.microej.com/, you can access a number of helpful re-
sources such as:

« Libraries from the MicroEJ Central Repository (https://developer.microej.com/central-repository/);
« Application Examples as source code from MicroEJ Github Repositories (https://github.com/MicroEJ);
« Documentation (HOWTOs, Reference Manuals, APIs javadoc...).

MicroEJ Applications are developed as standard Java applications on Eclipse JDT, using Foundation Libraries. Mi-
croEJ SDK allows you to run / debug / deploy MicroEJ Applications on a MicroEJ Platform.

Two kinds of applications can be developed on MicroEJ: MicroEJ Standalone Applications and MicroEJ Sanboxed
Applications.

A MicroEJ Standalone Application is a MicroEJ Application that is directly linked to the C code to produce a Mi-
croEJ Firmware. Such application must define a main entry point, i.e. a class containing a public static void
main(String[]) method. MicroEJ Standalone Applications are developed using MicroEJ SDK.

A MicroEJ Sandboxed Application is a MicroEJ Application that can run over a Multi-Sandbox Firmware. It can be
linked either statically or dynamically. If it is statically linked, it is then called a System Application as it is part of
the initial image and cannot be removed. MicroEJ Sandboxed Applications are developed using MicroEJ Studio.

3.2 Local Workspaces and Repositories

When starting MicroEJ SDK, it prompts you to select the last used workspace or a default workspace on the first
run. A workspace is a main folder where to find a set of projects containing MicroEJ source code.

When loading a new workspace, MicroEJ SDK prompts for the location of the MicroEJ repository, where the Mi-
croEJ Architectures, Platforms or Virtual Devices will be imported. By default, MicroEJ SDK suggests to point to
the default MicroEJ repository on your operating system, located at ${user.home}/.microej/repositories/
[version]. You can select an alternative location. Another common practice is to define a local repository relative
to the workspace, so that the workspace is self-contained, without external file system links and can be shared
within a zip file.
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3.3 Standalone Application

3.3.1 MicroEJ Platform Import

A MicroEJ Platform is required to run a MicroEJ Standalone Application on the Simulator or build the Firmware
binary for the target device.

The Platform Developer Guide describes how to create a MicroEJ Platform from scratch for any kind of device. In
addition, MicroEJ Corp. provides Platforms for various development boards (see https://repository.microej.com/
index.php?resource=JPF).

MicroEJ Platforms are distributed in two packages:
« Source Platform. The source files are imported into the workspace. This is the default case.

+ Binary Platform. A . jpf fileisimported into the MicroEJ repository. As of MicroEJ SDK 5. 3.0, this package
is deprecated.

Source Platform Import

Import from Folder

This section applies when the Platform files are already available on a local folder. This is likely the case when the
files are checked out from a Version Control System, such as a local git repository clone.

Note: If you are going to import a Platform from MicroEJ Github, you can follow the specific GitHub Repositories
section instead (the projects will be automatically imported).

+ Select File > Import... > General > Existing ProjectsintoWorkspace > Selectrootdirectory =

Browse... .
« Select the root directory. The wizard will automatically discover projects to import.

« Clickonthe Finish button.

Import from Zip File

This section applies when the Platform files are packagedina .zip file.

» Select File > Import... > General > Existing Projectsinto Workspace > Select archive file =
Browse... .

« Select the zip of the project (e.g., x.zip). The wizard will automatically discover projects to import.

« Clickonthe Finish button.

Platform Build

MicroEJ Platforms are usually shared with only the Platform configuration files. Once the projects are imported,
follow the platform-specific documentation to build the Platform.

Once imported or built, a Platform project should be available as following:
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v 2 myDevice-myPlatform-CMdhardfp_|ARS3-1.0.0
(% build
= =ource
=| .project

Fig. 1: MicroEJ Platform Project
The source folder contains the Platform content which can be set to the target.platform.dir option.

Binary Platform Import

After downloading the MicroEJ Platform . jpf file, launch MicroEJ SDK and follow these steps to import the MicroEJ
Platform:

« Open the Platform view in MicroEJ SDK, select Window > Preferences > MicroEJ > Platforms . The
view should be empty on a fresh install of the tool.

'('} Preferences = n

type filter text Platforms L= A4

» General A
» Ant
y CfC++ Platforms, Virtual Devices and Architectures:
Checkstyle
EasyantdEclipse
» Help Deselect All
» Install/Update
> vy
» Java
4 Microk)
Architectures Get UID
Maming Convention
Platforms in workspace
Updates
» Mylyn

Add or remove platforms.

MName Version Lic... Select All

Import...

Uninstall

> Plug-in Development
- PMD
n Restore Defaults Apph

Fig. 2: MicroEJ Platform Import

« Press Import... button.

« Choose SelectFile... andusethe Browse option to navigate tothe .jpf file containing your MicroEJ
Platform, then read and accept the license agreement to proceed.
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- oS

('} Import Platforms, Virtual Devices and Architectures

Import Platforms, ¥irtual Devices and Architectures

Select a directory/file to search for available platforms, virtual devices and architectures.

(") Select directory: Browse...
(®) Select file: Ch\Usersh, MicroEJPlatform jpof Browse...
Platforms, Yirtual Devices and Architectures:
Mame Yersion Select All
L} MicroE Platform 2.1.1 Deselect Al

MICROE) LICEMSE AGREEMENT

PREAMELE

THIS SOFTWARE LICEMNSE AGREEMENT (THE « AGREEMENT ») APPLIES TO PRODUCTS LICEMSE
On purchase of any Licensed Product from 52T or an 52T Partner or an [52T Distributor, the relz
THE LICEMSEE, AS A USER OF THE LICEMSED PRODUCTS REFERRED TO ABOVE AND OM THE REI

1 DEFIMITIONS

€ >

[+]1 agree and accept the above terms and conditions and | want to install the copyrighted Software

Fig. 3: MicroEJ Platform Selection

+ The MicroEJ Platform should now appear in the Platforms view, with a green valid mark.
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O

Preferences = n

type filter text Platforms =1 v w

»

»

»

General ~
Ant

C/C++ Platforms, Virtual Devices and Architectures:
Checkstyle
EasyantdEclipse

Add or remove platforms.

MName Version Lic... Select All
O} MicroEJ Platform 211 o

+ Help Deselect All
+ Install/Update

> vy

. Java

Import...

Uninstall

MicroE)
Architectures Get UID
Maming Conventicon
Platforms in workspace
Updates

» Mylyn
» Plug-in Development
> PMD

<

n Restore Defaults Apply

Fig. 4: MicroEJ Platform List

3.3.2 Build and Run an Application

Create a MicroEJ Standalone Application

File

Create a project in your workspace. Select File > New > MicroEJ Standalone Application Project .

Edit Source Refactor Mavigate Search Project Run  Window Help

Mew Alt+Shift+N » | (22 MicroE) Standalone Application Project -
Open File... \g MicroE) Standalone Example Project
Close Chrl+W ‘3 Platform
= .
Close Al Ctrl+Shift+W Front Panel Project
£ MicroE) Sandboxed Application Project
Sav 1+
Save Ctrl+5 =i Project...
Save Az
F¥  MirenFl Fant

Fig. 5: New MicroEJ Standalone Application Project

Fill in the application template fields, the Project name field will automatically duplicate in the following

fields. Click on Finish . A template project is automatically created and ready to use, this project already
contains all folders wherein developers need to put content:

- src/main/java: Folder for future sources

- src/main/resources : Folder for future resources (images, fonts, etc.)
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- META-INF : Sandboxed Application configuration and resources

- module.ivy: lvyinput file, dependencies description for the current project

+ Rightclickonthesourcefolder src/main/java andselect New > Package . Giveaname: com.mycompany
. Clickon Finish .

0 Mew Java Package - 0 n
Java Package

Create a new Java package.

Creates folders corresponding to packages.

Source folder: | MyTest/src Browse...

Mame: COM.Mmycompany

[ | Create package-info.java

Fig. 6: New Package

+ The package com.mycompany is available under src/main/java folder. Right click on this package and
select New > Class . Give a name: Test and check the box public static void main(String[]

args) . Clickon Finish .
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0 Mew Java Class - B n

Jawva Class —=
Create a8 new Java class, @

Source folder: MyTest/src Browse...

Package: COM.mMycompany Browse...

[ Enclosing type: Browse...

Mame: Test

Modifiers: (@) public () package private protected

[ ]abstract [ ]final ctatic

Superclass: java.lang.Object Browse...

Interfaces: Add...
Bemowve

Which method stubs would you like to create?
[#]ipublic static void main(String[] args);

[ ] Constructors from superclass
Inherited abstract methods
Do you want to add comments? (Configure templates and default value here

|:| Generate comments

Fig. 7: New Class

+ The new class has been created with an empty main() method. Fill the method body with the following
lines:

System.out.println("hello world!");
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by module.ivy [J] Testjava &3

package com.mycompany;

public class Test {

-
“

public =s=tatic void main(String([] args)
System.out.println("hello world!"™});

Fig. 8: MicroEJ Application Content
The test application is now ready to be executed. See next sections.

Run on the Simulator

{

To run the sample project on Simulator, select it in the left panel then right-click and select Run > Runas >

MicroEJ Application .
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package com.mycompany;

4 Go Into public class Test {

Open in New Window public static void main

Open Type Hierarchy F4 System.out.println/

Show In Alt+Shift+W »

0

=
= {2 | Copy Ctrl+C
¥ | BS

w —

Copy Qualified Mame
[ Paste Ctrl+V
. Delete Delete

Build Path »
Source Alt+Shift+5 ¥
Refactor Alt+Shift+T »

Import...
Export...

EE

wit  Refresh F5
Close Project
Close Unrelated Projects

Assign Warking Sets..,

Run As »
Debug As *
Profile As »
Validate

@ Ruild with Faswlnt

1 lava Applet Alt+5hift+X, A
2 Java Application Alt+Shift+X, J
3 Microk) Application Alt+Shift+X, M

MM A

Run Cenfigurations..,

"

Fig. 9: MicroEJ Development Tools Overview

MicroEJ SDK console will display Launch steps messages.

=============== [ Initialization Stage ) =
=== eI Launchj_ng on Simulator ] ===============

SUCCESS

Run on the Hardware Device

Compile an application, connect the hardware device and deploy on it is hardware dependant. These steps are
described in dedicated documentation available inside the MicroEJ Platform. This documentation is accessible
from the MicroEJ Resources Center view.

Note: MicroEJ Resources Center view may have been closed. Click on Help > MicroEJ Resources Center to
reopen it.
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Open the menu Manual and select the documentation [hardware device] MicroEJ Platform, where
[hardware device] is the name of the hardware device. This documentation features a guide to run a built-in
application on MicroEJ Simulator and on hardware device.

MicroE) Resource Center 23
type filter text
. &2 Javadoc

6 Manual

[l Hardware Device MicroE] Platform

Fig. 10: MicroEJ Platform Guide

3.3.3 Build Output Files
When building a MicroEJ Application, multiple files are generated next to the ELF file. These files are generated in a
folder which is named like the main type and which is located in the output folder specified in the run configuration.

The following image shows an example of output folder:

v [ com.microg).demo.widget.common.Mavigation
= bon
[= cC
[ externalResources
= fonts
= heapDump
= Images
= logs
= platform
= resourceBuffer
w [—- soar
=| com.microgj.demowidget.common.Mavigation.clinitrap
com.micreel.demo.widget.common.MNavigation.o
Ei com.micreel.demo.widget.common.Mavigation.s3infos
|X| com.microg.demowidget.commen.Mavigation.xml
L] sni_intern.h
[ SOAR.map

SOAR.o

Fig. 11: Build Output Files
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The SOAR Map File

The SOAR.map file lists every embedded symbol of the application (section, Java class or method, etc.) and its size
in ROM or RAM. This file can be opened using the Memory Map Analyzer.

The embedded symbols are grouped into multiple categories. For example, the Object class and its methods are
grouped inthe LibFoundationEDC category. For each symbol or each category, you can see its size in ROM ( Image
Size)and RAM (Runtime Size).

The SOAR groups all the Java strings in the same section, which appearsinthe ApplicationStrings category. The
same appliesto the staticfields (Statics category), thetypes (Types category), and the class names (ClassNames
category).

The SOAR Information File

The soar/<main class>.xml file can be opened using any XML editor.
This file contains the list of the following embedded elements:

« method (in selected_methods tag)

« resource (in selected_resources tag)

« system property (in java_properties tag)

« string (in selected_internStrings tag)

« type (in selected_types tag)

« immutable (in selected_immutables tag)

3.3.4 MicroEJ Launch

The MicroEJ launch configuration sets up the MicroEJ Applications environment (main class, resources, target plat-
form, and platform-specific options), and then launches a MicroEJ launch script for execution.

Execution is done on either the MicroEJ Platform or the MicroEJ Simulator. The launch operation is platform-
specific. It may depend on external tools that the platform requires (such as target memory programming). Refer
to the platform-specific documentation for more information about available launch settings.

Main Tab

The Main tab allows you to setin order:
1. The main project of the application.
2. The main class of the application containing the main method.

3. Types required in your application that are not statically embedded from the main class entry point. Most
required types are those that may be loaded dynamically by the application, using the Class.forName()
method.

4. Binary resources that need to be embedded by the application. These are usually loaded by the application
using the Class.getResourceAsStream() method.

5. Immutable objects’ description files. See the [BON 1.2] ESR documentation for use of immutable objects.
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0 Run Configurations n
Create. manage. and run configurations ;—I
- —*|,
= x| H 5 Name: | HelloWerld
type filter text 3] Main s Execution| 8§ Configuration | g, JRE E Source | [[] Commen
E C/C++ Application Praject ~
Ju JUnit
BI;I La::'1ch Group MyHelloWorld5ample Browse...
4 [7] MicroE) Application Main type, Required types
31 HelloWarld
& MicroE Tool com.is2t.examples.edc.helle. HelloWorld Select Main type...
Add types...
Extra types...
Remove
Resources
Add...
Remove
Immutables v
Revert Apply

Filter matched 6 of 11 items

Fig. 12: MicroEJ Launch Application Main Tab

Execution Tab

The next tab is the Execution tab. Here the target needs to be selected. Choose between execution on a MicroEJ
Platform or on a MicroEJ Simulator. Each of them may provide multiple launch settings. This page also allows you
to keep generated, intermediate files and to print verbose options (advanced debug purpose options).
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G— Run Cenfigurations

Create, manage, and run configurations

)

CEX B3P~

type filter text

] C/C++ Application
Ju JUnit

Name: | Widget Demo (SIM)

3] Main | = Execution

A Configuratioﬂ B JRE} E_/ Source\l i=| Qommoﬂ

Target

Platfarm: | STM32F746G-DISCO SingleApp Production [K1AU3] (4.0.0-RC202007301413) | Browse...
L Launch Group
w [T MicroE) Application Execution
& W!dget Demo (EMB) (®) Execute on Simulator () Execute on Device
[3] Widget Demo (SIM])
» g MicroE! Tool Core Engine Mode: MDefanl ~
Settings: | Default ~ | Seftings: | Build & Deploy w
The Application is simulated
Cptions
Output folder: | S{project_loc:com.microej.demouwidget} Browse...
Clean intermediate files [ Verbose
Opticns Files
Y project_loc:com.microe].demo.widget}/build/commeoen.properties Add...
Y project_loc:com.microgj.demo.widgetl/build/sim/sim.properties
Remove
Up
Down
Revert Appl
Filter matched 8 of 21 items = e
@

Configuration Tab

Fig. 13: MicroEJ Launch Application Execution Tab

The next tabis the Configuration tab. Thistab contains all platform-specific options.

3.3. Standalone Application

39




MicroEJ Documentation, Revision ed46acae

ﬂ Run Configurations n

Create. manage. and run configurations -
w,

S X B2 Name: | HelloWorld

type filter text 37 Main | s Execution | ifif Configuration g, JRE E Source | [[] Commen
[E] C/C++ Application 4 Debug
Ju JUnit Code Coverage
[ Launch Group Heap Dumper
4 [7] MicroE) Application 1Dwe
Logs
@ MicroE) Tool 4 Simulator
Com Port
F5
HAL
4 Target
Memory

Specify debug options

4 Libraries
EDC
Shielded Plug
. ECOM
FS
> Microll
Met
MNLS
S5L

. . Revert Apply
Filter matched 6 of 11 items

Fig. 14: Configuration Tab

JRE Tab

The next tabisthe JRE tab. Thistab allows you to configure the Java Runtime Environment used for running the
underlying launch script. It does not configure the MicroEJ Application execution. The VM Arguments text field
allows you to set vm-specific options, which are typically used to increase memory spaces:

« To modify heap space to 1024MB, set the -Xmx1024M option.

« To modify string space (also called PermGen space) to 256MB, set the -XX:PermSize=256M
-XX:MaxPermSize=256M options.

« To set thread stack space to 512MB, set the -Xss512M option.

Other Tabs

The next tabs ( Source and Common tabs) are the default Eclipse launch tabs. Refer to Eclipse help for more
details on how to use these launch tabs.
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3.3.5 Application Options
Introduction
To run a MicroEJ Standalone Application on a MicroEJ Platform, a set of options must be defined. Options can be
of different types:
« Memory Allocation options (e.g set the Java Heap size). These options are usually called link-time options.
« Simulator & Debug options (e.g. enable periodic Java Heap dump).
+ Deployment options (e.g. copy microejapp.o to a suitable BSP location).
« Foundation Library specific options (e.g. embed UTF-8 encoding).

The following section describes options provided by MicroEJ Architecture. Please consult the appropriate MicroEJ
Pack documentation for options related to other Foundation Libraries (MicroUl, NET, SSL, FS, ...) integrated to the
Platform.

Notice that some options may not be available, in the following cases:

« Option is specific to the MicroEJ Core Engine capability (tiny/single/multi) which is integrated in the targeted
Platform.

+ Option is specific to the target (MicroEJ Core Engine on Device or Simulator).

« Option has been introduced in a newer version of the MicroEJ Architecture which is integrated in the targeted
Platform.

+ Options related to Board Support Package (BSP) connection.

Defining an Option

A MicroEJ Standalone Application option can be defined either from a launcher or from a properties file. It is also
possible to use both together. Each MicroEJ Architecture and MicroEJ Pack option comes with a default value,
which is used if the option has not been set by the user.

Using a Launcher

To set an option in a launcher, perform the following steps:

1. In MicroEJ Studio/SDK, select Run > Run Configurations... menu,
2. Select the launcher of the application under MicroEJ Application or create a new one,

3. Select the Configuration tab,

4. Find the desired option and set it to the desired value.

It is recommended to index the launcher configuration to your version control system. To export launcher options
to the filesystem, perform the following steps:

1. Selectthe Common tab,
2. Selectthe Shared file: option and browse the desired export folder,

3. Pressthe Apply button. Afile named [launcher_configuration_name].launch is generated in the ex-
port folder.
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Using a Properties File

Options can be also be defined in properties files.

When a MicroEJ Standalone Application is built using the firmware-singleapp skeleton, options are loaded from
properties files located in the build folder at the root of the project.

The properties files are loaded in the following order:

1. Every file matching build/sim/x.properties, for Simulator options only (Virtual Device build). These files
are optional.

2. Every file matching build/emb/x.properties, for Device options only (Firmware build). These files are
optional.

3. Everyfile matching build/*.properties, bothfor Simulatorand Device options. At least one fileis required.
Usually, the build folder contains a single file named common.properties.

In case an option is defined in multiple properties files, the option of the first loaded file is taken into account and
the same option defined in the other files is ignored (a loaded option cannot be overridden).

The figure below shows the expected tree of the build folder:

v [ build
v [ emb
=| emb.properties
W [ sim
=| sim.properties
5 common.properties

Fig. 15: Build Options Folder

Itis recommended to index the properties files to your version control system.

To set an option in a properties file, open the file in a text editor and add a line to set the desired option to the
desired value. For example: soar.generate.classnames=false.

To use the options declared in properties files in a launcher, perform the following steps:
1. In MicroEJ Studio/SDK, select Run > Run Configurations... ,
2. Select the launcher of the application,
3. Selectthe Execution tab,
4. Under Option Files , pressthe Add... button,

5. Browse the sim.properties file for Simulator or the emb.properties file for Device (if any) and press
Open button,

6. Add the common.properties file and pressthe Open button.

Note: An option setin a properties file can not be modified in the Configuration tab. Options are loaded in the
order the properties files are added (you can use Up and Down buttons to change thefile order). In Configuration
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tab, hovering the pointer over an option field will show the location of the properties file that defines the option.

Generating a Properties File

In order to export options defined ina . launch file to a properties file, perform the following steps:
1. Selectthe [launcher_configuration_name].launch file,
2. Select File > Export > MicroEJ > Launcher as Properties File ,

Browse the desired output .properties file,

> W

Pressthe Finish button.

Category: Runtime

w Device T
es
v CoreEngine P
Kernel [JEmbed all type names
Watchdog
Deploy
v Feature [] Execute assertions on Simulator
Dynamic Download
~ Libraries [] Execute assertions on Device
v ECOM
Comm Connection
EDC [ Enable execution traces
External Resources Loader
Shielded Plug [ start execution traces automatically

Assertions

Trace

~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Types
Option(checkbox): Embed all type names

Option Name: soar.generate.classnames
Default value: true
Description:

Embed the name of all types. When this option is disabled, only names of declared required types are embedded.
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Group: Assertions
Option(checkbox): Execute assertions on Simulator

Option Name: core.assertions.sim.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Option(checkbox): Execute assertions on Device

Option Name: core.assertions.emb.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Group: Trace
Option(checkbox): Enable execution traces

Option Name: core.trace.enabled

Default value: false

Option(checkbox): Start execution traces automatically

Option Name: core.trace.autostart

Default value: false
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Category: Memory

w Device Heaps

v CoreEngine L
Kernel Java heap size (in bytes) | |
Watchdog
Deploy
w Feature

Immortal heap size (in bytes) | |

Dynamic Download Threads

w Libraries Number of threads | |
v ECOM
Comm Connection Number of blocks in pool | |

EDC
External Resources Loader Block size (in bytes) | |
Shielded Plug

w Runtime Maximum size of thread stack (in blocks) | |
Memory

Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heaps
Option(text): Java heap size (in bytes)

Option Name: core.memory. javaheap.size
Default value: 65536

Description:

Specifies the Java heap size in bytes.

A Java heap contains live Java objects. An OutOfMemory error can occur if the heap is too small.

Option(text): Immortal heap size (in bytes)

Option Name: core.memory.immortal.size
Default value: 4096

Description:

Specifies the Immortal heap size in bytes.

The Immortal heap contains allocated Immortal objects. An OutOfMemory error can occur if the heap is too small.

Group: Threads

Description:
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This group allows the configuration of application and library thread(s). A thread needs a stack to run. This stack
is allocated from a pool and this pool contains several blocks. Each block has the same size. At thread startup the
thread uses only one block for its stack. When the first block is full it uses another block. The maximum number of
blocks per thread must be specified. When the maximum number of blocks for a thread is reached or when there
is no free block in the pool, a StackOverflow error is thrown. When a thread terminates all associated blocks are
freed. These blocks can then be used by other threads.

Option(text): Number of threads

Option Name: core.memory.threads.size
Default value: 5
Description:

Specifies the number of threads the application will be able to use at the same time.

Option(text): Number of blocks in pool

Option Name: core.memory.threads.pool.size
Default value: 15
Description:

Specifies the number of blocks in the stacks pool.

Option(text): Block size (in bytes)

Option Name: core.memory.thread.block.size
Default value: 512
Description:

Specifies the thread stack block size (in bytes).

Option(text): Maximum size of thread stack (in blocks)

Option Name: core.memory.thread.max.size
Default value: 4
Description:

Specifies the maximum number of blocks a thread can use. If a thread requires more blocks a StackOverflow error
will occur.
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Category: Simulator

~ Device Options
v CoreEngine

Kernel [[]Use target characteristics

Watchdog Slowing factor (0 means disabled): | 0
Deploy
v Feature . HIL Connectien
Dynamic Download
w Libraries [ Specify a port
w ECOM
Comm Connection 8001
EDC
External Resources Loader HIL connection timeout: | 10 |
Shielded Plug
~ Runtime Shielded Plug server configuration
. Memory Server socket port: | 10082 |
w Simulator

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Options

Description:

This group specifies options for MicroEJ Simulator.

Option(checkbox): Use target characteristics

Option Name: s3.board.compliant
Default value: false
Description:

When selected, this option forces the MicroEJ Simulator to use the MicroEJ Platform exact characteristics. It sets
the MicroEJ Simulator scheduling policy according to the MicroEJ Platform one. It forces resources to be explicitly
specified. It enables log trace and gives information about the RAM memory size the MicroEJ Platform uses.

Option(text): Slowing factor (0 means disabled)

Option Name: s3.slow
Default value: 0
Description:

Format: Positive integer

This option allows the MicroEJ Simulator to be slowed down in order to match the MicroEJ Platform execution
speed. The greater the slowing factor, the slower the MicroEJ Simulator runs.
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Group: HIL Connection

Description:

This group enables the control of HIL (Hardware In the Loop) connection parameters (connection between MicroEJ
Simulator and the Mocks).

Option(checkbox): Specify a port

Option Name: s3.hil.use.port
Default value: false
Description:

When selected allows the use of a specific HIL connection port, otherwise a random free port is used.

Option(text): HIL connection port

Option Name: s3.hil.port
Default value: 8001
Description:

Format: Positive integer
Values: [1024-65535]

It specifies the port used by the MicroEJ Simulator to accept HIL connections.

Option(text): HIL connection timeout

Option Name: s3.hil.timeout
Default value: 10

Description:

Format: Positive integer

It specifies the time the MicroEJ Simulator should wait before failing when it invokes native methods.

Group: Shielded Plug server configuration

Description:

This group allows configuration of the Shielded Plug database.

Option(text): Server socket port

Option Name: sp.server.port
Default value: 10082

Description:
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Set the Shielded Plug server socket port.

Category: Code Coverage

~ Device Code Coverage
w CoreEngine
Kernel
Watchdog
Deploy
w Feature

[ Activate code coverage analysis

Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Code Coverage

Description:

This group is used to set parameters of the code coverage analysis tool.

Option(checkbox): Activate code coverage analysis

Option Name: s3.cc.activated
Default value: false
Description:

When selected it enables the code coverage analysis by the MicroEJ Simulator. Resulting files are output in the cc
directory inside the output directory.

Option(text): Saving coverage information period (in sec.)

Option Name: s3.cc.thread.period
Default value: 15
Description:

It specifies the period between the generation of .cc files.
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Category: Debug

w Device Remote Debug

v CoreEngine
Kernel Debug port: | 12000

Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Remote Debug
Option(text): Debug port

Option Name: debug.port
Default value: 12000
Description:

Configures the JDWP debug port.
Format: Positive integer

Values: [1024-65535]
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Category: Heap Dumper

~ Device Heap Inspection

v CoreEngine i
Kernel [] Activate heap dumper
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heap Inspection

Description:

This group is used to specify heap inspection properties.

Option(checkbox): Activate heap dumper

Option Name: s3.inspect.heap
Default value: false

Description:

When selected, this option enables a dump of the heap each time the System.gc() method is called by the MicroEJ

Application.
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Category: Logs

w Device

Logs
v CoreEngine L
system thread maonitoring
Kernel 2
Watchdog memory schedule monitors
Deploy
w Feature 2

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Logs

Description:

This group defines parameters for MicroEJ Simulator log activity. Note that logs can only be generated if the
Simulator > Use target characteristics optionis selected.

Some logs are sent when the platform executes some specific action (such as start thread, start GC, etc), other logs
are sent periodically (according to defined log level and the log periodicity).

Option(checkbox): system

Option Name: console.logs.level.low

Default value: false

Description:

When selected, System logs are sent when the platform executes the following actions:
start and terminate a thread

start and terminate a GC

exit

Option(checkbox): thread

Option Name: console.logs.level.thread
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Default value: false
Description:

When selected, thread information is sent periodically. It gives information about alive threads (status, memory
allocation, stack size).

Option(checkbox): monitoring

Option Name: console.logs.level .monitoring
Default value: false
Description:

When selected, thread monitoring logs are sent periodically. It gives information about time execution of threads.

Option(checkbox): memory

Option Name: console.logs.level .memory
Default value: false
Description:

When selected, memory allocation logs are sent periodically. This level allows to supervise memory allocation.

Option(checkbox): schedule

Option Name: console.logs.level.schedule
Default value: false
Description:

When selected, a log is sent when the platform schedules a thread.

Option(checkbox): monitors

Option Name: console.logs.level .monitors
Default value: false
Description:

When selected, monitors information is sent periodically. This level permits tracing of all thread state by tracing
monitor operations.

Option(text): period (in sec.)

Option Name: console.logs.period
Default value: 2
Description:

Format: Positive integer
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Values: [0-60]

Defines the periodicity of periodical logs.

Category: Device

w Device Device Architecture
w CoreEngine
Kernel
Watchdog
Deploy

[] Use a custom device architecture

~ Feature
Device Uni D
Dynamic Download evice Lnique

w Libraries [ Use a custom device unique ID
w ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Architecture

Option(checkbox): Use a custom device architecture

Option Name: s3.mock.device.architecture.option.use

Default value: false

Option(text): Architecture Name

Option Name: s3.mock.device.architecture.option

Default value: (empty)

Group: Device Unique ID

Option(checkbox): Use a custom device unique ID

Option Name: s3.mock.device.id.option.use

Default value: false
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Option(text): Unique ID (hexadecimal value)

Option Name: s3.mock.device.id.option

Default value: (empty)

Category: Com Port

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs
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Category: Libraries

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: EDC

w Device Java System.out

v Cor;:rr;gewlne [ Use a custom Java output stream
Watchdog
Deploy
w Feature

Runti ti
Dynamic Download B

~ Libraries Embed UTF-8 enceding
v ECOM .
Comm Connection []Enable SecurityManager checks
EDC
External Resources Loader
Shielded Plug

~ Runtime
Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Java System.out

3.3. Standalone Application 56



MicroEJ Documentation, Revision ed46acae

Option(checkbox): Use a custom Java output stream

Option Name: core.outputstream.disable.uart

Default value: false

Description:

Select this option to specify another Java System.out print stream.

If selected, the default Java output stream is not used by the Java application. the JPF will not use the default Java
output stream at startup.

Option(text): Class

Option Name: core.outputstream.class

Default value: (empty)

Description:

Format: Java class like packageA.packageB.className
Defines the Java class used to manage System.out.

At startup the JPF will try to load this class using the Class.forName() method. If the given class is not available,
the JPF will use the default Java output stream as usual. The specified class must be available in the application
classpath.

Group: Runtime options

Description:

Specifies the additional classes to embed at runtime.

Option(checkbox): Embed UTF-8 encoding

Option Name: cldc.encoding.utf8.included
Default value: true
Description:

Embed UTF-8 encoding.

Option(checkbox): Enable SecurityManager checks

Option Name: com.microej.library.edc.securitymanager.enabled
Default value: false
Description:

Enable the security manager runtime checks.
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Category: Shielded Plug

~ Device Shielded Plug cenfiguration

v CoreEngine
Kernel Database definition: Browse...
Watchdog

Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Shielded Plug configuration

Description:

Choose the database XML definition.

Option(browse): Database definition

Option Name: sp.database.definition
Default value: (empty)
Description:

Choose the database XML definition.
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Category: ECOM

w Device Device Management

" CU';::;QE"”E [ Enable registration event notifications
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Management
Option(checkbox): Enable registration event notifications

Option Name: com.is2t.ecom.eventpump.enabled
Default value: false

Description:

Enables notification of listeners when devices are registered or unregistered. When a device is registered or un-
registered, a new ej.ecom.io.RegistrationEvent isadded to an event queue. Then events are processed by a

dedicated thread that notifies registered listeners.

Option(text): Registration events queue size

Option Name: com.is2t.ecom.eventpump.size
Default value: 5

Description:

Specifies the size (in number of events) of the registration events queue.
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Category: Comm Connection

w Device Comm Connection Options

w CoreEngine

Kernel []Enable comm connections

Watchdog
Deploy Device Management

v Feature Enable dynamic comm ports registration
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Comm Connection Options

Description:

This group allows comm connections to be enabled and application-platform mappings set.

Option(checkbox): Enable comm connections

Option Name: use.comm.connection
Default value: false
Description:

When checked application is able to open a CommConnection.

Group: Device Management
Option(checkbox): Enable dynamic comm ports registration

Option Name: com.is2t.ecom.comm.registryPump.enabled
Default value: false
Description:

Enables registration (or unregistration) of ports dynamically added (or removed) by the platform. A dedicated
thread listens for ports dynamically added (or removed) by the platform and adds (or removes) their CommPort
representation to the ECOM DeviceManager .
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Category: External Resources Loader

<

Device External Resources Loader

v CoreEngine

Kernel Folder where are stored the resources which will be pregrammed outside CPU address
space range (storage media like SD card, serial NOR flash, EEPROM).
Watchdog The resources which will be linked into the CPU address space range (internal
Deploy device memeories, external parallel memories) must be listed in the Resources box
w Feature of Main tab.

Dynamic Download

~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime

Browse...

Memory

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: External Resources Loader

Description:

This group allows to specify the external resources input folder. The content of this folder will be copied in an
application output folder and used by SOAR and the Simulator. If empty, the default location will be [output
folder]/externalResources, where [output folder] is the location defined in Execution tab.

Option(browse):

Option Name: ej.externalResources.input.dir
Default value: (empty)
Description:

Browse to specify the external resources folder..
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Category: Device

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: Core Engine

v Device
v CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memary
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Memory

Specify target options

Memory

Maximum number of monitors per thread

Maximum number of frames dumped on OutOfMemoryError
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Option(text):

Option Name: core.memory.thread.max.nb.monitors
Default value: 8
Description:

Specifies the maximum number of monitors a thread can own at the same time.

Option(text):

Option Name: core.memory.oome.nb.frames
Default value: 5
Description:

Specifies the maximum number of stack frames that can be dumped to the standard output when Core Engine
throws an OutOfMemoryError.

Category: Kernel

Device

<

[] Check APIs allowed by Kernel
v CoreEngine

Kernel Threads
Watchdog
Deploy
~ Feature

Maximum number of threads per Feature | |

Installed Features
Dynamic Download

w Libraries Maximum number of installed Features | |
v ECOM
Comm Connection Code Size (in bytes) | |
EDC
External Resources Loader Runtime Size (in bytes) | |
Shielded Plug
~ Runtime

Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Check APIs allowed by Kernel

Option Name: apis.check.enable

Default value: true
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Group: Threads
Option(text):

Option Name: core.memory.feature.max.threads
Default value: 5
Description:

Specifies the maximum number of threads a Feature is allowed to use at the same time.

Group: Installed Features
Option(text):

Option Name: core.memory.installed.features.max
Default value: 0
Description:

Specifies the maximum number of installed Features that can be added to this Kernel.

Option(text):

Option Name: core.memory.installed.features.text.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features code.

Option(text):

Option Name: core.memory.installed.features.bss.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features runtime memory.
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Category: Watchdog

v Device
+ CoreEngine [ Enable watchdog support

Kernel Watchdog
Watchdog Mazximum number of active watchdogs
Deploy

w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Enable watchdog support

Option Name: enable.watchdog. support

Default value: true

Group: Watchdog
Option(text):

Option Name: maximum.active.watchdogs
Default value: 4

Description:

Specifies the maximum number of active watchdogs at the same time.
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Category: Deploy

~ Device Configuration

v CoreEngine
Kemgel [ Deploy the compiled MicroE) application in a folder in MicroE) application main class project
Watchdog
Deploy
w Feature

Output file: | Browse...

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Description:

Configures the output location where store the MicroEJ Application, the MicroEJ platform libraries and header files.

Group: Configuration

Option(checkbox): Deploy the compiled MicroEJ Application in a folder in MicroEJ Application main class
project

Default value: true
Description:

Deploy the compiled MicroEJ Application in a folder in MicroEJ Application’s main class project.

Option(browse): Output file

Option Name: deploy.copy.filename
Default value: (empty)
Description:

Choose an output file location where copy the compiled MicroEJ Application.
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Category: Feature

e [‘J'ewcc:re Engine Specify Feature options
Kernel
Watchdog
Deploy
~ Feature
Dynamic Download
w Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Description:

Specify Feature options
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Category: Dynamic Download

w Device Dynamic Download

v CoreEngine

Kernel Output Name: |
Watchdog
Deploy Kernel: | F—
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Dynamic Download
Option(text): Output Name

Option Name: feature.output.basename

Default value: application

Option(browse): Kernel

Option Name: kernel.filename

Default value: (empty)

3.3.6 SOAR

SOAR complies with the deterministic class initialization ( <clinit>) order specified in /[BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

An explicit clinit dependency can be declared by creating an XML file with the .clinitdesc extension in the ap-
plication classpath. The file has the following format:

<?xml version='1.0' encoding='UTF-8'?>
<clinit>
(continues on next page)
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(continued from previous page)

<type name="T1" depends="T2"/>
</clinit>

where T1 and T2 are fully qualified names on the form a.b.C. This explicitly forces SOAR to create a dependency
from T1 to T2, and therefore cuts a potentially detected dependency from T2 to T1.

Aclinit map file (ending with extension .clinitmap)is generated beside the SOAR object file. It describes for each
clinit dependency:

+ the typesinvolved
« the kind of dependency

« the stack calls between the two types

3.4 Sandboxed Application

3.4.1 Sandboxed Application Structure

Application Skeleton Creation

The first step to explore a Sandboxed Application structure is to create a new project.

Firstselect File > New > MicroEJ Sandboxed Application Project :

Fillin the application template fields, the Project name field will automatically duplicate in the following fields.

A template project is automatically created and ready to use, this project already contains all folders wherein de-
velopers need to put content:

src/main/java Folder for future sources;
src/main/resources Folder for future resources (images, fonts, etc.);
META-INF Sandboxed Application configuration and resources;

module.ivy Ivyinput file, dependencies description for the current project.

Sources Folder

The project source folder ( src/main) contains two subfolders: java and resources. java folder will contain all
*. java files of the project, whereas resources folder will contain elements that the application needs at runtime
like raw resources, images or character fonts.

META-INF Folder

The META-INF folder contains several folders and a manifest file. They are described hereafter.
certificate (folder) Contains certificate information used during the application deployment.

libraries (folder) Contains a list of additional libraries useful to the application and not resolved through the
regular transitive dependency check.

properties (folder) Containsan application.properties file which contains application specific properties
that can be accessed at runtime.
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services (folder) Contains a list of files that describe local services provided by the application. Each file name
represents a service class fully qualified name, and each file contains the fully qualified name of the provided
service implementation.

wpk (folder) Contains a set of applications ( .wpk files) that will be started when the application is executed on
the Simulator.

MANIFEST.MF (file) Containsthe information given at project creation, extra information can be added to this file
to declare the entry points of the application.

module.ivy File

The module.ivy file describes all the libraries required by the application at runtime. The lvy classpath container
lists all the modules that have been automatically resolved from the content of module.ivy . See MicroEJ Module
Manager for more informations about MicroEJ Module Manager.

3.4.2 Application Publication

Build the WPK

When the application is ready for deployment, the last step in MicroEJ Studio is to create the WPK (Wadapps Pack-
age) file that is intended to be published on a MicroEJ Forge instance for end users.

In MicroEJ Studio, right-click on the Sandboxed Application project name and select Build Module.

The WPK build process will display messages in MicroEJ console, ending up the following message:

[echo] project hello published locally with version 0.1.0-RC201907091602
BUILD SUCCESSFUL

Total time: 1 minute 6 seconds

The WPK file produced by the build process is located in a dedicated target~/artifacts folderinthe projectand
is published to the target module repository declared in MicroEJ Module Manager settings file.

The module repository can be a MicroEJ Forge instance.

3.4.3 Shared Interfaces

Principle

The Shared Interface mechanism provided by MicroEJ Core Engine is an object communication bus based on plain
Java interfaces where method calls are allowed to cross MicroEJ Sandboxed Applications boundaries. The Shared
Interface mechanism is the cornerstone for designing reliable Service Oriented Architectures on top of MicroEJ.
Communication is based on the sharing of interfaces defining APIs (Contract Oriented Programming).

The basic schema:
« A provider application publishes an implementation for a shared interface into a system registry.

« Auser application retrieves the implementation from the system registry and directly calls the methods de-
fined by the shared interface.
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USER APPLICATION PROVIDER APPLICATION

Shared Interface Call

AA.mm() > mm() {
//code

}

MICROEJ CORE ENGINE

Fig. 16: Shared Interface Call Mechanism

Shared Interface Creation

Creation of a shared interface follows three steps:
« Interface definition,
« Proxy implementation,

+ Interface registration.

Interface Definition

The definition of a shared interface starts by defining a standard Java interface.

package mypackage;

public interface MyInterface(
void foo();

3

To declare an interface as a shared interface, it must be registered in a shared interfaces identification file. A shared
interface identification file is an XML file with the .si suffix with the following format:

<sharedInterfaces>
<sharedInterface name="mypackage.MyInterface"/>
</sharedInterfaces>

Shared interface identification files must be placed at the root of a path of the application classpath. For a MicroEJ
Sandboxed Application project, it is typically placed in src/main/resources folder.
Some restrictions apply to shared interface compared to standard java interfaces:

+ Types for parameters and return values must be transferable types;

« Thrown exceptions must be classes owned by the MicroEJ Firmware.

Transferable Types

In the process of a cross-application method call, parameters and return value of methods declared in a shared
interface must be transferred back and forth between application boundaries.
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USER APPLICATION Shared Interface Transfer [FHMSALCSS AR IREL.

R = AA.mm(P1, P2)

Fig. 17: Shared Interface Parameters Transfer

Shared Interface Types Transfer Rules describes the rules applied depending on the element to be transferred.

Table 1: Shared Interface Types Transfer Rules

Type Owner Instance Rule
Owner

Base type N/A N/A Passing by value. (boolean, byte, short
, char, int, long, double, float)

Any Class, Array or Inter- | Kernel Kernel Passing by reference

face

Any Class, Array or Inter- | Kernel Application Kernel specific or forbidden

face

Array of base types Any Application Clone by copy

Arrays of references Any Application | Clone and transfer rules applied again on
each element

Shared Interface Application Application Passing by indirect reference (Proxy cre-
ation)

Any Class, Array or Inter- | Application Application Forbidden

face

Objects created by an application which class is owned by the Kernel can be transferred to another application
if this has been authorized by the Kernel. The list of eligible types that can be transferred is Kernel specific, so
you have to consult the firmware specification. MicroEJ Evaluation Firmware Example of Transfer Types lists Kernel
types allowed to be transferred through a shared interface call. When an argument transfer is forbidden, the call is
abruptly stopped and a java.lang.IllegalAccessError isthrown by MicroEJ Core Engine.

Table 2: MicroEJ Evaluation Firmware Example of Transfer Types

Type Rule
Clone by copy

java.lang.String

. . Proxy reference creation
java.io.InputStream

Clone by deep copy

java.util.Map<String,String>

Proxy Class Implementation

The Shared Interface mechanism is based on automatic proxy objects created by the underlying MicroEJ Core En-
gine, so that each application can still be dynamically stopped and uninstalled. This offers a reliable way for users
and providers to handle the relationship in case of a broken link.

Once a Java interface has been declared as Shared Interface, a dedicated implementation is required (called the
Proxy class implementation). Its main goal is to perform the remote invocation and provide a reliable implemen-
tation regarding the interface contract even if the remote application fails to fulfill its contract (unexpected excep-
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tions, application killed...). The MicroEJ Core Engine will allocate instances of this class when an implementation
owned by another application is being transferred to this application.

USER APPLICATION PROVIDER APPLICATION

R = AA.mm(P1, P2

Proxy Class

MICROEJ CORE ENGINE

Transfer

Shared Interfaces Binding

Fig. 18: Shared Interfaces Proxy Overview

A proxy class is implemented and executed on the client side, each method of the implemented interface must be
defined according to the following pattern:

package mypackage;
public class MyInterfaceProxy extends Proxy<MyInterface> implements MyInterface {

@0verride
public void foo(){
try {
invoke(); // perform remote invocation
} catch (Throwable e) {
e.printStackTrace();

b
3

Each implemented method of the proxy class is responsible for performing the remote call and catching all errors
from the server side and to provide an appropriate answer to the client application call according to the interface
method specification (contract). Remote invocation methods are defined in the super class ej.kf.Proxy and are
named invokeXXX() where XXX is the kind of return type. As this class is part of the application, the application
developer has the full control on the Proxy implementation and is free to insert additional code such as logging
calls and errors for example.

Table 3: Proxy Remote Invocation Built-in Methods

Invocation Method Usage
void invoke() Remote invocation for a proxy method that returns void
Object invokeRef() Remote invocation for a proxy method that returns a reference

boolean invokeBoolean(), byte invokeByte(), | Remote invocation for a proxy method that returns a base type
char invokeChar(), short invokeShort(), int in-
vokelnt(), long invokeLong(), double invoke-
Double(), float invokeFloat()
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3.5 Virtual Device

3.5.1 Using a Virtual Device for Simulation

The Virtual Device includes the same custom MicroEJ Core, libraries and System Applications as the real device.
The Virtual Device allows developers to run their applications either on the Simulator, or directly on the real device
through local deployment.

The Simulator runs a mockup board support package (BSP Mock) that mimics the hardware functionality. An ap-
plication on the Simulator is run as a Standalone Application.

Before an application is locally deployed on device, MicroEJ Studio ensures that it does not depend on any API that
is unavailable on the device.

YOUR APPLICATIONS

ADD-ON LIBRARIES

Web / REST servers | MQTT/LWM2M clients | JSON | CBOR | Crypto | Widgets | Components | Eclasspath | ...

FOUNDATION LIBRARIES

I ST

% MICROEJ VEE

VIRTUALIZATION
g ~
Engine Simulator

Linux / Windows [ macOS

PLATFORM

PROCESSOR
Ethernet D CORE Serial Bluetooth

WORKSTATION

Wi-Fi / LTE Display

Fig. 19: MicroEJ Virtual Device Architecture

3.5.2 Runtime Environment

The set of MicroEJ APIs exposed by a Virtual Device (and therefore provided by its associated firwmare) is docu-
mented in Javadoc format in the MicroEJ Resource Center ( Window > Show View > MicroEJ Resource Center

).
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i® MicroE) Resource Center 53
type filter text

4 | 2] Javadoc
[ MICROEJ-DEVELOPER-RUNTIME 1.0

- @2 Online Resources

Fig. 20: MicroEJ Resource Center APIs

3.6 MicroEJ Module Manager

3.6.1 Introduction

Modern electronic device design involves many parts and teams to collaborate to finally obtain a product to be sold
on its market. MicroEJ encourages modular design which involves various stake holders: hardware engineers, UX
designers, graphic designers, drivers/BSP engineers, software engineers, etc.

Modular design is a design technique that emphasizes separating the functionality of an application into inde-
pendent, interchangeable modules. Each module contains everything necessary to execute only one aspect of
the desired functionality. In order to have team members collaborate internally within their team and with other
teams, MicroEJ provides a powerful modular design concept, with smart module dependencies, controlled by the
MicroEJ Module Manager (MMM). MMM frees engineers from the difficult task of computing module dependencies.
Engineers specify the bare minimum description of the module requirements.

The following schema introduces the main concepts detailed in this chapter.
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}' \ Settings
/ OptlonsJ File J

MICROEJ.SDK

Configuration

MMM
v 'l:‘,{ module
(® src/main/java
i src/main/resources Import
v =)\ Module Dependencies module.ivy "}« = [
s edc-1.3.0,jar - C:\Users\user\.micrc Module Dependenaes

(= internal
= src
[#) CHANGELOG.md

Module i) LICENSEtxt Build & Publish Module

Description by module.ivy »  Module Repository
File (] README.md
I 4

Module Project Skeleton

Fig. 21: MMM Overview

MMM is based on the following tools:
« Apache lvy (http://ant.apache.org/ivy) for dependencies resolution and module publication;

« Apache EasyAnt (https://ant.apache.org/easyant/history/trunk/reference.html) for module build from
source code.

3.6.2 Specification

MMM provides a non ambiguous semantic for dependencies resolution. Please consult the MMM specification
available on https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.
0-E.pdf.

3.6.3 Module Project Skeleton

In MicroEJ SDK, a new MicroEJ module project is created as following:

+ Select File > New > Project... ,

« Select MicroEJ > MicroEJ Module Project ',

« Fill the module information (project name, module organization, name and revision),
+ Select one of the suggested skeletons depending on the desired module nature,

« Clickon Finish .

11f using MicroEJ SDK versions lower than 5.2.0, please refer to the following section.
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The project is created and a set of files and directories are generated from the selected skeleton.

Note: When an empty Eclipse project already exists or when the skeleton has to be created within an existing
directory, the MicroEJ module is created as following:

« In the Package Explorer, click on the parent project or directory,

« Select File > New > Other... ,

+ Select EasyAnt > EasyAnt Skeleton .

3.6.4 Module Description File

Amodule descriptionfileis an Ivy configuration file named module. ivy, located at the root of each MicroEJ module
project. It describes the module nature (also called build type) and dependencies to other modules.

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org” xmlns:m="http://ant.apache.org/ivy/extra”
xmlns:ej="https://developer.microej.com” ej:version="2.0.0">
<info organisation="[organisation]” module="[name]" status="integration” revision="[version]">
<ea:build organisation="com.is2t.easyant.buildtypes” module="[buildtype_name]” revision=
—"[buildtype_version]">
<ea:property name="[buildoption_name]"” value="[buildoption_value]"/>
</ea:build>
</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default” visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="documentation” visibility="public"/>
<conf name="source" visibility="public"/>
<conf name="dist"” visibility="public"/>
<conf name="test"” visibility="private"/>
</configurations>

<publications>
</publications>

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]"/>

</dependencies>
</ivy-module>

Enable MMM Semantic

The MMM semantic is enabled in a module by adding the MicroEJ XML namespace and the ej:version attribute
inthe ivy-module node:

<ivy-module xmlns:ej="https://developer.microej.com” ej:version="2.0.0">

Note: Multiple namespaces can be declared in the ivy-module node.

MMM semantic is enabled in the module created with the Module Project Skeleton.
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Module Dependency

Module dependencies are added to the dependencies node as follow:

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]"” rev="[dep_version]"/>
</dependencies>

When no matching rule is specified, the default matching rule is compatible.

Dependency Matching Rule

The following matching rules are specified by MMM:

Name Range Notation Semantic

compatible [M.m.p-RC, (M+1).0.0-RC][ Equal or up to next major version. Default if
not set.

equivalent [M.m.p-RC, M.(m+1).0-RC [ Equal or up to next minor version

greaterOrEqual [M.m.p-RC, oo Equal or greater versions

perfect [M.m.p-RC, M.m.(p+1)-RC[ Exact match (strong dependency)

Set the matching rule of a given dependency with ej:match="matching rule”.Forexample:

<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]" ej:match="perfect” />

Dependency Visibility

« Adependency declared public is transitively resolved by upper modules. The default when not set.
« Adependency declared private isonly used by the module itself, typically for:

- Bundling the content into the module

- Testing the module

The visibility is set by the configurations declared in the configurations node. For example:

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="[conf_name]” visibility="private"/>
</configurations>

The configuration of a dependency is specified by setting the conf attribute, for example:

<dependency org="[dep_organisation]” name="[dep_name]"” rev="[dep_version]"” conf="[conf_name]->x" />

Automatic Update Before Resolution

The Easyant plugin ivy-update can be used to automatically update the version (attribute rev ) of every module
dependencies declared.

<info organisation="[organisation]” module="[name]"” status="integration” revision="[version]">
<ea:plugin org="com.is2t.easyant.plugins” name="ivy-update"” revision="1.+" />
</info>
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When the plugin is enabled, for each module dependency, MMM will check the version declared in the module file
and update it to the highest version available which satisfies the matching rule of the dependency.

Build Options

MMM Build Options can be set with:
<ea:property name="[buildoption_name]” value="[buildoption_value]"/>

The following build options are globally available:

Table 4: Build Options

Property | Description Default Value
Name

Path to the build directory target~.
target ${basedir}/target~

Refer to the documentation of Module Natures for specific build options.

3.6.5 MicroEJ Module Manager Configuration

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from
MicroEJ Central Repository and to publish built modules to a local folder. The repository configura-
tion is stored in a settings file ( ivysettings.xml ), and the default one is located at $USER_HOME\.
microej\microej-ivysettings-[VERSION].xml

Preferences Page

The MMM preferences page is available at Window > Preferences > MicroEJ > Module Manager .
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& Preferences

type filter text Module Manager - r v
General
Ant Module Repository
C/Ces (1) Settings File: | C\Users\user\.microgj\microej-ivysettings-3.ml ‘
Checkstyle
Help Default | Workspace... | | File System...
Install/Update
Java Import Repository
w Microk) Options
Architectures
Module Manager (2) propery fes: Edit...
Maming Convention Pt
Platforms
Platforms in workspace Remove
Settings
Updates Up
Wirtual Devices D
Mybyn own
Plug-in Development Build Repoci
PMD uild Repaository
Run/Debug 3 [ Use Module repository as Build repository
Senarlint (4) Settings File: | C:\Program Files\MicroEl\MicroE)-SDK-20.0T\rcpl\configuration'org.eclipse.osgi\9\data\repositories\microej-build-repositony\ivysettings.xml Browse...
Team
Termi Export Build Kit
erminal
Validation Launch
XML
(5) [ 5et verbose mode
() Runtime JRE: jre1.8.0_221 v
(7) Max build history size: | 5
< 5 Restore Defaults Apply
® Apply and Close Cancel

Fig. 22: MMM Preferences Page

This page allows to configure the following elements:

1.
2.
3.

Settings File: the file describing how to connect module repositories. See the settings file section.

Options: files declaring MMM options. See the Options section.

Use Module repository as Build repository:thesettings file for connecting the build repositoryin place
of the one bundled in MicroEJ SDK. This option shall not be enabled by default and is reserved for advanced
configuration.

Build repository Settings File:the settings file for connecting the build repository in place of the one
bundled in MicroEJ SDK. This option is automatically initialized the first time MicroEJ SDK is launched. It
shall not be modified by default and is reserved for advanced configuration.

Set verbose mode : to enable advanced debug traces when building a module.
Runtime JRE :the Java Runtime Environment that executes the build process.
Max build history size:the maximum number of previous builds available in Build Module shortcut

list:

3

File Refactor Mavigate Search  Project  Run
cruoiv[@]Jeis-0-a-i@e-

4 Package Explorer 33 | ) Build Selected Module (Ctrl+Alt-C, E)

workspaceRepository -

Edit Source

3.6.
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Settings File

The settings file is an XML file that describes how MMM connects local or online module repositories. The file format
is described in Apache lvy documentation.

To configure MMM to a custom settings file (usually from an offline repository):

1. Set Settings file toacustom ivysettings.xml settings file',

2. Clickon Apply and Close button

If the workspace is not empty, it is recommended to trigger a full resolution and rebuild all the projects using this
new repository configuration:

1. Clean caches

« In the Package Explorer, right-click on a project;
« Select Ivy > Cleanallcaches .
2. Resolve projects using the new repository

To resolve all the workspace projects, click on the Resolve All button in the toolbar:

'® workspaceRepository -

File Edit Source Refactor Mavigate Searc

A | B4~ (

To only resolve a subset of the workspace projects:

« In the Package Explorer, select the desired projects,
+ Right-click on a project and select lvy > Clean all caches .
3. Trigger Add-On Library processors for automatically generated source code

+ Select Project > Clean... ,
+ Select Clean all projects |,

o Clickon Clean button.

Options

Options can be used to parameterize a module description file or a settings file. Options are declared as key/value
pairsin a standard Java properties file, and are expanded using the ${my_property} notation.

Atypical usage in a settings file is for extracting repository server credentials, such as HTTP Basic access authenti-
cation:

1. Declare options in a properties file

3.6. MicroEJ Module Manager 81


https://ant.apache.org/ivy/history/2.5.0/settings.html
https://en.wikipedia.org/wiki/.properties

MicroEJ Documentation, Revision ed46acae

[E| credentials.properties &

1# User specific credentials
2 artifactory.username=myusername
3 artifactory.password=AKCKLzp2JHRLDyFvmTPMXocXiiU1Cnad7eidUcCO1ERSUdgIrIu24ZTYieXaCwuMaIWykjCD9

4

2. Register this property file to MMM options

Options

Property files: | Sfworkspace_loctest/credentials.properties}

3. Usethis option in a settings file

38
39 <credentials host="artifactory.corp” realm="Artifactory Realm” username="${artifactory.username}” passwd="$§{artifactory.password}” />
4/

Atypical usage in a module description file is for factorizing dependency versions across multiple modules projects:

1. Declare an option in a properties file

=| versions.properties &3

=l
14# Specify the EDC wersion used in this workspace
2 edc.version=1.3.8

pu

2. Register this property file to MMM options

Options

Property files: | S{workspace_loc:test/versions.properties)

3. Use this option in a module description file

22 <dependencies:

23 ol--

24 Use the EDC version defined by MMM configuration

25 -

26 <dependency org="ej.api" name="edc" rev="%{edc.version}" /»
27 </dependencies:

28 ¢/ivy-module:
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3.6.6 Module Build

In MicroEJ SDK, the build of a MicroEJ module project can be started as following:

« In the Package Explorer, right-click on the project,
+ Select Build Module .

Awilh B BR-PDHF-O0-QU-FOE- BB
[% Package Explorer 51 T¢ Type Hierarchy s § = E
v'_,ff- module ,
= src/r W
B sre/ Go Into
i f . .
o> srcit Open in New Window
B sroft _
v B\ Moc Open Type Hierarchy F4
e Show In Alt+Shift+ W > broej com-5g).
= STC | =y
- = Co Ctrl+C
) CHa ' CoPY
= Lcg 52 Copy Qualified Name
by moc [ Paste Ctrl+W
REAl 3¢ Delete Delete
Build Path H
Source Alt+Shift+5 »
Refactor Alt+5hift+T >
fxy Import..
iy Export.
i Refresh F5
Close Project
Assign Working Sets...
) PRunAs »
%3 Debug As »
Profile As *
& Build Module
restare trom Local History...
@ JAutodoc ¥

Fig. 23: Module Build

The build of a module can take time depending on

« the module nature to build,
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« the number and the size of module dependencies to download,
« the repository connection bandwidth, ...
The module build logs are redirected to the integrated console.

Alternatively, the build of a MicroEJ module project can be started from the build history:

Hmi DG P H-Q-Q

[ Package Explorer @ module3

4 module E modulel
'l_'—,‘f- moduled [Tﬂ maodule
'l_'—,"f- madule3

Fig. 24: Module Build History

3.6.7 Build Kit

The Module Manager build kit is the consistent set of tools and scripts required for building modules.

It is bundled with MicroEJ SDK and can be exported to run in headless mode using the following steps:'

+ Select File > Export > MicroEJ > Module Manager Build Kit ,
+ Choose an empty Target directory ,

+ Clickonthe Finish button.
Once the build kit is fully exported, the directory content shall look like:

v [ = sdlk_5.2.0_build_kit
w [ ant
= lib
microg)-build-repositony.zip

To go further with headless builds, please consult Tool-CommandLineBuild for command line builds, and this tu-
torial to setup MicroEJ modules build in continuous integration environments).

3.6.8 Former MicroEJ SDK Versions

This section describes MMM configuration elements for MicroEJ SDK versions lower than 5.2.0.

New MicroEJ Module Project

The New MicroEJ Module Project wizard is availableat File > New > Project... , EasyAnt > EasyAnt Project
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Preferences Pages

MMM Preferences Pages are located in two dedicated pages. The following pictures show the options mapping
using the same options numbers declared in Preferences Page.

lvy Preferences Page

The Ivy Preferences Page is available at Window > Preferences > Ivy > Settings .

® preferences

type filter text Settings fe=1E 4 - -

General A
Ant [ reload the settings only on demand
CiC++

Checkstyle
Copyright Default | Workspace... | | File System... | | Variables...
EasyantdEclipse

(l) Ivy settings path: | CiA\Users\user\. microgj\microej-ivysettings-3xml |

Help Ivy user dir: ‘ |
lceTea
Install/Update

Workspace... | | File System... | Variables...

Instant Messaging ~
v by (2) Property files: | Stworkspace loc:easyant-build-comp t/rvy/ivyDE.properties} Edit
Advanced S e loc build. p vy/tvyDE_windows.properties}
Add
Classpath Container
Security Remove
Settings
Source/Javadoc Map Up
Workspace Resolver
¥ML Editor Down
Java
JavaScript
< i > Y Restore Defaults Apply

® Apply and Close Cancel

Easyant Preferences Page

The Easyant Preferences Page is available at Window > Preferences > EasyAnt4Eclipse .

® Preferences

type filter text EasyantdEclipse = T
i:: el Set preferences for EasyAnt4Eclipse.
C/Crs (5) [[]Set verbose mode
Checkstyle (3) [[] Use vyDE preferences for vy settings path
Copyright (4) Ivy settings path: | C:\Program Files\MicroENMicroE)-SDK-19.05\rcp\configuration\org.eclipse.osgi\ 54610\ cpirepositorieshivysettings.xml Browse...
Easyant4Eclipse
Help (7) Max build history size: [ 5
leeTea (6) Runtime JRE jre1.80.221 v
Install/Update
Instant Messaging
v vy
Advanced
Classpath Container
Security
Settings ~
Restore Defaults Apply
< >
@ Apply and Close Cancel
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Export the Build Kit

3.7

Create an empty directory (e.g. mmm_sdk_[version]_build_kit),

Locate your SDK installation plugins directory (by default, C:\Program Files\MicroEJ\MicroEJ
SDK-[version]\rcp\plugins on Windows OS),

Open the file com.is2t.eclipse.plugin.easyant4e_[version].jar with an archive manager,
Extract the directory 1ib to the target directory,

Open the file com.is2t.eclipse.plugin.easyant4e.offlinerepo_[version].jar with an archive man-
ager,

Navigate to directory repositories,

Extractthefilenamed microej-build-repository.zip forMicroEJSDK 5.x or is2t_repo.zip forMicroEJ
SDK 4.1.x to the target directory.

Module Natures

The following table describes the project skeleton name for most common MicroEJ Module Natures.

Table 5: MicroEJ Module Natures Summary

Module Nature Skeleton Direct Wizard
Name
Add-On Library microej- File > New > MicroEJ Add-On Library Project
javalib
Mock microej-
mock
Module Repository artifact-
repository
Sandboxed Application application | File > New > MicroEJ Sandboxed Application Project
Standalone Application firmware- File > New > MicroEJ Standalone Application Project
singleapp

3.7.1 Module Repository

A module repository is a module that bundles a set of modules in a portable ZIP file. It is a tree structure where
modules organizations and names are mapped to folders.
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» = com
v (=g
v [= api

» = bon

v = ecom

» [= ecom=-comm

v (= edc

y =123
~ = 130

CHANGELOG-1.3.0.md
CHAMNGELOG-1.3.0.md.md5
CHAMNGELOG-1.3.0.md.shal
edec-1.3.0,jar
edc-1.3.0.jarmd3
edc-1.3.0.jar.shal
vy-1.3.0xml
ivy-1.3.0xml.md5
ivy-1.3.0.xml.shal
LICEMSE-1.3.0.txt
LICENSE-1.3.0.tct. md5
LICEMNSE-1.3.0.4xt.shal
README-1.3.0.md
README-1.3.0.md.md5
README-1.3.0.md.shal

— «— Modules Tree

(W) () [=) i) [ e f e ‘.f [Tl e [IIE e [ =)

v = fs
s = kf
» (= microui
» [ net
» (= security
» [= sni
» = sp
v = ssl
% [= trace
y = library
> = tool - ) . ]
%) ivysettingsaml «———— LoOcCal (offline) settings file

Fig. 25: Example of MicroEJ Module Repository Tree

A module repository takes its input modules from other repositories, usually the MicroEJ Central Repository which
is itself built by MicroEJ Corp. as a module repository.
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A module repository is often called an offline repository as it includes the settings file for a local configuration in
MicroEJ SDK. It can also be imported in MicroEJ Forge.

Create a Repository Project

In MicroEJ SDK, first create a new module project using the artifact-repository skeleton.

« The ivysettings.xml settings file describes how to import the modules of this repository when it is ex-
tracted locally on file system. This file will be packaged at the root of the zip file and does not need to be
modified.

« The module.ivy file describes how to build repository and lists the module dependencies that will be in-
cluded in this repository.

Configure Resolver for Input Modules

MicroEJ Module Manager (MMM) needs to import dependencies to build the module repository. The location
fetched by MMM is defined by a resolver. The resolver is configured with the parameter bar.populate.from.
resolver . The preset value is the resolver provided by default in MicroEJ SDK configuration, which is connected
to MicroEJ Central Repository.

<ea:property name="bar.populate.from.resolver” value="MicroEJChainResolver"/>

The MicroEJChainResolver is a URL resolver  defined in $USER_HOME\ .
microej\microej-ivysettings-[VERSION].xml that pointsto MicroEJ Central Repository.

To ensure the repository will be compliant with the MMM specification, add the following option:

<ea:property name="bar.check.as.v2.module” value="true"/>

There are other advanced options that do not need to be modified by default. These options are described in the
module.ivy generated by the skeleton.

Include Modules

Modules bundled into the module repository must be declared in the dependencies element of the module.ivy
file.

Include a Single Module

To add a module, declare the module dependency using the artifacts configuration:
<dependencies>
<dependency conf="artifacts->*" transitive="false"” org="[module_orgl” name="[module_name]"” rev=

—"[module_version]"” />

<!-- ... other dependencies ... -->
</dependencies>

For example, to add the ej.api.edc libraryversion 1.2.3, write the following line:

<dependency conf="artifacts->x" transitive="false" org="ej.api" name="edc" rev="1.2.3" />
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Note: We recommended to manually describe each dependency of the module repository, in order to keep full
controloftheincluded modules as well asincluded modules versions. Module dependencies can still be transitively
included by setting the dependency attribute transitive to true. In this case, the included module versions are
those that have been resolved when the module was built.

Multiple versions of the same module can be included by declaring each dependency using a different configura-
tion. The artifacts configuration hasto be derived with a new name as many times as there are different versions
to include.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="artifacts"” visibility="private"/>
<conf name="artifacts_1" visibility="private"/>
<conf name="artifacts_2" visibility="private"/>

<!-- ... other configurations ... -->
</configurations>

<dependencies>

<dependency conf="artifacts->x" transitive="false" org="[module_orgl]"” name="[module_name]"” rev=
—"[module_version_11" />

<dependency conf="artifacts_1->*" transitive="false” org="[module_org]l” name="[module_name]” rev=
—"[module_version_2]" />

<dependency conf="artifacts_2->x" transitive="false"” org="[module_org]l” name="[module_name]" rev=
—"[module_version_3]1" />

<!-- ... other dependencies ... -->
</dependencies>

Include a Module Repository

To add all the modules already included in an other module repository, add the configuration repository ifit
does not exist:

<configurations defaultconfmapping="default->default;provided->provided">

<!-- ... other configurations ... -->

<conf name="repository” visibility="private” description="Repository to be embedded in the repository
">

</configurations>

Then declare the module repository dependency using the repository configuration:

<dependencies>
<dependency conf="repository->*" transitive="false" org="[repository_orgl]" name="[repository_name]”_
—rev="[repository_version]"” />

<!-- ... other dependencies ... -->
</dependencies>
Build the Repository

In the Package Explorer, right-click on the repository project and select Build Module.

The build consists of two steps:
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1. Gathers all module dependencies. The whole repository content is created under target~/
mergedArtifactsRepository folder.

2. Checks the repository consistency. For each module, it tries to import it from this repository and fails the
build if at least one of the dependencies cannot be resolved.

The module repository .zip fileisbuiltinthe target~/artifacts/ folder. This file may be published along with
a CHANGELOG.md, LICENSE.txt and README.md .

Use the Offline Repository

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from MicroEJ
Central Repository.

To configure MicroEJ SDK to import dependencies from a local module repository:
1. Unzip the module repository .zip file to the folder of your choice,

2. Configure MMM settings file using the ivysettings.xml file located at the root of the folder where the repos-
itory has been extracted.

3.8 MicroEJ Classpath

MicroEJ Applications run on a target device and their footprint is optimized to fulfill embedded constraints. The
final execution context is an embedded device that may not even have a file system. Files required by the appli-
cation at runtime are not directly copied to the target device, they are compiled to produce the application binary
code which will be executed by MicroEJ Core Engine.

As a part of the compile-time trimming process, all types not required by the embedded application are eliminated
from the final binary.

MicroEJ Classpath is a developer defined list of all places containing files to be embedded in the final application
binary. MicroEJ Classpath is made up of an ordered list of paths. A path is either a folder or a zip file, called a JAR
file (JAR stands for Java ARchive).

« Application Classpath explains how the MicroEJ Classpath is built from a MicroEJ Application project.

o Classpath Load Model explains how the application contents is loaded from MicroEJ Classpath.

« Classpath Elements specifies the different elements that can be declared in MicroEJ Classpath to describe
the application contents.

3.8.1 Application Classpath

The following schema shows the classpath mapping from a MicroEJ Application project to the MicroEJ Classpath
ordered list of folders and JAR files. The classpath resolution order (left to right) follows the project appearance
order (top to bottom).
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> (s bon-1.3.0jar - C:\cache\gj.api\bon\jars
> [ kf-1.44jar - C\cache\gj.apitkf\jars
> {8 edc-1.23jar - C:\cache\g.apitedcijars _
v B\ Referenced Libraries Additionnal JAR file located in
> (03 extrajar —_— }MyApplication/METAfINF/libraries/extra .jar
> [ src-adpgenerated/wadapps/java
v (= META-INF
» [= certificate
v (= libraries
bt extrajar
» [= properties
&' MANIFEST.MF
v [ src
&= main
» [ src-adpgenerated
[%] CHANGELOG.md
= LICENSE.tdt
ko module.ivy
[¥] README.md

Fig. 26: MicroEJ Application Classpath Mapping

3.8.2 Classpath Load Model

A MicroEJ Application classpath is created via the loading of :

+ an entry point type,

« all . [extension].list files declaredin a MicroEJ Classpath.
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The different elements that constitute an application are described in Classpath Elements. They are searched within
MicroEJ Classpath from left to right (the first file found is loaded). Types referenced by previously loaded MicroEJ
Classpath elements are loaded transitively.
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Fig. 27: Classpath Load Principle

3.8.3 Classpath Elements

The MicroEJ Classpath contains the following elements:

« An entrypoint described in section Application Entry Points;

« Typesin .class files, described in section Types;
« Raw resources, described in section Raw Resources;

« Immutables Object data files, described in Section Immutable Objects;

+ Images, Fonts and Native Language Support (NLS) resources, described in Application Resources;

« x.[extension].list files, declaring contents to load. Supported list file extensions and format is specific
to declared application contents and is described in the appropriate section.

At source level, Java types are stored in src/main/java folder of the module project, any other kind of resources
and list files are stored in the src/main/resources folder.

Application Entry Points

MicroEJ Application entry point declaration differs depending on the application kind:

« In case of a MicroEJ Standalone Application, it is a class that contains a public static void
main(String[]) method, declared using the option application.main.class.
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« In case of a MicroEJ Sandboxed Application, it is a class that implements ej.kf.FeatureEntryPoint , de-
clared inthe Application-EntryPoint entryin META-INF/MANIFEST.MF file.

Types
MicroEJ types (classes, interfaces) are compiled from source code ( . java) to classfiles ( .class ). When a type is
loaded, all types dependencies found in the classfile are loaded (transitively).
Atype can be declared as a Required type in order to enable the following usages:
+ to be dynamically loaded from its name (with a call to Class.forName(String) );
« to retrieve its fully qualified name (with a call to Class.getName() ).

A type that is not declared as a Required type may not have its fully qualified name (FQN) embedded. Its FQN can
be retrieved using the stack trace reader tool (see Stack Trace Reader).

Required Types are declared in MicroEJ Classpath using *.types.list files. The file format is a standard Java
properties file, each line listing the fully qualified name of a type. Example:

# The following types are marked as MicroEJ Required Types
com.mycompany .MyImplementation
java.util.Vector

Raw Resources

Raw resources are binary files that need to be embedded by the application so that they may be dynamically re-
trieved with a call to Class.getResourceAsStream(java.io.InputStream) . Raw Resources are declared in Mi-
croEJ Classpath using *.resources.list files. The file format is a standard Java properties file, each line is a
relative / separated name of a file in MicroEJ Classpath to be embedded as a resource. Example:

# The following resource is embedded as a raw resource
com/mycompany/MyResource. txt

Others resources types are supported in MicrokJ Classpath, see Application Resources for more details.

Immutable Objects

Immutables objects are regular read-only objects that can be retrieved with a call to ej.bon.Immutables.
get(String) . Immutables objects are declared in files called immutable objects data files, which format is de-
scribed in the [BON] specification. Immutables objects data files are declared in MicroEJ Classpath using *.
immutables.list files. The file format is a standard Java properties file, each lineis a / separated name of a
relative file in MicroEJ Classpath to be loaded as an Immutable objects data file. Example:

# The following file is loaded as an Immutable objects data files
com/mycompany/MyImmutables.data

System Properties

System Properties are key/value string pairs that can be accessed with a call to System.getProperty(String).

System Properties are defined when building a Standalone Application, by declaring *.properties.list filesin
MicroEJ Classpath.

The file format is a standard Java properties file. Example:
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Listing 1: Example of Contents of a MicroEJ Properties File

# The following property is embedded as a System property
com.mycompany . key=com.mycompany . value
microedition.encoding=I1S0-8859-1

System Properties are resolved at runtime, and all declared keys and values are embedded as intern Strings.

System Properties can also be defined using Application Options. This can be done by setting the option with a
specific prefix in their name:

« Properties for both the MicroEJ Core Engine and the MicroEJ Simulator : name starts with microej. java.
property.x*

« Properties for the MicroEJ Simulator : name starts with sim. java.property.*
« Properties for the MicroEJ Core Engine : name starts with emb. java.property.*

For example, to define the property myProp with the value theValue, set the following option :
Listing 2: Example of MicroEJ System Property Definition as Applica-
tion Option

microej.java.property.myProp=theValue

Option can also be setinthe VM arguments field of the JRE tab of the launch using the -D option (e.g. -Dmicroej.
java.property.myProp=theValue).

Note: When building a Sandboxed Application, *.properties.list files found in MicroEJ Classpath are silently
skipped.

Constants

Note: This feature require [BON] version 1.4 which is available in MicroEJ Runtime starting from MicroEJ Archi-
tecture version 7.11.0.

Constants are key/value string pairs that can be accessed with a call to ej.bon.Constants.get[Type](String),
where Type if one of:

« Boolean,
» Byte,

« Char,

« Class,

« Double,
« Float,

o Int,
 Long,

« Short,

« String.
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Constants are declared in MicroEJ Classpath *.constants.list files. Thefile formatis a standard Java properties
file. Example:
Listing 3: Example of Contents of a BON constants File

# The following property is embedded as a constant
com.mycompany .myconstantkey=com.mycompany.myconstantvalue
Constants are resolved at binary level without having to recompile the sources.
At link time, constants are directly inlined at the place of Constants.get[Type] method calls with no cost.
The String key parameter must be resolved as an inlined String:

« either a String literal "com.mycompany.myconstantkey"”

« ora static final String field resolved as a String constant
The String value is converted to the desired type using conversion rules described by the [BON] API.

A boolean constant declared in an if statement condition can be used to fully remove portions of code. This
feature is similar to C pre-processors #ifdef directive with the difference that this optimization is performed at
binary level without having to recompile the sources.

Listing 4: Example of if code removal using a BON boolean constant

if (Constants.getBoolean("com.mycompany.myconstantkey”)) {
System.out.println(”"this code and the constant string will be fully removed when the constant is.
—resolved to 'false'"”)

}

Note: In Multi-Sandbox environment, constants are processed locally within each context. In particular, constants
defined in the Kernel are not propagated to Sandboxed Applications.

3.9 Application Resources

Application resources are the following Classpath Elements:

» Images
 Fonts

 Native Lanqguage Support

3.9.1 Images

Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.Image.getimage() or
ej.microui.display.Resourcelmage.loadlmage() . To be displayed, these images have to be converted from their
source format to the display raw format. The conversion can either be done at:

« build-time (using the image generator tool),

« run-time (using the relevant decoder library).
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Images that must be processed by theimage generator tool are declared in MicroEJ Classpath *. images. list files.
Thefile formatis a standard Java properties file, each line representing a / separated resource path relative to the
MicroEJ classpath root referring to a standard image file (e.g. .png, .jpg). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImagel.png

# The following image is embedded
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage?2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

Please refer to Images for more information.

3.9.2 Fonts

Overview

Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont(). To be displayed,
these fonts have to be converted at build-time from their source format to the display raw format by the font gener-
atortool. Fonts that must be processed by the font generator tool are declared in MicroEJ Classpath *. fonts.list
files. The file format is a standard Java properties file, each line representing a / separated resource path relative
to the MicroEJ classpath root referring to a MicroEJ font file (usually with a .ejf file extension). The resource may
be followed by optional parameters which define :

« some ranges of characters to embed in the final raw file;
« the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depthiis 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

MicroEJ font files conventionally end with the .ejf suffix and are created using the Font Designer (see Font De-
signer).
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Font Range
The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. If unspecified, all characters of the font are embedded.

Several ranges can be specified, separated by ; . There are two ways to specify a character range: the custom range
and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.
Examples:
« myfont:0x21-0x49 : Defines one range: embed all characters from 0x21 to 0x49 (included);

« myfont:0x21-0x49,0x55-0x75 : Defines a set of two ranges: embed all characters from 0x21 to 0x49 and
from 0x55 to 0x75.

« myfont:0x21-0x49,0x55 : Defines a set of one range and one character: embed all characters from 0x21 to
0x49 and character 0x55.

Known Range

A known range is a range available in the following table.
Examples:
« myfont:basic_latin:Embed all Basic Latin characters;

« myfont:basic_latin;arabic: Embed all Basic Latin characters, and all Arabic characters.

Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8). If unspecified, the encoded
transparency levelis 1 (does not depend on transparency level encoded in EJF file).

Examples:
« myfont:latin:4:Embed all latin characters with 16 levels of transparency

« myfont::2:Embed all characters with 4 levels of transparency

3.9.3 Native Language Support

Native Language Support (NLS) allows the application to facilitate internationalization. It provides support to ma-
nipulate messages and translate them in different languages. Each message to be internationalized is referenced
by a key, which can be used in the application code instead of using the message directly.

Messages must be defined in PO files in the MicroEJ Classpath of the application. Here is an example:

msgid ""

msgstr "

"Language: en_US\n"

"Language-Team: English\n"

"MIME-Version: 1.0\n"

"Content-Type: text/plain; charset=UTF-8\n"

(continues on next page)
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(continued from previous page)

msgid "Labell”
msgstr "My label 1"

msgid "Label2”
msgstr "My label 2"

These PO files have to be converted to be usable by the application. In order to let the build system know which PO
files to process, they must be referenced in MicroEJ Classpath *.nls.list files. The file format of these *.nls.
list files is a standard Java properties file. Each line represents the Full Qualified Name of a Java interface that
will be generated and used in the application. Here is an example, let’s call it i18n.nls.list:

com.mycompany .myapp.Labels
com.mycompany . myapp . Messages

For each line, PO files whose name starts with the interface name ( Messages and Labels in the example) are
retrieved from the MicroEJ Classpath and used to generate:

+ aJava interface with the given FQN, containing a field for each msgid of the PO files

+ a NLS binary file containing the translations

So, in the example, the generated interface com.mycompany.myapp.Labels will gather all the translations from
files named Labels*.po and located in the MicroEJ Classpath. PO files are generally suffixed by their locale (
Labels_en_US.po ) but it is only for convenience since the suffix is not used, the locale is extracted from the PO
file’s metadata.

Once the generation is done, the application can use the Java interfaces to get internationalized messages, for
example:

import com.mycompany.myapp.Labels;
public class MyClass {

String label = Labels.lLabell;

The generation is triggered when building the application or after a change done in any PO or *.nls.1list files.
This allows to always have the Java interfaces up-to-date with the translations and to use them immediately.

The NLS APl module must be added to the module.ivy of the MicroEJ Application project, in order to allow access
to the NLS library.

<dependency org="ej.library.runtime” name="nls" rev="3.0.1"/>

3.10 Development Tools

MicroEJ provides a number of tools to assist with various aspects of development. Some of these tools are run using
MicroEJ Tool configurations, and created using the Run Configurations dialog of the MicroEJ SDK. A configuration
must be created for the tool before it can be used.
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Fig. 28: MicroEJ Tool Configuration

The above figure shows a tool configuration being created. In the figure, the MicroEJ Platform has been selected,
but the selection of which tool to run has not yet been made. That selection is made in the Execution Settings...
box. The Configuration tab then contains the options relevant to the selected tool.

3.10.1 Test Suite with JUnit

MicroEJ allows to run unit tests using the standard JUnit API during the build process of a MicroEJ library or a
MicroEJ Application. The Test Suite Engine runs tests on a target Platform and outputs a JUnit XML report.

Principle

JUnit testing can be enabled when using the microej-javalib (MicroEJ Add-On Library) or the
microej-application (MicroEJ Applications) build type. JUnit test cases processing is automatically enabled
when the following dependency is declared in the module. ivy file of the project.

<dependency conf="test->*" org="ej.library.test” name="junit" rev="1.5.0"/>
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When a new JUnit test case class is created inthe src/test/java folder, a JUnit processor generates MicroEJ com-
pliant classes into a specific source folder named src-adpgenerated/junit/java. These files are automatically
managed and must not be edited manually.

JUnit Compliance
MicroEJ is compliant with a subset of JUnit version 4. MicroEJ JUnit processor supports the following annotations:
@After, @AfterClass, @efore, @BeforeClass, @Ignore, @Test.

Each test case entry point must be declared using the org. junit.Test annotation (@Test before a method dec-
laration). Please refer to JUnit documentation to get details on usage of other annotations.

Setup a Platform for Tests
Before running tests, a target platform must be configured in the MicroEJ workspace. The following steps assume

that a platform has been previously imported into the MicroEJ Platform repository (or available in the Workspace).

Goto Window > Preferences > MicroEJ > Platforms (or Platformsin workspace )and selectthe desired
platform on which to run the tests.

Press F2 to expand the details.
Select the the platform path and copy it to the clipboard.
Goto Window > Preferences > Ant > Runtime and selectthe Properties tab.

Click on Add Property... button and set a new property named target.platform.dir with the platform path
pasted from the clipboard.

Setup a Project with a JUnit Test Case

This section describes how to create a new JUnit Test Case starting from a new MicroEJ library project.

First create a new module project usingthe microej-javalib skeleton. Anew projectnamed mylibrary iscreated
in the workspace.

Right-click on the src/test/java folderand select New > Other... menu item.

Selectthe Java > JUnit > New JUnit Test Case wizard. Enter a test name and press Finish . A new JUnit
test case class is created with a default failing test case.

Build and Run a JUnit Test Suite

Right-click on the mylibrary project and select Build Module . After the library is built, the test suite engine
launches available test cases and the build process fails in the console view.

Onthe mylibrary project, right-click and select Refresh .

A target~  folder appears with intermediate build files. The JUnit report is available at
target~\test\xml\TEST-test-report.xml.

Double-click on the file to open the JUnit test suite report.

Modify the test case by replacing
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fail(”"Not yet implemented”);
with
Assert.assertTrue(true);

Right-click again on the mylibrary project and select Build Module . The test is now successfully executed on
the target platform so the MicroEJ Add-On Library is fully built and published without errors.

Double-click on the JUnit test suite report to see the test has been successfully executed.

Test Suite Reports

Once a test suite is completed, the following test suite reports are generated:

« JUnit HTML report in the module project location target~/test/html/test/junit-noframes.html . This
report contains a summary and the execution trace of every executed test.

Testsuite Results:

Summary
[ Tests [ Failures [ Errors | Ignored [ Tried Again [ Success rate [ Time |
|54 [15 o lo lo [72.22% |3788.653 |
[ i Failures [ Success [ Success Rate |
|963 [35 |928 [96.37% |

Note: failures are anticipated and checked for with assertions while errors are unanticipated.
Note: ignored tests are executed but not counted on the success rate.

Note: fried again tests are executed but not counted on the success rate

Packages

Note: package statistics are not computed recursively, they only sum up all of its testsuites numbers.

Name i Tried | Time(s) | Time Stamp |Host]
Again
2 Jo o 0 0 134.660 |1598001204286)local
4 o o 0 0 274761 |1598001339008)local
3 o 1 0 o 194.437 1598001613793 local
i 0 o 0 0 66171 |1598001808250|local
31 o 10 0 o 2181.600| 1598001874436 local
10 o 0 0 65519 |1508004056327 local
12 o |4 0 o 871.505 |1598004121855|local

Fig. 29: Example of MicroEJ Test Suite HTML Report

+ JUnit XML report in the module project location target~/test/xml/TEST-test-report.xml.

% TEST-test-reportxml =

i 1 < version="1.0" encoding="UTF-8" standalone="no"?>

ite errors="0" failures="1" hostname="" ignored="0" name="testsuite-hai
classname=" SingleTest MathTest testFact" name=" SingleTest MathTest
! [CDAT! [Unable to locate toois.jar. Expected to find it in C:\Prc

Buildfile: C:\Users\ARM 2016\.ivy2\cache\com.is2t.easyant.plugins\microej-test

10 buildTest:
Fig. 30: Example of MicroEJ Test Suite XML Report

XML report file can also be open in the JUnit View. Right-click on the file> Open With > JUnit View :
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& main

dv JUnit &
& platform
‘& test testsuite-harness-demo test
& classes Runs: 2/2 ® Errors: 0 o Failures: 1 ]
& html , —
| + @l testsuite-harness-demo test (48.128 s = Failure Trace
4 = xm

e _SingleTest_MathTest_testFact (27.337 s)
g _SingleTest_MathTest_testFact2 (20.791 s)

= test
3ul TEST-test-report.xml

Fig. 31: Example of MicroEJ Test Suite XML Report in JUnit View

If executed on device, the Firmware binary produced for each test is available in module project location target~/
test/xml/<TIMESTAMP>/bin/<FULLY-QUALIFIED-CLASSNAME>/application.out.

Advanced Configurations

Autogenerated Test Classes

The JUnit processor generates test classes into the src-adpgenerated/junit/java folder. This folder contains:

_AllTestClasses.java file Asingle classwithamainenty pointthatsequentially calls all declared test methods
of all JUnit test case classes.

_AllTests_[TestCase].java files For each JUnit test case class, a class with a main entry point that sequen-
tially calls all declared test methods.

_SingleTest_[TestCase]_[TestMethod]. java files For each test method of each JUnit test case class, a class
with a main entry point that calls the test method.

JUnit Test Case to MicroEJ Test Case
The Test Suite Engine allows to select the classes that will be executed, by setting the following property in the
project module.ivy file.

<ea:property name="test.run.includes.pattern” value="[MicroEJ Test Case Include Pattern]”/>

Thefollowingline consider all JUnit test methods of the same class as a single MicroEJ test case (default behaviour).
If at least one JUnit test method fails, the whole test case fails in the JUnit report.

<ea:property name="test.run.includes.pattern” value="#*/_AllTests_x%.class"/>

The following line consider each JUnit test method as a dedicated MicroEJ test case. Each test method is viewed
independently in the JUnit report, but this may slow down the test suite execution because a new deployment is
done for each test method.

<ea:property name="test.run.includes.pattern” value="#x/_SingleTest_x*.class"/>

Run a Single Test Manually

Each test can be run independently as each class contains a main entry point.

In the src-adpgenerated/junit/java folder, right-click on the desired autogenerated class (
_SingleTest_[TestCase]_[TestMethod].java)and select RunAs > MicroEJ Application .
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The test is executed on the selected Platform and the output result is dumped into the console.

Test Suite Options

The Test Suite Engine can be configured with specific options which can be added to the module.ivy file of the
project running the test suite, within the <ea:build> XML element.

« Application Option Injection

It is possible to inject an Application Option for all the tests, by adding to the original option the microej.
testsuite.properties. prefix:

<ea:property name="microej.testsuite.properties.[application_option_name]"” value="[application_
—option_value]”/>
+ Retry Mechanism

A test execution may not be able to produce the success trace for an external reason, for example an unre-
liable harness script that may lose some trace characters or crop the end of the trace. For all these unlikely
reasons, it is possible to configure the number of retries before a test is considered to have failed:

<ea:property name="microej.testsuite.retry.count” value="[nb_of_retries]"/>

By default, when a test has failed, it is not executed again (option value is set to 0 ).

Test Specific Options

The Test Suite Engine allows to define Application Options specific to each test case. This can be done by defining
a file with the same name as the generated test case file with the .properties extension instead of the .java
extension. The file must be putinthe src/test/resources folder and within the same package than the test case
file.

3.10.2 Stack Trace Reader
Principle

Stack Trace Reader is a MicroEJ tool that reads and decodes the MicroEJ stack traces. When an exception occurs,
the MicroEJ Core Engine prints the stack trace on the standard output System.out . The class names, non-required
types names(see Types), and method names obtained are encoded with a MicroEJ internal format. This internal
format prevents embedding all class names and method names in the executable image to save some memory
space. The Stack Trace Reader tool allows you to decode the stack traces by replacing the internal class names and
method names with their real names. It also retrieves the line numbers in the MicroEJ Application.

Functional Description

The Stack Trace Reader reads the debug information from the fully linked ELF file (the ELF file that contains the
MicroEJ Core Engine, the other libraries, the BSP, the OS, and the compiled MicroEJ Application). It prints the
decoded stack trace.

When Multi-Sandbox capability is enabled, the stack trace reader can simultaneously decode heterogeneous stack
traces with lines owned by different MicroEJ Sandboxed Applications and the firmware. Lines owned by the
firmware can be decoded with the firmware debug information file (optionally made available by your firmware
provider).
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Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use (Standalone Application)

For example, write the following new line to dump the currently executed stack trace on the standard output.

by module.ivy [J] Testjava &2

<

package com.mycompany;
puoblic clazss Test {
public static void main (String[] args) {

System.out.println ("hello world!"™):;
I new Exceptioni].pIintStackTIace(];[]

Fig. 32: Code to Dump a Stack Trace

To decode an application stack trace, the stack trace reader tool requires the application executable ELF file. In the
case of a platform with full BSP connection (see BSP Connection Cases), the fileis application.out inthe output
folder. In the other cases, the ELF file is generated by the C toolchain when building the BSP project (usuallya .out
or .axf file).
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v'_,ijx MyStandalonelpp

# crc/main/java

’_,ﬂ’} src/main/resources

B\ Module Dependencies moduleivy []

[= build

W [ com.mycompany. Test

= cc
= externalResources
= fonts
= heapDump
[= images
[= logs
= platform
= resourceBuffer
[= soar

E application.out j
= deployHookB5PBuild.properties
MM SOAR.map
SOAR.o
[S] SOAR.s

= nvs

= src

= wifi

CHAMGELOG.md
LICENSE. txt

foy moduleivy
README.md

Fig. 33: Application Binary File

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.

Wh START

Hella 'Warld!

Exception inthread "main" jawvalang Exception
at javalang System @0 0x3407778:0: 3407 7822
at javalang Throwahle Eh:0x3408030:0x 34080 462
at javalang Throwahle Eh:0x34089 0o 0x 3408 ek @
at corm.mycompany. Test @ 0x3f40762c:0x3 407652 (2
at javalang MainThread @k 0x3407284:0x3f407 2982
at javalang Thread (@MM:0x3f4080E8:0x 3408094
at javalang Thread. (@M:0x3f408c7 4:0x3f4 08713

WA EMD (exit code = 0)

Fig. 34: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on RunAs... >
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Run Configurations...

Create a new MicroEJ Tool configuration. In the Execution tab, select your target platform, then select the

Stack Trace Reader tool. Set an output folder in the Output folder field.

Iﬁ o = K | = ? T Mame: | Stack Trace Reader
|t5-'pefi|terte>ct | o Execution I Configuration | ®), JRE| (O] Common
[©] C/C++ Application Target
Ju JUnit Platform: | Browse...
L Launch Group
3] MicroE) Application
~ g Microkl Tool Execution
g Stack Trace Reader
Settings: | Stack Trace Reader
Reads stack trace generated by MicroEl core engine.
Options
Qutput folder: | 5{project_loc:MyStandalonelpp} Browse...
Clean intermediate files [ verbose
Options Files
Add...
Remove
Up
Down

Fig. 35: Stack Trace Reader Tool Configuration (Platform Selection)

In Configuration tab, browse the previously generated application binary file with debug information (

application.out in case of a Standalone Application with full BSP connection)
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CEeEXBY-

| type filter text

[E] C/C++ Application
Ju Wnit
& Launch Group
» [T Microb) Application
~ g MicroEl Tool
[ig Stack Trace Reader

Name: | Stack Trace Reader

Stack Trace Reader

o Execution | 1! Configuration ™, JRIﬂ = Commonw

Application

Executable file: | :meApp},-‘com.mycompany.Te{cfappIication.out |] Browse...

Additional object files:

Add
Remaove
“Trace pert" interface for Eclipse
Connection type: | Console
Port: | COMOD Baudrate: 115200
Port: | 5555 Address:
Stack trace file: Browse...

Fig. 36: Stack Trace Reader Tool Configuration (Standalone Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.

B Console 32 Lf: Problems & Progress

Stack Trace Reader_ [MicroB) Tool]

[INFO] Paste
Exception in

at
at
at
at
dat
atT
at

[ MicroE] Core Engine Trace ]
the MicroE] core engine stack trace here.
thread "main" java.lang.Exception

java.lang.System. [@M:@x3T407773 :0x3T407732(

java.lang.Throwable.@M:8x3T483830: 0x3T403045
java.lang.Throwable.@M:8x3T4889cc :Bx3T488%e6
com.mycompany . Test.@M:8x3f48762c: 8x3T407652(F

9

@
@

java.lang.MainThread.@M:@x3T487a84 :0x3T407398[

java.lang.Thread.
java.lang.Thread.

Excepticn in thread “"main
java.lang.System.getStackTrace(Unknown Source)
java.lang.Throwable.fillInStackTrace(Throwable. java:82)
java.lang.Throwable.<init>»(Throwable.java:32)
com.mycompany.Test.main(Test.java:21)
java.lang.MainThread.run{Thread. java:855)
java.lang.Thread.runkrapper(Thread. java: 464)
java.lang.Thread.callWrapper(Thread. java:449)

at
at
at
at
at
at
at

-

i

M:ex3T403bE8 r0x3T403bo4E

M:@x3f4e3cT4 :@x3T408c 7T

aw

java.lang.Exception

Fig. 37: Stack Trace Reader Console

Use (Sandboxed Application)

For example, write the following new line to dump the currently executed stack trace on the standard output.
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public class MyBackgroundCode implements BackgroundSerwvice {
@verride

public void onStart() {
ff Auto-generated method stub

System.out.println("MyBackgroundCode: Hello Werld™);
[ new Throwable().printStackTrace(); |

¥
Fig. 38: Code to Dump a Stack Trace

To decode an application stack trace, the stack trace reader tool requires the application binary file with debug
information (application.fodbg inthe outputfolder). Note that the file uploaded on the deviceis application.
fo (stripped version without debug information).

W i‘jj- MySandboxedApp
# sre/main/java
“_,f"} src/main/resources
B\ Module Dependencies module.ivy [7]
(# crc-adpgenerated/wadapps/java
=, Referenced Libraries
w [= _MySandboxedfpp_.generated. MySandboxedAppEntryPoint
= externalResources
= resourceBuffer
|=| application.fo

E--;E- applicatiun.fndbﬂ
EE application.map
[= .settings
= applications
= com.microgj.firmware.developer.KernelStartup

[ filesystem

= META-INF

= sre

[ src-adpgenerated
.classpath
.gitignore
Jproject
CHAMGELOG.md
LICEMSE et
module.ivy
README.md

B&mERm=E

Fig. 39: Application Binary File with Debug Information

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.
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com microe]wadapps ki abstractfeaturespplicationstorage INFO: Start MySandhoxedipp
tyBackgroundCode: Hello ‘Warld
Exceptionin thread "ejwadapps.app.default” java lang Throwahle
at javalang. Systemn @hl:0x8052497 c:0x805 295 ol
at javalang Throwakle (Bh4:0x807bBe0 0x807 b5t @
at java.lang. Throwakle. @hi0xE076M4 0807 665E
at comumicroe].example MyBackground Code (2F a5dk2a447701 00000375481 2202 24d0b875ch 9689 36 41:0xc0 38000 @M. 0xcl 38007 c:lxc03600h 2402
at Exception in thread "ejwadapps app.default” javallang/Throwakble
at java/lang/System B 10805497 C:0x0805438CE
at javaglan/Throwable @h:0x0807BEED:0x0807BEFE(R
at java/lang Throwahle. @ 0x08076F4C: 00807 EFEEE
at com/microej{example/ftdyBackground Code (@F abdh2a4477010000d37545(1 e20224d0b87Ech 9889 3641 :0xC03800F0 & EM 0xCO380B 7 C:0xCO380BA4 G
at ejpwadappsfapp/BackgroundServdceProxy @Ffa7a45517201000073783c876987bE5bEe3aaabe 1 d407d 1 :0:300AEBCIEE M: Ix300AB508: 0x300AB51 5@
at com/microejwadapps/managementiutil/Backgroundstdanager (@F fa7a4561720100007378 30876987 hEEbE e 3aaabe1 d407fd1 0xA00AEBCOEE@M: I I00AATE0: 0x00AATIZ (@
at com/microejfwadapps/managementiutil{Backgroundstdanager. @F fa7245517201000073783c876987055h e 3Jaanbe1 d407d1 :0x00ABCOE @M (xI00ABFT 4:0x900ABF52E
at ejjobsersahle/Observable (@F fafa45517201000073783c876987b55h88 3aaafel d407d1:0x300 AEB COE@M 030 0ABAT 0:0xI00ABA4DE
at com/microejwadapps/managementiutil/BackgroundServicaslistimpl (2Ffa7a48617 20100007 37830876987 hA6h8edasalel d407id1: 0x8004EBCOE @ 0x300ADEE4: 0x3004DE94(2
at ejpwadapps/managementBackgroundService sListProxy @F.a5dh2a4477 0100000375481 22022 4d0bE75ckh 96893660 41: 0 COIB00FI @ @M 0xCO380A2E: COIB0AIGE
at __MySandboxeddpp_fgenerated/MySandboxe dAppActvator. @F a5db2a4477010000d 3754611 e20224¢0b8 75chI683 364 1:0:C0 3800F 042 (@M. 0xCO380C54.0xC0380CE2 (@
at ejjcomponentsfregistryimpliabstractRegistry, @h.0x08078E48.0:08078E7 22
at ejfcomponents/registry/util/BundleRegistryHelper @h:0x0806EEE 8:0x0B0BE 7020
at__MySandboxedipp_fgenerated/MySandboxedAppEntryPoint (BF a5db2a4477010000¢ 3754811 2202240 0b875ch 96893614 1 0xC0 3800F0E @M. 0:C0380B04:0:C0 380B2EE
at ejfkikemel$ 2. @ 008055558 (0505589002
at javalanc/Thresd (& 00807 C4F0:0«0807 CE0RE
atjava/lang/Thresd (@ 00807 C333:0x0807 C344(E
atjave/lang/Thresd @i 00807 C485:.0x0807C493(2

Fig. 40: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on RunAs... >

Run Configurations...

Create a new MicroEJ Tool configuration. In the Execution tab, select your target platform, then select the
Stack Trace Reader tool. Set an output folder in the Output folder field.

ERCEER | B Y- MName: | Stack Trace Reader
type filter text | 4 Execution . I Configuration | =, JRE| [C] Commen
[€] C/C++ Application Target
Ju JUnit Platform: | Browse..,

& Launch Group
3] Microk) Application
v [Og MicroEl Toel
[ Stack Trace Reader

Execution
Settings: | Stack Trace Reader

Reads stack trace generated by MicroEl core engine.

Options
Output felder | Sproject_loc:MySandboxedApp} Browse...
Clean intermediate files [verbose
Options Files
Add...
Remaove
Up
Down

Fig. 41 Stack Trace Reader Tool Configuration (Virtual Device Selection)

In the Configuration tab, if the Kernel executable file is available to you (usually named firmware.out and

located inyour Virtual Device files), you can browse for itin the Executable file field, and then add your previously
generated application binary file with debuginformation (application. fodbg in case of a Sandboxed Application)

in the Additional object files field.
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Mame: | Stack Trace Reader |

i Execution | 33 Configuration . =, JRE| ] Commen

Stack Trace Reader Application

Executable file: | Smicrog)_lock 1.6 d00 firmwarefirmware.out Browse...

Additional object files:

1App_.generated MySandboxed AppEntryPoint/application.fodbg Add

Remove

"Trace port" interface for Eclipse

Cennection type: | Conscle ~

COMO 115200

Browse...

Fig. 42: Select the Kernel Executable File

To check where the Kernel executable file of your Virtual Device is located, if you have access to it, goto Window >
Preferences > MicroEJ > Virtual Devices , hoveroveryourVirtual Device in the listand wait untilaninformation

popup appears. Press F2 to get all the informations and the path to the directory of your Virtual Device should
appear in the list.
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[ G.

| type filter text Virtual Devices v M
C/C++ A
Checkstyle
Help Target:
Install/Update Mame Version Lic... Select All

Java
i
w Microk) Dﬂ d

Architectures

200

Add or remove Virtual Devices.

Deselect All
Module Manager I
MNaming Conventicn Uninstall
Platforms
Platforms in workspa Get UID
Settings
Updates
Virtual Devices
Mylyn
Plug-in Development
PMD
Run/Debug
SonarLint

[Path: C:\Users\ I\ microej\repositories\MicroEJ-SDK-Dist-20.1241.6\d001 |

Teamn
Terminal
Validation

XML
v Restore Defaults Apply

'i?;' I\a‘ (=] Apply and Close Cancel

Fig. 43: Location of the Virtual Device Directory

In this directory, the Kernel executable file should be named firmware.out inthe /firmware sub-directory.

If you do not have access to the Kernel executable file, you can still get some information from the Stack Trace
Reader using the application binary file only. In the Configuration tab, browse the previously generated applica-
tion binary file with debug information (application. fodbg in case of a Sandboxed Application)
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O IE 0 [ x| = ? M MName: | Stack Trace Reader

| type filter text | i Bxecution |8 Configuration - =), JRﬂ i Common]
[©] C/C++ Application Stack Trace Reader Application
Ju JUnit - —
# Launch Group Executable file: | rated.MySandboxedAppEntryPom[appllcatlon.fodbg] Browse...
> O Micro) Application Additional object files:
w B MicroEl Tool
O Stack Trace Reader Add
Remove
"Trace port” interface for Eclipse
Connection type: | Console ~
Port: | COMD Baudrate: 115200
Port: | 5555 Address:
Stack trace file: Browse...

Fig. 44: Stack Trace Reader Tool Configuration (Sandboxed Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.
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Bl Console 33

Stack Trace Reader_ [MicroE] Tool] C\Program Files\Java'jrel.8.0 ?_21\b|n\Javaw exe (27-lan-2021 15:18:24)
[ MicroEl Core Engine Trace ]
[INFO] Paste the MicroEl core engine stack trace here.

| Problems =g Prograss 4" Search ]

Exception i

thread " wadapps.app.default” java.lang.Throwable

1 085297 c:0x885a98c@

Bx887b3ed: x807b8T6E

Bx3876T4C: @x307 @

ackgroundCode. aSdb2a4477016000d375458T1220224deba75cb968936Th41 : Bxc@3 800 TOMEM : @xc@380b7 C: @xc@3debasd
.madapp: app dafau__ lang/Throwable

lang.Throwable. @
lang.Throwable.

L (e

on in thread “ej

4477010000d3754571e20224d6b375cb968936Tb41 : @xCO3B06F :BxCB33887C :0xCB338BA
y 7201600073783c876987b55b8e3aaade1d487Td1 : 0x90RAGBCEEHEM : Ox9BBABSES : Ox90BABS
Bac<g cund:.anaga' F:fa7a45517201000073753C876987b55b5e3aaadeld4a7dl : @x908A6BCARGE
BackgroundsManager.{F : fa7a4551720100008737533C5876987b55b3e3aaase1d407Td1: @x9@0@AEBCAHE
7281 EEBB?B?SBCS?FDSFE33b8&3aaa35 a4l B?fd : Bx98@AEBCAHEEM : BxI0RABA1A : BxIBBABALGE
Backgroundser 1 7201@008873783c876967h5508 JaaaBeldanT
@00d3754811e20224d0b875cb368936Fbal : @xCR3800F O
L@F: 3db2a 477010000d37545f1220224d8b375cb968936Tb4l : BxC0O3E0GFBEMEM : 0xCB380C54 : 0xCB330C320
>BBB7E:¥8
@

P0AATI2E

9BRABFS2(

b ery ab e/Obser
vadapps
dapps/managems

nanagement/u
/BackgroundSer
ySandboxedAppAct

int.@F:a5db2a447701 eeeeds?s—af 220224deba75ch968936Th41: BxCa3IB0AFAMHEM : @xC@380804: @xCA38082E4

lang/Thread >.BSE7C¢88:E>.8887C¢93£

Exception in thread "ej.wadapps.app.default” java.lang.Throwable
at java.lang.System.getStackTrace(Unknown Source)
at java.lang.Throwable.fillInStackTrace(Throwable.java:82)
at java.lang.Throwable.<init»(Throwahle.{ava:32)
at com.microej.example.MyBackgroundCode.onStart(MyBackgroundCode. java:17)
at Exception in thread "ej.wadapps.app.default” java/lang/Throwable
at java/lang/System.getStackTrace(Unknown Source)
java/lang/Throwable.fillInStackTrace(Throwable.java:82)
at java/lang/Throwable.<init>(Throwable.{ava:32)
at com/microej/example/MyBackgroundCode.onStart(MyBackgroundCede. java:17)
at ej/wadapps/app/BackgroundserviceProxy.8x98BAB5@8 (Unknown Source)
at com/microej/wadapps/management/util/BackgroundsManager.Bx9BBAATER (Unknown Source)
at com/microej/wadapps/management/util/BackgroundsManager.8x98@ABF14(Unknown Source)
at ej/observable/Observable.8x988ABA1B(Unknown Source)
at com/microej/wadapps/management/util/BackgroundServicesListImpl. @x986AD864 (Unknown Source)
ej/wadapps/management/BackgroundservicesListProxy.add(BackgroundservicesiistProxy. fava:39)
at _ _MySandboxedApp__/generated/MySandboxedAppActivator. link(MySandboxedAppActivator. java:21)
at ej/components/registry/impl/AbstractRegistry.link(AbstractRegistry.java:68)
at ej/components/registry/util/BundleRegistryHelper.startup(BundleRegistryHelper.java:52)
at _ MySandboxedApp__/generated/MySandboxedAppEntryPoint.start(MySandboxedAppEntryPoint. java:15)
at ej/kf/Kernel$2.run(Kernel.java:222)
java/lang/Thread.run{Thread. java:3e3)
at java/lang/Thread.runWrapper(Thread.java:454)
at java/lang/Thread.callWrapper(Thread.java:439)

o
=

W
o+

o
=

Fig. 45: Stack Trace Reader Console

Other debug information files can be appended using the 'Additional object files option.

Stack Trace Reader Options

The following section explains MicroEJ tool options.
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Category: Stack Trace Reader

Stack Trace Reader Application

Executable file: Browse...

Additional object files:

Add

Remove

"Trace port" interface for Eclipse

Connectien type: | Console ~

COMOD 115200

Browse...

Group: Application
Option(browse): Executable file

Option Name: application.file
Default value: (empty)
Description:

Specify the full path of a full linked elf file.

Option(list): Additional object files

Option Name: additional.application.files

Default value: (empty)

Group: “Trace port” interface for Eclipse

Description:

This group describes the hardware link between the device and the PC.

Option(combo): Connection type

Option Name: proxy.connection.connection.type
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Default value: Console
Available values:

Uart (COM)

Socket

File

Console

Description:

Specify the connection type between the device and PC.

Option(text): Port

Option Name: pcboardconnection.usart.pc.port
Default value: COM0

Description:

Format: port name

Specifies the PC COM port:

Windows - COMT, COM2, ..., COM*n*

Linux- /dev/ttySe, /dev/ttyS1, ..., /dev/ttyS*nx

Option(combo): Baudrate

Option Name: pcboardconnection.usart.pc.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description:

Defines the COM baudrate for PC-Device communication.

Option(text): Port

Option Name: pcboardconnection.socket.port
Default value: 5555
Description:

IP port.

3.10. Development Tools

115



MicroEJ Documentation, Revision ed46acae

Option(text): Address

Option Name: pcboardconnection.socket.address
Default value: (empty)
Description:

IP address, on the form A.B.C.D.

Option(browse): Stack trace file

Option Name: pcboardconnection.file.path

Default value: (empty)

3.10.3 Code Coverage Analyzer
Principle

The MicroEJ Simulator features an option to output .cc (Code Coverage) files that represent the use rate of functions
of an application. It traces how the opcodes are really executed.

Functional Description

The Code Coverage Analyzer scans the output .cc files, and outputs an HTML report to ease the analysis of methods
coverage. The HTML report is available in a folder named htmlReport in the same folder as the .cc files.
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Classpath

Code Code
Simulator Coverage Coverage
Files

Analyzer

*

Fig. 46: Code Coverage Analyzer Process

Dependencies
In order to work properly, the Code Coverage Analyzer should input the .cc files. The .cc files relay the classpath

used during the execution of the Simulator to the Code Coverage Analyzer. Therefore the classpath is considered
to be a dependency of the Code Coverage Analyzer.

Installation

This tool is a built-in platform tool.

Use

A MicroEJ tool is available to launch the Code Coverage Analyzer tool. The tool name is Code Coverage Analyzer.

Two levels of code analysis are provided, the Java level and the bytecode level. Also provided is a view of the fully
or partially covered classes and methods. From the HTML report index, just use hyperlinks to navigate into the
report and source / bytecode level code.
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Category: Code Coverage

Code Coverage

*.cc files folder: Browse...

Classes filter

Includes:

Add...

Edit...

Remove

Excludes:

Add...

Edit...

Remove

Option(browse): *.cc files folder

Option Name: cc.dir
Default value: (empty)
Description:

Specify a folder which contains the cc files to process (*.cc).

Group: Classes filter
Option(list): Includes

Option Name: cc.includes
Default value: (empty)
Description:

List packages and classes to include to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : includes all classes which are in package packageA.packageB

packageA.packageB.className : includes the class packageA.packageB.className
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Option(list): Excludes

Option Name: cc.excludes
Default value: (empty)
Description:

List packages and classes to exclude to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : excludes all classes which are in package packageA.packageB

packageA.packageB.className : excludes the class packageA.packageB.className

3.10.4 Heap Dumper & Heap Analyzer
Introduction

Heap Dumper is a tool that takes a snapshot of the heap. Generated files (with the .heap extension) are available
on the application output folder. Note that it works only on simulations. It is a built-in platform tool and has no
dependencies.

The Heap Analyzer is a set of tools to help developers understand the contents of the Java heap and find problems
such as memory leaks. For its part, the Heap Analyzer plug-in is able to open dump files. It helps you analyze their
contents thanks to the following features:

« memory leaks detection
« objects instances browse

+ heap usage optimization (using immortal or immutable objects)

The Heap

The heap is a memory area used to hold Java objects created at runtime. Objects persist in the heap until they are
garbage collected. An object becomes eligible for garbage collection when there are no longer any references to it
from other objects.

Heap Dump

A heap dump is an XML file that provides a snapshot of the heap contents at the moment the file is created. It
contains a list of all the instances of both class and array types that exist in the heap. For each instance it records:

« The time at which the instance was created
+ The thread that created it
« The method that created it
For instances of class types, it also records:
« Theclass
+ The values in the instance’s non-static fields

For instances of array types, it also records:
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« The type of the contents of the array

«+ The contents of the array

For each referenced class type it records the values in the static fields of the class.

Heap Analyzer Tools

The Heap Analyzer is an Eclipse plugin that adds three tools to the MicroEJ environment.

Tool name Number of | Purpose
input files
Heap Viewer 1 Shows what instances are in the heap, when they were created,
and attempts to identify problem areas
Progressive 10r more Shows how the number of instances in the heap has changed over
Heap Usage time
Compare 2 Compares two heap dumps, showing which objects were created,

or garbage collected, or have changed values

Heap Dumper

When the Heap Dumper option is activated, the garbage collector process ends by performing a dump file that
represent a snapshot of the heap at this moment. Thus, to generate such dump files, you must explicitly call the
System.gc() method in your code, or wait long enough for garbage collector activation.

The heap dump file contains the list of all instances of both class and array types that exist in the heap. For each

instance it records:

« the time at which the instance was created

« the thread that created it

« the method that created it

For instances of class types, it also records:

« theclass

« the valuesin the instance’s non-static fields

For instances of array types, it also records:

« the type of the contents of the array

« the contents of the array

For each referenced class type, it records the values in the static fields of the class.
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Category: Heap Dumper

Heap Dumper Application

Executable file: Browse...

Resident application files:
Add...
Remove

Memary

Heap memaory file: | Browse...

Output

Heap file name: | application.heap

Group: Application

Option(browse): Executable file

Option Name: application.filename
Default value: (empty)
Description:

Specify the full path of a full linked ELF file.

Option(list): Resident application files

Option Name: additional.application.filenames
Default value: (empty)
Description:

Specify the full path of resident applications .out files linked by the Firmware Linker.

Group: Memory
Option(browse): Heap memory file

Option Name: heap.filename

Default value: (empty)
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Description:

Specify the full path of heap memory dump, in Intel Hex format.

Group: Output
Option(text): Heap file name

Option Name: output.name

Default value: application.heap

Heap Viewer

To open the Heap Viewer tool, select a heap dump XML file in the Package Explorer , right-click on it and select

Open With > Heap Viewer

Alternatively, right-click on it and select Heap Analyzer > Open heap viewer

This will open a Heap Viewer tool window for the selected heap dump' .
The Heap Viewer works in conjunction with two views:

1. The Outline view

2. The Instance Browser view
These views are described below.

The Heap Viewer tool has three tabs, each described below.

Outline View

The Outline view shows a list of all the types in the heap dump, and for each type shows a list of the instances of
that type. When an instance is selected it also shows a list of the instances that refer to that instance. The Outline
view is opened automatically when an Heap Viewer is opened.

! Although this is an Eclipse ‘editor’, it is not possible to edit the contents of the heap dump.
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E Console |[21 Problems [ 0= Outline &3

33 types - 70 instances (from first to last time stamp)

Type name
. char(]
@ com.is2t.cldec.s3.DefaultSystemOut
» @ com.is2t.test HeapDumpTest
PRC) com.isZt.test. HeapDumpTest5TestOhbj
<p #99
<p £100
. (@ com.is2t.test.HeapDumpTest$ TestObj2
@ &jbonlmmutables
> @ gj.bonImmutablesFile
. int[]
» L& int(]l]
@ ist.support.lang.Systools

L e —

References

<p 208

Type

Instance Browser View

Instances
1

0
1
2

D= R -

Referenced instances
0

=R = R R R R UV )

(=N )

(C] com.is2ttest. HeapDumpTest

Method

@ com.is2t.test. HeapDumpTest.start() : void
@ com.is2t.test.HeapDumpTest.start() : void

Fig. 47: Outline View

@ N |
Thread i
& main
& main

The Instance Browser view opens automatically when a type or instance is selected in the Outline view. It has two
modes, selected using the buttons in the top right corner of the view. In ‘Fields’ mode it shows the field values for
the selected type or instance, and where those fields hold references it shows the fields of the referenced instance,
and so on. In ‘Reference’ mode it shows the instances that refer to the selected instance, and the instances that

refer to them, and so on.

El Console | [Z1 Problems | o= Outline LEEE Fields and Reference Hierarchy &2

Fields - heap file name: Ch\Users\Jehn\.microgfworkspaces\CM_ARMCC-DEV-1.0.0%HeapDumpT est\ com.isz

Field

4 @ this
@ a
Gb
F =

Type Value
® co m.is2t.test.HeapDumpTestiTestObj #100
© int 1
© int 0
© int 0

Fig. 48: Instance Browser View - Fields mode

(R = O
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&l Console (21 Problems EE Cutline T;EE Fields and Reference Hierarchy &2 o[:g =08
References - heap file name : ChUsers'John'umicroefweorkspaces\CM_ARMCC-DEV-1.0.00HeapDumpTest\co
Field Type Value
a @ this C com.isZt.test.HeapDumpTest5TestOhj #100
4 @ testObj C) com.is2t.test.HeapDurmpTest #98
<no references>  <nonex <none:

Fig. 49: Instance Browser View - References mode

Heap Usage Tab

The Heap usage page of the Heap Viewer displays four bar charts. Each chart divides the total time span of the heap
dump (from the time stamp of the earliest instance creation to the time stamp of the latest instance creation) into a
number of periods along the x axis, and shows, by means of a vertical bar, the number of instances created during
the period.

The top-left chart shows the total number of instances created in each period, and is the only chart displayed
when the Heap Viewer is first opened.

When a type or instance is selected in the Outline view the top-right chart is displayed. This chart shows the
number of instances of the selected type created in each time period.

When an instance is selected in the Outline view the bottom-left chart is displayed. This chart shows the
number of instances created in each time period by the thread that created the selected instance.

When an instance is selected in the Outline view the bottom-right chart is displayed. This chart shows the
number of instances created in each time period by the method that created the selected instance.
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[ heap-Oaml 52 =
Instance creation over time, by type, creating thread and creating method Generate graphViz file
Heap usage - Total Instances of type 'com.is2t.test. HeapDumpTest5TestOhy'
Heap usage : 569/569 instance(s) Heap usage: 500/569 instancels)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp
Created by thread 'main’ Created by method 'com.is2t.test HeapDumpTest.start() « void'
Heap usage: 503/589 instance(s) Heap usage : 500/569 instance(s)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp

Heap usage | Dominator tree | Leak suspects

Fig. 50: Heap Viewer - Heap Usage Tab

Clicking on the graph area in a chart restricts the Outline view to just the types and instances that were created
during the selected time period. Clicking on a chart but outside of the graph area restores the Outline view to
showing all types and instances” .

The button Generate graphViz file in the top-right corner of the Heap Usage page generates a file compatible with
graphviz (www.graphviz.org).

Dominator Tree Tab

The Dominator tree page of the Heap Viewer allows the user to browse the instance reference tree which contains
the greatest number of instances. This can be useful when investigating a memory leak because this tree is likely
to contain the instances that should have been garbage collected.

The page contains two tree viewers. The top viewer shows the instances that make up the tree, starting with the
root. The left column shows the ids of the instances - initially just the root instance is shown. The Shallow instances
column shows the number of instances directly referenced by the instance, and the Referenced instances column
shows the total number of instances below this point in the tree (all descendants).

2 The Outline can also be restored by selecting the All types and instances option on the drop-down menu at the top of the Outline view.

3.10. Development Tools 125



MicroEJ Documentation, Revision ed46acae

The bottom viewer groups the instances that make up the tree either according to their type, the thread that created
them, or the method that created them.

Double-clicking an instance in either viewer opens the Instance Browser view (if not already open) and shows de-
tails of the instance in that view.

[0 heap-0xml 2 =0
?;EE Dominator tree : Instance hierarchy that contains greatest number of instances

Dominator tree instances Type

» [ 298 C] com.is2t.test.HeapDumpTest

4 L

Deorminator tree instances grouped by 1ype, thread or method | Types hd

-
Top consumers Instances

C com.isZt.test.HeapDumpTestSTestObj 500
|= java.lang.Object(]

@ java.utilVector

(@ com.is2t.test.HeapDumpTest

=

Heap usage | Dominator tree | Leak suspects

Fig. 51: Heap Viewer - Dominator Tree Tab

Leak Suspects Tab

The Leak suspects page of the Heap Viewer shows the result of applying heuristics to the relationships between
instances in the heap to identify possible memory leaks.

The page is in three parts.

« The top part lists the suspected types (classes). Suspected types are classes which, based on numbers of
instances and instance creation frequency, may be implicated in a memory leak.

+ The middle part lists accumulation points. An accumulation point is an instance that references a high num-
ber of instances of a type that may be implicated in a memory leak.

« The bottom part lists the instances accumulated at an accumulation point.
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[0 heap-Oaml 22

19 Types suspected

C] com.is2t.test.HeapDumpTestSTestOhbj

Accumulation points

Instance

) #381

Type
java.lang.Object(]

Accumulated instances

Instance
dp#123
<y #124
Ep #125
Ep#126
< #130
dp#3
Ep#132
<p#133
dp#134
Jp#135

B i mem

Type

pjojojojojolofolofolo)

com.isZt.test. HeapDumpTest5TestOhy
com.is2t.test. HeapDumpTestSTestOhbj
com.is2t.test.HeapDumpTestSTestObj
com.is2t.test. HeapDumpTestSTestOhbj
com.isZt.test. HeapDumpTest5TestOhy
com.is2t.test. HeapDumpTestSTestOhbj
com.is2t.test.HeapDumpTestSTestObj
com.is2t.test. HeapDumpTestSTestOhbj
com.isZt.test. HeapDumpTest5TestOhy
com.is2t.test. HeapDumpTestSTestOhbj

Heap usage | Dominator tree | Leak suspects

Progressive Heap Usage

Fig. 52: Heap Viewer - Leak Suspects Tab

To open the Progressive Heap Usage tool, select one or more heap dump XML filesin the Package Explorer , right-

click and select Heap Analyzer > Show progressive heap usage

This tool is much simpler than the Heap Viewer described above. It comprises three parts.

+ The top-right part is a line graph showing the total number of instances in the heap over time, based on the

creation times of the instances found in the heap dumps.

« The left part is a pane with three tabs, one showing a list of types in the heap dump, another a list of threads
that created instances in the heap dump, and the third a list of methods that created instances in the heap

dump.

+ The bottom-left is a line graph showing the number of instances in the heap over time restricted to those
instances that match with the selection in the left pane. If a type is selected, the graph shows only instances
of that type; if a thread is selected the graph shows only instances created by that thread; if a method is
selected the graph shows only instances created by that method.
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E”| Progressive Heap Usage %

FProgressive heap usage by type, creating thread and creating method

Types | Threads | Methods|

Mame

char[]

C com.is2t.cldc,s3.DefaultSystem Out
C com.is2t.test.HeapDumpTest

C com.is2t.test. HeapDumpTestSTestObj
C) g.bonImmutables

C) gj.bonImmutablesFile

int[]

int{][]

@ ist.support.lang.Systools

3 ist.support.util EncUS_ASCI

C) ist.suppert.util EncodingConversion
(C] java.io.FileDescriptor

C java.io.FileQutputStream

C java.io.OutputStream

C) java.o. OutputStreamWriter

C) java.ic.Print5stream

C) java.ioWriter

(C] java.lang.Exception

C java.langIndexOutOfBoundsException
@ java.lang.MullPointerException

C) java.lang.Object

m

Type search

Compare Heap Dumps

Heap usage - Total

Instances
570

380

190

39 78 117 156 195 234 273 312 351 390 429 468

Time stamp

Heap usage - Type com.is2t.test HeapDumpTestiTestObj

Instances
501

334

167

3% 78 117 156 195 234 273 312 351 390 429 468
Tirne stamp

Fig. 53: Progressive Heap Usage

The Compare tool compares the contents of two heap dump files. To open the tool select two heap dump XML files
in the Package Explorer, right-click and select Heap Analyzer > Compare

The Compare tool shows the types in the old heap on the left-hand side, and the types in the new heap on the
right-hand side, and marks the differences between them using different colors.

Typesin the old heap dump are colored red if there are one or more instances of this type which are in the old dump
but not in the new dump. The missing instances have been garbage collected.

Types in the new heap dump are colored green if there are one or more instances of this type which are in the new
dump but not in the old dump. These instances were created after the old heap dump was written.

Clicking to the right of the type name unfolds the list to show the instances of the selected type.
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£9 Heap Comparator ©% =0
Show ’AII instances v] Array type C] Class type
[0 Oid heap : heap-0.xm 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
char|] - char[] -
@ com.is2t.cldc.s3.DefaultSystem Out C] com.ist.clde.s3.DefaultSystem Out
(& com.is2ttest.HeapDumpTest (® com.is2ttest HeapDumpTest
(9 com.is2ttest.HeapDumpTestSTestObj (@ com.is2ttest.HeapDumpTestsTestObj
(@ com.is2ttest.HeapDumpTestSTestObj3 {5 com.is2t.test.HeapDumpTestSTestObj2
@ &j.bonlmmutables (@ com.is2t.test.HeapDumpTestSTestObj3
@ gj.benImmutablesFile @ gjbonImmutables
int[] ® gj.bonImmutablesFile
int[]] = int(] E
C] ist.supportlang. Systools 1 int[1[]
(@ ist.support.util EncUS_ASCT (@ ist.suppertlang.Systools
(@ ist.support.util EncodingConversion @ ist.support.util. EncUS_ASCT
(@ java.io.FileDescriptor (@ ist.support.util. EncodingConversion
(@ java.io FileDutputStream (@ java.ioFileDescriptor
(@ java.ic.OutputStream (@ java.ic.FileOutputStream
@ java.o, OutputStreamWiter @ java.o, QutputStream
(& java.io PrintStream — @ java.io.OutputStreamWriter B
(& java.ioWriter (@ java.io.PrintStream
@ java.lang.Exception C] java.ic Writer
@ javalangIndexOutOfBoundsException (@ javalang.Exception
(@ java.lang.MullPointerException @ javalangIndexOutOfBoundsException
(@ javalang.Object @ java.lang.MullPointerException
java.lang.Object[] @ javalang.Object
@ javalang.OutOfMemoryError i java.lang.Object[] i

Fig. 54: Compare Heap Dumps

The combo box at the top of the tool allows the list to be restricted in various ways:

« Allinstances - no restriction.

Garbage collected and new instances - show only the instances that exist in the old heap dump but notin the
new dump, or which exist in the new heap dump but not in the old dump.

Persistent instances - show only those instances that exist in both the old and new dumps.

Persistentinstances with value changed - show only those instances that exist in both the old and new dumps
and have one or more differences in the values of their fields.

Instance Fields Comparison View

The Compare toolworksin conjunction with the Instance Fields Comparison view, which opens automatically when
an instance is selected in the tool.

The view shows the values of the fields of the instance in both the old and new heap dumps, and highlights any
differences between the values.
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£9 Heap Comparator &1

=8
Show ’Persistent instances with value changed vl Array type @ Class type
[0 OId heap : heap-0.xml 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
3 com.ist.testHeapDumpTest (@ com.is?t.test.HeapDumpTest
& com.is?ttestHeapDumpTestSTestObj3 (& com.is?t.test. HeapDumpTestSTestObj3
dp #625 <dp #625
java.ang.Object[] java.lang. Object[]
(& javalang.Thread (& javalang.Thread
@ java.utilVector (@ java.util.Vector
Type com.is2t.test. HeapDumpTestSTestObj3 : 0 instances garbage collected, 0 new instances, 1 persistent instances.
El Console (E_L‘ Problems EE Outline (E Fields and Reference Hierarchy (Eﬁ Instance Fields Comparison 2 =
Fields Type Old value  New value
a @this © com.is2ttest. HeapDumpTestiTestOhbj3 #5625 #6525
@a int 0 0
Gb int 0 3
@c int 0 0

Fig. 55: Instance Fields Comparison view

3.10.5 ELF to Map File Generator

Principle

The ELF to Map generator takes an ELF executable file and generates a MicroEJ compliant .map file. Thus, any ELF
executable file produced by third party linkers can be analyzed and interpreted using the Memory Map Analyzer.

Functional Description

ELF Executable file

Execute
ELF to Map
Tool

Fig. 56: ELF To Map Process
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Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: ELF to Map

ELF to Map Input
ELF file: ‘ | Browse...
Output
Map file: ‘ | Browse...

Group: Input

Option(browse): ELF file

Option Name: input.file

Default value: (empty)

Group: Output

Option(browse): Map file

Option Name: output.file

Default value: (empty)
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3.10.6 Serial to Socket Transmitter
Principle

The MicroEJ serialToSocketTransmitter is a piece of software which transfers all bytes from a serial port to a tcp
client or tcp server.

Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: Serial to Socket

Serial to Socket Serial Options

Port: | COMD Baudrate: | 115200 v

Server Options

Port: | 5555

Group: Serial Options

Option(text): Port

Option Name: serail.to.socket.comm.port
Default value: COM0

Description: Defines the COM port:

Windows - COM1, COM2, ..., COM#n*

Linux- /dev/ttySo, /dev/ttyUSBo, ..., /dev/ttyS*nx, /dev/ttyUSBxnx
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Option(combo): Baudrate

Option Name: serail.to.socket.comm.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description: Defines the COM baudrate.

Group: Server Options
Option(text): Port

Option Name: serail.to.socket.server.port
Default value: 5555

Description: Defines the server IP port.

3.10.7 Memory Map Analyzer
Principle
When a MicroEJ Application is linked with the MicroEJ Workbench, a Memory MAP file is generated. The Memory

Map Analyzer (MMA) is an Eclipse plug-in made for exploring the map file. It displays the memory consumption of
different features in the RAM and ROM.
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Functional Description

MicroEJ
Application

Platform

1. Build the MicroEJ
Application

Map file Executable file

2. Open Memory
Map Analyzer

Fig. 57: Memory Map Analyzer Process

In addition to the executable file, the MicroEJ Platform generates a map file. Double click on this file to open the
Memory Map Analyzer.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use

The map file is available in the MicroEJ Application project output directory.
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[ Pa. i JgMy. EiTe. iTe. = O | [0 HelloWorldjava &3 =g
= & v 2® * Javall .
. 55} MyHelloWorldSample ; package com.microej.example.hello;
4 4% src/main/java 16% import java.io.Filej[]
4 [ com.microej.example.hello 24
> 47| HelloWorld.java 258
. (™ src/main/resources 26 * Prints the message "Hello World !" an displays MicroE] splash
. 27 */
g fn“ Refe.ranced Libraries 28 public class HelloWorld extends Displayable implements EventHandler{
» [ .settings 29
4 [= commicroej.example.hello.HelloWorld 38 private static final int PADDING TEXT =5;
(&= bon 31 private static final int PADDING BETWEEN IMAGE AND TEXT = 3@;
> B ec ?% . final .
. o fonts ;z private final String[] messages; E -
(= heapDump 35 private Image microejImage;
- (= images L
= logs 378 public static void main(String[] args) {
> (= soar 38 -"?i_crnUI.sturt();
- 39 / new Helloworld().sh H
. (= toolbox -
m 48 try {
SOAR.map & 41 socket s = SSLSocketFactory.getDefoult().createSocket();
SOAR.0 a2 } catch (IOException &) {
> (= filesystem v 43 l Auto-generated catch block
N 44 e.printStackTrace();
[% classpath Z; '
X] project 47 File f = mew File("/s55");

&

Fig. 58: Retrieve Map File

Select an item (or several) to show the memory used by this item(s) on the right. Select “All” to show the memory
used by all items. This special item performs the same action as selecting all items in the list.

[# Pa.. 57 FgMy.. EjTe. = [0 | [0S0ARmap i = B8
< 7 ’ Image 5 Runtime Si
- . ame mage Size untime Size e
“ r" T,,yjrij,:nv:‘o;“;as\fample @ All 1899 KB 51.9 KB =
) L‘“ erc/main/resources . @ ApplicationCode 27KB 0B IMAGE: 49.3 KB /189.9 KB
S @ ApplicationFonts 24.2 KB 0B [ 26.00% ]
» =% Referenced Libraries
. @ Applicationlmages 3.2KB 0B :
g L/ settings > @ Applicationlmmutables 264 B 0B _Ap...l ArplicationSirings l
4= fum.mlcmej.examp\E‘heIIU.HeIIuWurld I 0E 0B
.V,_I/ ben > O ApplicationStrings 189 KB 0B (s
L . @ BSP 600 B 3.7KB
(& fonts . @ ClassesNames 71KB 0B
& heapDump . @ CoreEngine 20KB 7.5KB
© = mages . @ CoreEngineAllocator 08 36.0 KB
£ logs . @ Drivers 56 B 0B
=l ;”Z"bux . @ InstalledFestures 08 64B
E SOARmap > @ LibAddonWadapps 2288 0B
SOARo » & LibFoundationBOMN 856 B 0B
- . @ LibFoundaticnEDC 375KB 486 B
& filesystem . @ LibFoundationFs 01KB 4B
& - . @ LibFoundationkF 100 KB 0B
|%] .classpath . = 5
Project . @ L!hFﬂundat!nanchI 26.7 KB 41KB
- @ LibFoundationNET 26.5 KB 4B
. @ LibFoundationSSL 106 KB 0B

Fig. 59: Consult Full Memory

Select an item in the list, and expand it to see all symbols used by the item. This view is useful in understanding
why a symbol is embedded.
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Fig. 60: Detailed View

3.10.8 Event Tracing
Description

Event Tracing allows to record integer based events for debugging and monitoring purposes without affecting ex-
ecution performance too heavily. Basically, it gives access to Tracer objects that are named and can produce a
limited number of different event types.

Arecord is an event type identified by an eventID and can have a list of values. It can be a single event or a period
of time with a start and an end.

Event Tracing can be accessed from two APIs:

+ A Java API, provided by the Trace APl module. The following dependency must be added to the module.ivy
of the MicroEJ Application project:

<dependency org="ej.api" name="trace" rev="1.1.0"/>

« ACAPI, provided by the Platform header file named LLTRACE_impl.h.
Events are recorded if and only if:

« the MicroEJ Core Engine trace system is enabled,

« and trace recording is started.

To enable the MicroEJ Core Engine trace system, set the Application Option named core. trace.enabled to true
(see also launch configuration).

Then, multiple ways are available to start and stop the trace recording:
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+ by setting the Application Option named core.trace.autostart to true to automatically start at startup
(see also launch configuration),

« using the Java APl methods ej.trace.Tracer.startTrace() and ej.trace.Tracer.stopTrace(),

+ using the C API functions LLTRACE_IMPL_start(void) and LLTRACE_IMPL_stop(void).

Java APl Usage

The detailed Trace APl documentation is available here.

First, you need to instantiate a Tracer object by calling its constructor with two parameters. The first parameter,
name, is a String that will represent the Tracer object group’s name. The second parameter, nbEventTypes,isan
integer representing the maximum number of event types available for the group.

Tracer tracer = new Tracer("MyGroup”, 10);

Then, you can record an event by calling the recordEvent(int eventId) method. The event ID needs to be in
the range 0 to nbEventTypes-1 with nbEventTypes the maximum number of event types set when initializing
the Tracer object. Methods named recordEvent(...) always needs the event ID as the first parameter and can
have up to ten integer parameters as custom values for the event.

To record the end of an event, call the method recordEventEnd(int eventID) . It will trace the duration of an
event previously recorded with one of the recordEvent(int) methods. The recordEventEnd(...) method can
also have another integer parameter for a custom value for the event end. One can use it to trace the returned value
of a method.

The Trace API also provides a String constant Tracer. TRACE_ENABLED_CONSTANT_PROPERTY representing the Con-
stant value of core.trace.enabled option. This constant can be used to remove at build time portions of code
when the trace system is disabled. To do that, just surround tracer record calls with a if statement that checks the
constant’s state. When the constant is set to false, the code inside the if statement will not be embedded with
the application and thus will not impact the performances.

if(Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {
// This code is not embedded if TRACE_ENABLED_CONSTANT_PROPERTY is set to false.
tracer.recordEventEnd(0);

}

Examples:

+ Trace asingle event:

private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();
tracer.recordEvent(0);

}

Standard Output:

VM START
[TRACE] [1] Declare group "Application”
[TRACE] [1] Event 0x0

«+ Trace a method with a start event showing the parameters of the method and an end event showing the
result:
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private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();

int a = 14;
int b = 54;
add(a, b);

}

public static int add(int a, int b) {
tracer.recordEvent(1, a, b);
int result = a + b;
tracer.recordEventEnd(1, result);
return result;

3

Standard Output:

VM START

[TRACE] [1] Declare group "Application”
[TRACE] [1] Event ox1 (14 [@OxE],54 [0x36])
[TRACE] [1] Event End 0x1 (68 [0x44])

Platform Implementation
By default, when enabled, the Trace API displays a message in the standard output for every recordevent(...)
and recordEventEnd(...) method calls.

It does not print a timestamp when displaying the trace message because it can drastically affect execution perfor-
mances. It only prints the ID of the recorded event followed by the values given in parameters.

A Platform can connect its own implementation by overriding the functions defined in the LLTRACE_impl.h file.

MicroEJ provides an implementation that redirects the events to SystemView tool, the real-time recording and
visualization tool from Segger. It is perfect for a finer understanding of the runtime behavior by showing events
sequence and duration.

A implementation example for the NXP OM13098 development board with SystemView support is available here.
Please contact our support team for more information about how to integrate this Platform module.

3.10.9 Null Analysis

NullPointerException thrown at runtime is one of the most common causes for failure of Java programs. The Null
Analysis tool can detect such programming errors (misuse of potential null Java values) at compile-time.

The following example of code shows a typical Null Analysis error detection in MicroEJ SDK.
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& Mainjava 2 = 8
1 package nullanalysis; ~ N
3 public class Main {
58 public static woid example() {
6 // The following ‘getProperty' method can return a 'null' value

f/ {@Nullable String java.lang.System.getProperty(String key)
Sstring myValue = System.getProperty("APropertyThatMayBeUndefined™);

f/ The following 'println’ method allows Nullable argument
'/ woid java.io.PrintStream.println(@Nullable String x)

System.out.println(myValue); =
14 /{ ERROR: 'Potential null peinter access: The variable myValue may be null at this location’
my¥alue. toUpperCase();
T v
g Problems &3 r § = O

1 error, 0 warnings, 0 others
Description

w @ Errors (1 item)
43 Potential null pointer access: The variable myValue may be null at this location

Fig. 61: Example of Null Analysis Detection

Principle
The Null Analysis tool is based on Java annotations. Each Java field, method parameter and method return value
must be marked to indicate whether it can be null or not.

Once the Java code is annotated, module projects must be configured to enable Null Analysis detection in MicroEJ
SDK.

Java Code Annotation

MicroEJ defines its own annotations:

« @NonNullByDefault: Indicates that all fields, method return values or parameters can never be null in the
annotated package or type. This rule can be overridden on each element by using the Nullable annotation.

« @Nullable: Indicates that a field, local variable, method return value or parameter can be null.
« @NonNull: Indicates that a field, local variable, method return value or parameter can never be null.
MicroEJ recommends to annotate the Java code as follows:

« In each Java package, create a package-info.java file and annotate the Java package with
@NonNullByDefault . Thisis a common good practice to deal with non null elements by default to avoid
undesired NullPointerException. It enforces the behavior which is already widely outlined in Java coding
rules.
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[ Package Explorer 57 = B [J] package-infojava &3
elsl

v',_'—';',- nullanalysis -

@Ej.annntatiun.ch”ullByDEfaultI
2 package nullanalysis;

L,

~ [ sre/main/java

v nullanalysis
)| package-info.java |

B crefmain,resources

« IneachJavatype, annotate allfields, methods return values and parameters that can be null with @Nullable.
Usually, this information is already available as textual information in the field or method Javadoc comment.
The following example of code shows where annotations must be placed:

@Mullable
public Object thisFieldCanBeNull;

@Nullable

public Object thisMethodCanReturnNull() {
return null;
¥

public void thisMethodParameterCanBeNull{@Nullable Object param) {

¥

Note: MicroEJ SDK 5.3.0 or higher requires annotations declared in EDC-1.3.3 or higher. See EDC 1.3.3 Changelog
for more details.

Module Project Configuration

To enable the Null Analysis tool, a module project must be configured as follows:
+ In the Package Explorer, right-click on the module project and select Properties ,

+ Navigate to Java Compiler > Errors/Warnings ,

+ Inthe Nullanalysis section, configure options as follows:
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® Properties for

| | | Errors/Warnings - -~ 8
Re_snurce Enable project specific settings Configure Workspace Settings...
Builders
Checkstyle Select the severity level for the following optional problems:

Git
hy | type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off) |
JAutedoc ~ Null analysis ~
Java Build Path Mull pointer access: Error w
Java Code Style
~ Java Compiler Potential null pointer access: Error ~
Annotation Processing
- Redundant null check: Error ~
Building
Errors/Warnings [~include 'assert’ in null analysis
Javadoc nable annotation-based null analysis
Task Tags ) Violation of null specification: Error ~
Javadoc Location
Java Editor Conflict between null annotations and null inference: Error ~
PMD .
Project Natures Unchecked conversion from non-annotated type to @NonMNull type: Error ~
Project References Unsafe conversion of annotated parameterized type to less-annotated type: Error ~
Run/Debug Settings
SonarLint Problems detected by pessimistic analysis for free type variables: Error w
Task Repositary Unsafe '@MNennull’ interpretation of free type variable from librany: Error ~
WikiText
Redundant null anneotation: Error ~
'@MonMull' parameter not annotated in overriding method: Error ~
Missing '@MNonMullByDefault’ annotation on package: Error w
se default annotations for null specification
nherit null annctations
nable syntactic null analysis for fields
v
Restore Defaults Apply
?\ Apply and Close Cancel
+ Click onthe Configure... link to configure MicroEJ annotations:
- ej.annotation.Nullable
- ej.annotation.NonNull
- ej.annotation.NonNullByDefault
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Enter customn annotation names for null specifications.

Primary annctations are for active use in source and class files, whereas secondary annotations are
intended only for interpreting API of third-party libraries,

‘Mullable' annotations:

Elements annotated with the '@Mullable’ annotation can be null,

Primary annotation: lej.annotation.Mullable]

Secondary annotations: | [ Add
‘MonMull' annotations:

Elements annctated with '@MNenMull' must never be null,

Primary annotation: lej.annotation.MonMull |

Secondary annotations: | [ Add

‘MonMullByDefault’ annotations:

The '@MNonMNullByDefault’ annotation sets ‘'non-null’ as default for all elements in a package, type,
or method. When using Eclipse's default '@MonMullByDefault’ annetation, an optional annotation
argument is evaluated, allowing to cancel or fine-tune the 'non-null’ default.

Primary annotation: |e_i.annu:utatiu:ur1.NDnNuIIB}rEIEfauIt|

Secondary annotations: | | [ Add
@' Restore Defaults] [ oK ] ’ Cancel l

« Inthe Annotations section, check Suppress optional errors with ‘@SuppressWarnings’ option:
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®¥ Properties for nullana

[l | | Errors/Warnings MR
Re_snurce ~ Enable project specific settings Configure Workspace Settings...
Builders
Checkstyle Select the severity level for the following optional problems:
hvy . - . .

IAutodoc | type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off) |
Java Build Path ~ Annotations ~
Java Code Style Missing '@Override’ annotation: lgnore

~ Java Compiler

Annatation Processin Include implementations of interface methods (1.6 or higher)

Building Missing '@Deprecated’ annotation: Ignore
Errors/Warnings o . -
Annotation is used as super interface: Warning ~
Javadoc
Task Tags Unhandled teken in '@5uppressWarnings': Warning
Ja\radnr? Location Enable '@5SuppressWarnings' annotations
lava Editor
PMD Unused '@5SuppressWarnings' token: Warning
Pm_!ect Natures ‘Unused’ status is not fully known because a relevant option is set to 'lgnore”: Info ~
Project References
Refactoring History I Suppress optional errors with '@5uppressWamings'| v
Run/Debug Settings
< J J 5 v Restore Defaults Apply

?\ Apply and Close Cancel

This option allows to fully ignore Null Analysis errors in advanced cases using @SuppressWarnings("null")
annotation.

If you have multiple projects to configure, you can then copy the content of the .settings folder to an other
module project.
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v '_.'j‘J nullanalysis
w [ cro/main/java
B nullanalysis
P src/main/resources
B sroftest/java
8 sroftest/resources
Bl Module Dependencies moduleivy [*]

w [ .settings
org.eclipse.jdt.core.prefs

org.eclipse.jdt.ui.prefs

= internal

= src

[= src-adpgenerated
.classpath
.gitignore

.project
[%] CHANGELOG.md
= LICEMSE txt

by module.ivy
[#] README.md

Fig. 62: Null Analysis Settings Folder

Warning: You may lose information if your target module project already has custom parameterization or if it
was created with another MicroEJ SDK version. In case of any doubt, please configure the options manually or
merge with a text file comparator.

MicroEJ Libraries

Many libraries available on MicroEJ Central Repository are annotated with Null Analysis. If you are using a library
which is not yet annotated, please contact our support team.

For the benefit of Null Analysis, some APIs have been slightly constrained compared to the Javadoc description.
Here are some examples to illustrate the philosophy:

« System.getProperty(String key, String def) does not accept a null default value, which allows to ensure the
returned value is always non null.

+ Collections of the Java Collections Framework that can hold null elements (e.g. HashMap) do not accept
null elements. This allows APIs to return null (e.g. HashMap.get(Object)) only when an element is not
contained in the collection.

Implementations are left unchanged and still comply with the Javadoc description whether the Null Analysis is
enabled or not. So if these additional constraints are not acceptable for your project, please disable Null Analysis.

Advanced Use

For more information about Null Analysis and inter-procedural analysis, please visit Eclipse JDT Null Analysis doc-
umentation.
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3.11 Advanced Tools

3.11.1 MicroEJ Linker

Overview

MicroEJ Linker is a standard linker that is compliant with the Executable and Linkable File format (ELF).

MicroEJ Linker takes one or several relocatable binary files and generates an image representation using a descrip-
tion file. The process of extracting binary code, positioning blocks and resolving symbols is called linking.

Relocatable object files are generated by SOAR and third-party compilers. An archive file is a container of Relocat-
able object files.

The descriptionfile is called a Linker Specific Configuration file (Isc). It describes what shall be embedded, and how
those things shall be organized in the program image. The linker outputs :

+ An ELF executable file that contains the image and potential debug sections. This file can be directly used by
debuggers or programming tools. It may also be converted into a another format (Intel* hex, Motorola* s19,
rawBinary, etc.) using external tools, such as standard GNU binutils toolchain (objcopy, objdump, etc.).

« Amap file, in XML format, which can be viewed as a database of what has been embedded and resolved by
the linker. It can be easily processed to get a sort of all sizes, call graphs, statistics, etc.

+ The linker is composed with one or more library loaders, according to the platform’s configuration.

ELF Overview

An ELF relocatable file is split into several sections:
« allocation sections representing a part of the program
« control sections describing the binary sections (relocation sections, symbol tables, debug sections, etc.)

An allocation section can hold some image binary bytes (assembler instructions and raw data) or can refer to an
interval of memory which makes sense only at runtime (statics, main stack, heap, etc.). An allocation section is an
atomic block and cannot be split. A section has a name that by convention, represents the kind of data it holds.
For example, .text sections hold binary instructions, .bss sections hold read-write static data, .rodata hold
read-only data, and .data holds read-write data (initialized static data). The nameis used in the.Isc file to organize
sections.

A symbol is an entity made of a name and a value. A symbol may be absolute (link-time constant) or relative to a
section: Its value is unknown until MicroEJ Linker has assigned a definitive position to the target section. A symbol
can be local to the relocatable file or global to the system. All global symbol names should be unique in the system
(the name is the key that connects an unresolved symbol reference to a symbol definition). A section may need the
value of symbols to be fully resolved: the address of a function called, address of a static variable, etc.

Linking Process

The linking process can be divided into three main steps:

1. Symbols and sections resolution. Starting from root symbols and root sections, the linker embeds all sec-
tions targeted by symbols and all symbols referred by sections. This process is transitive while new symbols
and/or sections are found. At the end of this step, the linker may stop and output errors (unresolved symbols,
duplicate symbols, unknown or bad input libraries, etc.)
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2. Memory positioning. Sections are laid out in memory ranges according to memory layout constraints de-
scribed by the Isc file. Relocations are performed (in other words, symbol values are resolved and section
contents are modified). At the end of this step, the linker may stop and output errors (it could not resolve
constraints, such as not enough memory, etc.)

3. Anoutput ELF executable file and map file are generated.

A partial map file may be generated at the end of step 2. It provides useful information to understand why the link
phase failed. Symbol resolution is the process of connecting a global symbol name to its definition, found in one of
the linker input units. The order the units are passed to the linker may have an impact on symbol resolution. The
rules are:

+ Relocatable object files are loaded without order. Two global symbols defined with the same name result in
an unrecoverable linker error.

« Archive files are loaded on demand. When a global symbol must be resolved, the linker inspects each archive
unit in the order it was passed to the linker. When an archive contains a relocatable object file that declares
the symbol, the object file is extracted and loaded. Then the first rule is applied. It is recommended that you
group object files in archives as much as possible, in order to improve load performances. Moreover, archive
files are the only way to tie with relocatable object files that share the same symbols definitions.

« Asymbol name is resolved to a weak symbol if - and only if - no global symbol is found with the same name.

Linker Specific Configuration File Specification

Description

A Linker Specific Configuration (Lsc) file contains directives to link input library units. An Isc file is written in an XML
dialect, and its contents can be divided into two principal categories:

« Symbols and sections definitions.

+ Memory layout definitions.

Listing 5: Example of Relocation of Runtime Data from FLASH to RAM

<?xml version="1.0" encoding="UTF-8"7>
<l--
An example of linker specific configuration file
-—>
<lsc name="MyAppInFlash">
<include name="subfile.lscf"/>
LY==
Define symbols with arithmetical and logical expressions
-—>
<defSymbol name="FlashStart” value="0"/>
<defSymbol name="FlashSize" value="0x10000"/>
<defSymbol name="FlashEnd" value="FlashStart+FlashSize-1"/>
Kl==
Define FLASH memory interval
-—>
<defSection name="FLASH" start="FlashStart"” size="FlashSize"/>

<l--
Some memory layout directives
-—>
<memorylLayout ranges ="FLASH">
<sectionRef name ="=*.text"/>
(continues on next page)
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(continued from previous page)
<sectionRef name ="x.data"/>
</memorylLayout>
</1sc>

File Fragments

An lsc file can be physically divided into multiple Isc files, which are called lsc fragments. Lsc fragments may be
loaded directly from the linker path option, or indirectly using the include tagin an Isc file.

Lsc fragments start with the root tag 1scFragment . By convention the lsc fragments file extensionis . 1scf . From
here to the end of the document, the expression “the Isc file” denotes the result of the union of all loaded (directly
and indirectly loaded) Isc fragments files.

Symbols and Sections

A new symbol is defined using defSymbol tag. Asymbol has a name and an expression value. All symbols defined
in the Isc file are global symbols.

A new section is defined using the defSection tag. A section may be used to define a memory interval, or define
a chunk of the final image with the description of the contents of the section.

Memory Layout

A memory layout contains an ordered set of statements describing what shall be embedded. Memory positioning
can be viewed as moving a cursor into intervals, appending referenced sections in the order they appear. A symbol
can be defined as a “floating” item: Its value is the value of the cursor when the symbol definition is encountered.
In the example below, the memory layout sets the FLASH section. First, all sections named .text are embedded.
The matching sections are appended in a undefined order. To reference a specific section, the section shall have a
unique name (for example a reset vector is commonly called .reset or .vector,etc.). Then, the floating symbol
dataStart is set to the absolute address of the virtual cursor right after embedded .text sections. Finally all
sections named .data are embedded.

A memory layout can be relocated to a memory interval. The positioning works in parallel with the layout ranges,
as if there were two cursors. The address of the section (used to resolve symbols) is the address in the relocated
interval. Floating symbols can refer either to the layout cursor (by default), or to the relocated cursor, using the
relocation attribute. A relocation layout is typically used to embed data in a program image that will be used
at runtime in a read-write memory. Assuming the program image is programmed in a read only memory, one of
the first jobs at runtime, before starting the main program, is to copy the data from read-only memory to RAM,
because the symbols targeting the data have been resolved with the address of the sections in the relocated space.
To perform the copy, the program needs both the start address in FLASH where the data has been put, and the
start address in RAM where the data shall be copied.

Listing 6: Example of Relocation of Runtime Data from FLASH to RAM

<memorylLayout ranges="FLASH" relocation="RAM" image="true">
<defSymbol name="DataFlashStart"” value="."/>
<defSymbol name="DataRamStart” value=" ." relocation="true"/>
<sectionRef name=".data"/>
<defSymbol name="DataFlashLimit"” value="."/>

</memoryLayout>
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Note: the symbol DataRamStart is defined to the start address where .data sections will be inserted in RAM

memory.

Tags Specification

Here is the complete syntactical and semantical description of all available tags of the .1sc file.

Table 6: Linker Specific Configuration Tags

Tags

Attributes

Description

defSection

Defines a new section. A floating section only holds a declared size
attribute. A fixed section declares at least one of the start / end at-
tributes. When this tag is empty, the section is a runtime section, and
must define at least one of the start, end or size attributes. When
this tag is not empty (when it holds a binary description), the section
is an image section.

name

Name of the section. The section name may not be unique. However,
it is recommended that you define a unique name if the section must
be referred separately for memory positioning.

start

Optional. Expression defining the absolute start address of the sec-
tion. Must be resolved to a constant after the full load of the Isc file.

end

Optional. Expression defining the absolute end address of the section.
Must be resolved to a constant after the full load of the Isc file.

size

Optional. Expression defining the size in bytes of the section. Invari-
ant: (end-start)+1=size . Must be resolved to a constant after the
full load of the Isc file.

align

Optional. Expression defining the alignment in bytes of the section.

rootSection

Optional. Boolean value. Sets this section as a root section to be em-
bedded even if it is not targeted by any embedded symbol. See also
rootSection tag.

symbolPrefix

Optional. Used in collaboration with symbolTags . Prefix of symbols
embedded in the auto-generated section. See Auto-generated Sec-
tions.

symbolTags

Optional. Used in collaboration with symbolPrefix . Comma sepa-
rated list of tags of symbols embedded in the auto-generated section.
See Auto-generated Sections.

defSymbol

Defines a new global symbol. Symbol name must be unique in the
linker context

name

Name of the symbol.

type

Optional. Type of symbol usage. This may be necessary to set the type
of a symbol when using third party ELF tools. There are three types: -
none : default. No special type of use. - function: symbol describes
a function. - data: symbol describes some data.

value

The value "." defines a floating symbol that holds the current cur-
sor position in a memory layout. (This is the only form of this tag that
can be used as a memorylLayout directive) Otherwise value is an ex-
pression. A symbol expression must be resolved to a constant after

memory positioning.

relocation

Optional. The only allowed value is true . Indicates that the value
of the symbol takes the address of the current cursor in the memory
layout relocation space. Only allowed on floating symbols.

Continued on next page
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Table 6 - continued from previous page
Tags Attributes Description
rootSymbol Optional. Boolean value. Sets this symbol as a root symbol that must
be resolved. See also rootSymbol tag.
weak Optional. Boolean value. Sets this symbol as a weak symbol.
memorylLayout directive. Defines a named group of sections. Group
name may be used in expression macros START, END, SIZE.All mem-
oryLayout directives are allowed within this tag (recursively).
name The name of the group.
Includes an lsc fragment file, semantically the same as if the fragment
contents were defined in place of the include tag.
name Name of the file to include. When the name is relative, the file sepa-
rator is /, and the file is relative to the directory where the current
[sc file or fragment is loaded. When absolute, the name describes a
platform-dependent filename.
Root tag for an .Isc file.
name Name of the Isc file. The ELF executable output will be {name}.out,
and the map file will be {name}.map
1scFragment Root tag for an Isc file fragment. Lsc fragments are loaded from the
linker path option, or included from a master file using the include
tag.
Describes the organization of a set of memory intervals. The memory
layouts are processed in the order in which they are declared in the
file. The same interval may be organized in several layouts. Each lay-
out starts at the value of the cursor the previous layout ended. The fol-
lowing tags are allowed within a memoryLayout directive: defSymbol
(under certain conditions), group, memorylLayoutRef, padding,and
sectionRef .
ranges Exclusive with default. Comma-separated ordered list of fixed sections
to which the layout is applied. Sections represent memory segments.
image Optional. Boolean value. false if not set. If true, the layout de-
scribes a part of the binary image: Only image sections can be embed-
ded. If false, only runtime sections can be embedded.
relocation Optional. Name of the section to which this layout is relocated.
name Exclusive with ranges. Defines a named memoryLayout directive in-
stead of specifying a concrete memory location. May be included in a
parent memoryLayout using memoryLayoutRef.
memorylLayout directive. Provides an extension-point mechanism to
include memoryLayout directives defined outside the current one.
name All directives of memoryLayout defined with the same name are in-
cluded in an undefined order.
memorylLayout directive. Append padding bytes to the current cursor.
Either size or align attributes should be provided.
size Optional. Expression must be resolved to a constant after the full load
of the Isc file. Increment the cursor position with the given size.
align Optional. Expression must be resolved to a constant after the full load
ofthe Iscfile. Move the current cursor position to the next address that
matches the given alignment. Warning: when used with relocation,
the relocation cursor is also aligned. Keep in mind this may increase
the cursor position with a different amount of bytes.
address Optional. Expression must be resolved to a constant after the full load
of the Isc file. Move the current cursor position to the given absolute
address.

group

include

1sc

memorylLayout

memorylLayoutRef

padding

Continued on next page
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Table 6 - continued from previous page
Tags Attributes Description
fill Optional. Expression must be resolved to a constant after the full load
of the Isc file. Fill padding with the given value (32 bits).
References a section name that must be embedded. This tagis not a
definition. It forces the linker to embed all loaded sections matching
the given name.
name Name of the section to be embedded.
References a symbol that must be resolved. This tagis not a definition.
It forces the linker to resolve the value of the symbol.
name Name of the symbol to be resolved.
Memory layout statement. Embeds all sections matching the given
name starting at the current cursor address.
file Select only sections defined in a linker unit matching the given file
name. The file name s the simple name without any file separator, e.g.
bsp.o or mylink.lsc. Link units may be object files within archive
units.
name Name of the sections to embed. When the name ends with *, all sec-
tions starting with the given name are embedded (name completion),
except sections that are embedded in another sectionRef using the ex-
act name (without completion).
symbol Optional. Only embeds the section targeted by the given symbol. This
is the only way at link level to embed a specific section whose name is
not unique.
force Optional. Deprecated. Replaced by the rootSection tag. The only
allowed value is true. By default, for compaction, the linker embeds
only what is needed. Setting this attribute will force the linker to em-
bed all sections that appear in all loaded relocatable files, even sec-
tions that are not targeted by a symbol.
sort Optional. Specifies that the sections must be sorted in memory. The
value can be: - order : the sections will be in the same order as the
input files - name : the sections are sorted by their file names - unit
: the sections declared in an object file are grouped and sorted in the
order they are declared in the object file
Binary section statement. Describes the four next raw bytes of the
section. Bytes are organized in the endianness of the target ELF ex-
ecutable.
value Expression must be resolved to a constant after the full load of the lsc
file (32 bits value).
Binary section statement. Fills the section with the given expression.
Bytes are organized in the endianness of the target ELF executable.
size Expression defining the number of bytes to be filled.
value Expression must be resolved to a constant after the full load of the lsc
file (32 bits value).

rootSection

rootSymbol

sectionRef

u4

fill

Expressions

An attribute expression is a value resulting from the computation of an arithmetical and logical expression. Sup-
ported operators are the same operators supported in the Java language, and follow Java semantics:

« Unaryoperators: + , - , ~ | |

+ Binaryoperators: + , -, x /| %, <<, >>> 0>> <> <= 0 >= == 1= & | 4
&& , |l
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« Ternary operator: cond ? ifTrue : ifFalse

« Built-in macros:

START (name) : Get the start address of a section or a group of sections

END(name) : Get the end address of a section or a group of sections

SIZE(name) : Get the size of a section or a group of sections. Equivalent to END(name)-START (name)

TSTAMPH() , TSTAMPL () : Get 32 bits linker time stamp (high/low part of system time in milliseconds)

SUM(name, tag) : Get the sum of an auto-generated section (Auto-generated Sections) column. The col-
umn is specified by its tag name.

An operand is either a sub expression, a constant, or a symbol name. Constants may be written in decimal (127) or
hexadecimal form (@x7F ). There are no boolean constants. Constant value @ means false, and other constants’
values mean true. Examples of use:

value="symbol+3"
value="((symbol1x4)-(symbol2%3)"

Note: Ternary expressions can be used to define selective linking because they are the only expressions that may
remain partially unresolved without generating an error. Example:

<defSymbol name="myFunction” value="condition ? symbl : symb2"/>

No error will be thrown if the condition is true and symb1 is defined, or the condition is false and symb2 is
defined, even if the other symbol is undefined.

Auto-generated Sections

The MicroEJ Linker allows you to define sections that are automatically generated with symbol values. This is com-
monly used to generate tables whose contents depends on the linked symbols. Symbols eligible to be embedded
in an auto-generated section are of the form: prefix_tag_suffix.An auto-generated section is viewed as a table
composed of lines and columns that organize symbols sharing the same prefix. On the same column appear sym-
bols that share the same tag. On the same line appear symbols that share the same suffix. Lines are sorted in the
lexical order of the symbol name. The next line defines a section which will embed symbols starting with zeroinit
. The first column refers to symbols starting with zeroinit_start_;the second column refers to symbols starting
with zeroinit_end_.

<defSection
name=".zeroinit"
symbolPrefix="zeroInit"
symbolTags="start,end"”
/>

Consider there are four defined symbols named zeroinit_start_xxx , zeroinit_end_xxx ,
zeroinit_start_yyy and zeroinit_end_yyy . The generated section is of the form:

0x00: zeroinit_start_xxx
0x04: zeroinit_end_xxx
0x08: zeroinit_start_yyy
0x0C: zeroinit_end_yyy

If there are missing symbols to fill a line of an auto-generated section, an error is thrown.
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Execution

MicroEJ Linker can be invoked through an ANT task. The task is installed by inserting the following code in an ANT

script

<taskdef
name="linker"
classname="com.is2t.linker.GenericLinkerTask"
classpath="[LINKER_CLASSPATH]"

/>

[LINKER_CLASSPATH] is a list of path-separated jar files, including the linker and all architecture-specific library

loaders.

The following code shows a linker ANT task invocation and available options.

<linker
doNotLoadAlreadyDefinedSymbol="[true|false]”
endianness="[little|big|none]”
generateMapFile="[true|false]”
ignoreWrongPositioningForEmptySection="[true|false]”
lsc="[filename]"
linkPath="[pathl:...pathN]"
mergeSegmentSections="[true|false]”
noWarning="[true|false]"
outputArchitecture="[tag]"
outputName="[name]"”
stripDebug="[true|false]”
toDir="[outputDir]”
verboselLevel="[0...9]"

>
<!-- ELF object & archives files using ANT paths / filesets -->
<fileset dir="xxx" includes="*.0">
<fileset file="xxx.a">
<fileset file="xxx.a">
<!-- Properties that will be reported into .map file -->
<property name="myProp"” value="myValue"/>

</linker>
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Table 7: Linker Options Details

Option

Description

doNotLoadAlreadyDefinedSymbol

Silently skip the load of a global symbol if it has already
been loaded before. ( false by default. Only the first
loaded symbol is taken into account (in the order input
files are declared). This option only affects the load se-
mantic for global symbols, and does not modify the se-
mantic for loading weak symbols and local symbols.

Explicitly declare linker endianness [little, big] or

endianness [none] for auto-detection. All input files must declare
the same endianness or an error is thrown.
Generate the .map file ( true by default).
generateMapFile

ignoreWrongPositioningForEmptySection

Silently ignore wrong section positioning for zero size
sections. ( false by default).

Provide a master Iscfile. This optionis mandatory unless

lsc the linkPath option is set.
) Provide a set of directories into which to load link file
linkPath fragments. Directories are separated with a platform-
path separator. This option is mandatory unless the 1sc
option is set.
Silently skip the output of warning messages.
noWarning

mergeSegmentSections

(experimental). Generate a single section per segment.
This may speed up the load of the output executable file
into debuggers or flasher tools. ( false by default).

outputArchitecture

Set the architecture tag for the output ELF file (ELF ma-
chineid).

outputName

Specify the output name of the generated files. By de-
fault, take the name provided in the Isc tag. The output
ELF executable filename will be name.out. The map file-
name will be name.map.

stripDebug

Remove all debug information from the output ELF file.
A stripped output ELF executable holds only the binary
image (no remaining symbols, debug sections, etc.).

toDir

Specify the output directory in which to store generated
files. Output filenames are inthe form: od + separator
+ value of the 1lsc name attribute + suffix.
By default, without this option, files are generated in the
directory from which the linker was launched.

verboselLevel

Print additional messages on the standard output about
linking process.

Error Messages

This section lists MicroEJ Linker error messages.

Table 8: Linker-Specific Configuration Tags

Message ID Description
0 The linker has encountered an unexpected internal error. Please contact the support hot-
line.

Continued on next page

3.11. Advanced Tools

153




MicroEJ Documentation, Revision ed46acae

Table 8 - continued from previous page

1 A library cannot be loaded with this linker. Try verbose to check installed loaders.

2 No sc file provided to the linker.

3 Afile could not be loaded. Check the existence of the file and file access rights.

4 Conflictinginput libraries. Aglobal symbol definition with the same name has already been
loaded from a previous object file.

5 Completion (*) could not be used in association with the force attribute. Must be an exact
name.

6 Arequired section refers to an unknown global symbol. Maybe input libraries are missing.

7 A library loader has encountered an unexpected internal error. Check input library file in-
tegrity.

8 Floating symbols can only be declared inside memorylLayout tags.

9 Invalid value format. For example, the attribute relocation in defSymbol must be a
boolean value.

10 Missing one of the following attributes: address, size, align.

1 Too many attributes that cannot be used in association.

13 Negative padding. Memory layout cursor cannot decrease.

15 Not enough space in the memory layout intervals to append all sections that need to be
embedded. Check the output map file to get more information about what is required as
memory space.

16 A block is referenced but has already been embedded. Most likely a block has been espe-
cially embedded using the force attribute and the symbol attribute.

17 A block that must be embedded has no matching sectionRef statement.

19 An 10 error occurred when trying to dump one of the output files. Check the output direc-
tory option and file access rights.

20 size attribute expected.

21 The computed size does not match the declared size.

22 Sections defined in the Isc file must be unique.

23 One of the memory layout intervals refers to an unknown Isc section.

24 Relocation must be done in one and only one contiguous interval.

25 force and symbol attributes are not allowed together.

26 XML char data not allowed at this position in the Isc file.

27 A section which is a part of the program image must be embedded in an image memory
layout.

28 A section which is not a part of the program image must be embedded in a non-image
memory layout.

29 Expression could not be resolved to a link-time constant. Some symbols are unresolved.

30 Sections used in memory layout ranges must be sections defined in the Isc file.

31 Invalid character encountered when scanning the lsc expression.

32 Arecursive include cycle was detected.

33 An alignment inconsistency was detected in a relocation memory layout. Most likely one
of the start addresses of the memory layout is not aligned on the current alignment.

34 An error occurs in a relocation resolution. In general, the relocation has a value that is out
of range.

35 symbol and sort attributes are not allowed together.

36 Invalid sort attribute value is not one of order, name,or no.

37 Attribute start or end in defSection tagis notallowed when defining a floating section.

38 Autogenerated section can build tables according to symbol names (see Auto-generated
Sections). A symbol is needed to build this section but has not been loaded.

39 Deprecated feature warning. Remains for backward compatibility. It is recommended that
you use the new indicated feature, because this feature may be removed in future linker
releases.

Continued on next page
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Table 8 - continued from previous page
40 Unknown output architecture. Either the architecture ID is invalid, or the library loader has
not been loaded by the linker. Check loaded library loaders using verbose option.
41...43 Reserved.

44 Duplicate group definition. A group name is unique and cannot be defined twice.

45 Invalid endianness. The endianness mnemonic is not one of the expected mnemonics (
little,big,none).

46 Multiple endiannesses detected within loaded input libraries.

47 Reserved.

48 Invalid type mnemonic passed to a defSymbol tag. Must be one of none, function, or
data.

49 Warning. A directory of link path is invalid (skipped).

50 No linker-specific description file could be loaded from the link path. Check that the link
path directories are valid, and that they contain .1sc or .1scf files.

51 Exclusive options (these options cannot be used simultaneously). For example,

-linkFilename and -linkPath are exclusive; either select a master Isc file or a path from
which to load .1scf files.

52 Name given to a memorylLayoutRef ora memoryLayout isinvalid. It must not be empty.

53 A memorylLayoutRef with the same name has already been processed.

54 A memorylLayout must define ranges orthe name attribute.

55 No memory layout found matching the name of the current memoryLayoutRef .

56 Anamed memorylLayout is declared with a relocation directive, but the relocation interval
is incompatible with the relocation interval of the memoryLayout that referenced it.

57 A named memorylLayout has not been referenced. Every declared memorylLayout must
be processed. Anamed memorylLayout must be referenced by a memorylLayoutRef state-
ment.

58 SUM operator expects an auto-generated section.

59 SUM operator tag is unknown for the targetted auto-generated section.

60 SUM operator auto-generated section name is unknown.

61 An option is set for an unknown extension. Most likely the extension has not been set to
the linker classpath.

62 Reserved.

63 ELF unit flags are inconsistent with flags set using the -forceFlags option.

64 Reserved.

65 Reserved.

66 Found an executable object file as input (expected a relocatable object file).

67 Reserved.

68 Reserved.

69 Reserved.

70 Not enough memory to achieve the linking process. Try to increase JVM heap that is run-

ning the linker (e.g. by adding option -Xmx1024M to the JRE command line).

Map File Interpretor

The map file interpretor is a tool that allows you to read, classify and display memory information dumped by
the linker map file. The map file interpretor is a graph-oriented tool. It supports graphs of symbols and allows
standard operations on them (union, intersection, subtract, etc.). It can also dump graphs, compute graph total
sizes, list graph paths, etc.

The map file interpretor uses the standard Java regular expression syntax.

Itis used internally by the graphical Memory Map Analyzer tool.

Commands:
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e createGraph graphName symbolRegExp ... section=regexp

createGraph all section=.*

Recursively create a graph of symbols from root symbols and sections described as regular expressions. For
example, to extract the complete graph of the application:

e createGraphNoRec symbolRegExp ... section=regexp

The above line is similar to the previous statement, but embeds only declared symbols and sections (without
recursive connections).

¢ removeGraph graphName

Removes the graph for memory.

¢ listGraphs

Lists all the created graphs in memory.

¢ listSymbols graphName

Lists all graph symbols.

e listPadding

Lists the padding of the application.

* listSections graphName

Lists all sections targeted by all symbols of the graph.

e inter graphResult g1 ... gn
Creates a graph which is the intersection of g1/\ ... /\gn.
e union graphResult g1 ... gn

Creates a graph which is the union of g1\/ ...\/ gn.

e substract graphResult g1 ... gn

Creates a graph which is the substract of g1\ ... \ gn.

* reportConnections graphName

Prints the graph connections.

e totalImageSize graphName

Prints the image size of the graph.

* totalDynamicSize graphName

Prints the dynamic size of the graph.
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¢ accessPath symbolName

The above line prints one of the paths from a root symbol to this symbol. This is very useful in helping you
understand why a symbol is embedded.

¢ echo arguments

Prints raw text.

¢ exec commandFile

Execute the given commandFile. The path may be absolute or relative from the current command file.

3.11.2 Test Suite Engine
3.11.3 MicroEJ Test Suite Engine

Introduction

The MicroEJ Test Suite Engine is a generic tool made for validating any development project using automatic test-
ing.
This section details advanced configuration for users who wish to integrate custom test suites in their build flow.

The MicroEJ Test Suite Engine allows the user to test any kind of projects within the configuration of a generic Ant
file.

TESTSUITE ENGINE

FOR EACH TEST CASE
-

Test Build & Link
Test Deployment Trace Redirection

o

(5

Trace Analysis

Test Execution

The MicroEJ Test Suite Engine is already pre-configured for running test suites on a MicroEJ Platform (either on
Simulator or on Device).
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« For Application and Libraries, refer to Test Suite with JUnit section.

« For Foundation Libraries Test Suites, refer to Platform Test Suite section.

Using the MicroEJ Test Suite Ant Tasks

Multiple Ant tasks are available in the testsuite-engine. jar provided in the Build Kit:

+ testsuite allowsthe usertorun a given test suite and to retrieve an XML report document in a JUnit format.

« javaTestsuite is a subtask of the testsuite task, used to run a specialized test suite for Java (will only
run Java classes).

« htmlReport is atask which will generate an HTML report from a list of JUnit report files.

The testsuite Task

The following attributes are mandatory:

Table 9: testsuite task mandatory attributes

Attribute Name | Description
. The output folder of the test suite. The final report will be generated at [outputDirl/
outputDir [label]/[reportName].xml , see the testsuiteReportFileProperty and
testsuiteReportDirProperty attributes.
The harness script must be an Ant script and it is the script which will be called for each test
harnessScript

by the test suite engine. It is called with a basedir located at output location of the current
test.

The test suite engine provides the following properties to the harness script giving all the informations to start the

test:

Table 10: harnessScript properties

Attribute Name | Description

' The output name of the current test in the report. Default value is the relative path of the
testsuite. test. It can be manually set by the user. More details on the output name are available in the
test.name section Specific Custom Properties.

' The current test absolute path in the filesystem.
testsuite.
test.path

. The absolute path to the custom properties of the current test (see the property
testsuite. customPropertiesExtension)
test.
properties

. The absolute path to the common properties of all the tests (see the property
testsuite. commonProperties )
common.
properties

. The absolute path to the directory of the final report.
testsuite.
report.dir

The following attributes are optional:
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Table 11: testsuite task optional attributes

Attribute | Description Default value
Name

The time in seconds before any test is considerated as un-

known. Setitto 0 to disable the time-out.

The required level to output messages from the test suite.
n be one of those values: error , warning, info,

verbose, debug.

The final report name (without extension). _
reportName testsuite-report

The extension of the custom properties for each test. For in-
custonPropatidesifieis 48 to options , a test named xxx/Test1. | -Properties
class will be associated with xxx/Test1.options. If afile
exists for a test, the property testsuite.test.properties
is set with its absolute path and given to the harnessScript
If the test path references a directory, then the custom
properties path is the concatenation of the test path and the
customPropertiesExtension value.
The properties to apply to every test of the test suite. Those | no common properties
PYptiéas might be overridden by the custom properties of
each test. If this option is set and the file exists, the prop-
erty testsuite.common.properties is set to the absolute
path of the harnessScript file
The build label. timestamp of when the test suite
was invoked.

timeOut 60

verbosele info

commonPro

label

The name of the current tested product.
productName TestSuite

The location of your Java VM to start the test suite (the

jvm harnessScript is called asis: [jvm] [...] -buildfile | Java.home location.ifthe property
[harnessScript]). is set, java otherwise.
The arguments to pass to the Java VM started for each test. | None.

jvmargs

The name of the Ant property in which the path of the
teStSUitERﬁfﬂ?‘aﬂtlﬁéﬂaSP{‘?QeﬁWed. Path is [outputDirl/[label]/ testsuite.report.file
[reportName].xml

The name of the Ant property in which is store the path of the
testsulteRefpedtoty ortheTial report. Pathis [outputDir]/[label]. | testsuite.report.dir
The name of the Ant property in which you want to have the | None
testsulteRGaul S test suite (true or false), depending if every
tests successfully passed the test suite or not. Ignored tests
do not affect this result.

Finally, you have to give as nested element the path containing the tests.

Table 12: testsuite task nested elements

Element Name | Description
Containing all the file of the tests which will be launched by the test suite.

testPath

Any test in the intersection between testIgnoredPath and testPath will be executed by
testignoredPath the test suite, but will not appear in the JUnit final report. It will still generate a JUnit re-
(optional) port for each test, which will allow the HTML report to let them appears as “ignored” if it is
generated. Mostly used for known bugs which are not considered as failure but still relevant
enough to appears on the HTML report.

3.11. Advanced Tools 159



MicroEJ Documentation, Revision ed46acae

Listing 7: Example of test suite task invocation

<!-- Launch the testusite engine -->

<testsuite:testsuite
timeOut="${microej.kf.testsuite.timeout}”
outputDir="${target.test.xml}/testkf”
harnessScript="${com.is2t.easyant.plugins#microej-kf-testsuite.microej-kf-testsuite-harness-jpf-emb.

—xml.file}"”
commonProperties="${microej.kf.launch.propertyfile}"
testsuiteResultProperty="testkf.result"
testsuiteReportDirProperty="testkf.testsuite.report.dir”
productName="${module.name} testkf"”
jvmArgs="${microej.kf.testsuite.jvmArgs}"
lockPort="${microej.kf.testsuite.lockPort}"
verboselLevel="${testkf.verbose.level}"

>
<testPath refid="target.testkf.path"/>

</testsuite:testsuite>

The javaTestsuite Task

This task extends the testsuite task, specializing the test suite to only start real Java class. This task retrieves
the classname of the tests from the classfile and provides new properties to the harness script:

Table 13: javaTestsuite task properties

Property Name | Description

) The classname of the current test. The value of the property testsuite.test.name isalso
testsuite. set to the classname of the current test.
test.class

) The classpath of the current test.
testsuite.
test.
classpath

Listing 8: Example of javaTestsuite task invocation
<!-- Launch test suite -->

<testsuite:javaTestsuite
verboselLevel="${microej.testsuite.verboselLevel}”
timeOut="${microej.testsuite.timeout}"
outputDir="${target.test.xml}/@{prefix}"
harnessScript="${harness.file}"
commonProperties="${microej.launch.propertyfile}"
testsuiteResultProperty="@{prefix}.result”
testsuiteReportDirProperty="@{prefix}.testsuite.report.dir”
productName="${module.name} @{prefix}"
jvmArgs="${microej.testsuite.jvmArgs}”
lockPort="${microej.testsuite.lockPort}"
retryCount="${microej.testsuite.retry.count}”
retryIf="${microej.testsuite.retry.if}"
retryUnless="${microej.testsuite.retry.unless}"”

<testPath refid="target.@{prefix}.path"/>

(continues on next page)
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(continued from previous page)

<testIgnoredPath refid="tests.@{prefix}.ignored.path” />
</testsuite:javaTestsuite>

The htmlReport Task

This task allow the user to transform a given path containing a sample of JUnit reports to an HTML detailed report.
Here is the attributes to fill:

« Anested fileset element containing all the JUnit reports of each test. Take care to exclude the final JUnit
report generated by the test suite.

« Anested element report:

- format : The format of the generated HTML report. Must be noframes or frames. When noframes
format is choosen, a standalone HTML file is generated.

- todir: The output folder of your HTML report.

- The report tagaccepts the nested tag param with name and expression attributes. These tags can
pass XSL parameters to the stylesheet. The built-in stylesheets support the following parameters:

* PRODUCT : the product name that is displayed in the title of the HTML report.
* TITLE :the comment thatis displayed in the title of the HTML report.

Note: It is advised to set the format to noframes if your test suite is not a Java test suite. If the format is set to
frames, with anon-Java MicroEJ Test Suite, the name of the links will not be relevant because of the non-existency
of packages.

Listing 9: Example of htmlReport task invocation

<!-- Generate HTML report -->
<testsuite:htmlReport>
<fileset dir="${@{prefix}.testsuite.report.dir}">
<include name="x*/x.xml"/> <!-- include unary reports -->
<exclude name="*x/bin/*x*/%*.xml"/> <!-- exclude test bin files -->
<exclude name="x.xml"/> <!-- exclude global report -->
</fileset>
<report format="noframes” todir="${target.test.html}/@{prefix}"/>
</testsuite:htmlReport>

Using the Trace Analyzer

This section will shortly explains how to use the Trace Analyzer . The MicroEJ Test Suite comes with an archive
containing the Trace Analyzer which can be used to analyze the output trace of an application. It can be used
from different forms;

« The FileTraceAnalyzer will analyze a file and research for the given tags, failing if the success tag is not
found.

« The SerialTraceAnalyzer will analyze the data from a serial connection.
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The TraceAnalyzer Tasks Options

Here is the common options to all TraceAnalyzer tasks:
+ successTag: the regular expression which is synonym of success when found (by default . *PASSED. x ).
« failureTag: the regular expression which is synonym of failure when found (by default . *FAILED.*).
« verboselLevel :int value between 0 and 9 to define the verbose level.
« waitingTimeAfterSuccess : waiting time (in s) after success before closing the stream (by default 5).

« noActivityTimeout : timeout (in s) with no activity on the stream before closing the stream. Set it to 0 to
disable timeout (default value is 0).

« stopEOFReached: boolean value. Setto true to stop analyzing when input stream EOF is reached. If false
, continue until timeout is reached (by default false).

« onlyPrintableCharacters:booleanvalue. Setto true toonly dump ASCII printable characters (by default
false).

The FileTraceAnalyzer Task Options

Here is the specific options of the FileTraceAnalyzer task:

« traceFile: path to the file to analyze.

The SerialTraceAnalyzer Task Options

Here is the specific options of the SerialTraceAnalyzer task:
+ port:the comm port to open.
« baudrate : serial baudrate (by default 9600).
« databits: databits (5]6|7|8) (by default 8).
+ stopBits: stopbits (0[1|3 for (1_5)) (by default 1).

« parity: none | odd | event (bydefault none).

Appendix

The goal of this section is to explain some tips and tricks that might be useful in your usage of the test suite engine.

Specific Custom Properties

Some custom properties are specifics and retrieved from the test suite engine in the custom properties file of a test.

« The testsuite.test.name property is the output name of the current test. Here are the steps to compute
the output name of a test:

- If the custom properties are enabled and a property named testsuite.test.name isfind on the cor-
responding file, then the output name of the current test will be set to it.

- Otherwise, if the running MicroEJ Test Suite is a Java test suite, the output name is set to the class name
of the test.
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- Otherwise, from the path containing all the tests, a common prefix will be retrieved. The output name
will be set to the relative path of the current test from this common prefix. If the common prefix equals
the name of the test, then the output name will be set to the name of the test.

- Finally, if multiples tests have the same output name, then the current name will be followed by _XXX
, an underscore and an integer.

« The testsuite.test.timeout property allow the userto redefine the time out for each test. If it is negative
or not an integer, then global timeout defined for the MicroEJ Test Suite is used.

3.12 Graphical User Interface

This section presents libraries relative to the user interface.

The following schema shows the overall architecture and modules:

Widget Examples Applications APP

ADD-ON LIBRARIES

LIBRARIES
VIRTUALIZATION

Graphical Engine

ABSTRACTION LAYERS

BSP Drivers Drivers Drivers

RTOS/OS

PLATFORM

D PROCESSOR
CORE LCD

HARDWARE

Fig. 63: Graphical User Interface Overview
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Note: This chapter describes the current Graphical User Interface version 3, provided by Ul Pack version 13.0.0
or higher. If you are using the former Graphical User Interface version 2 (provided by MicroEJ Ul Pack version up
to 12.4.x), please refer to this MicroEJ Documentation Archive.

3.12.1 MicroUl

Introduction

MicroUl Foundation Library provides access to a pixel-based display and inputs.
The aim of this library is to enable the creation of user interface in Java by reifying hardware capabilities.

To use the MicroUl Foundation Library, add MicroUl APl module to a module description file:

<dependency org="ej.api” name="microui” rev="3.0.3"/>

Drawing Foundation Library extends MicroUI drawing APIs' with more complex ones such as:
« thick line, arc, circle and ellipse
+ polygon
+ image deformation and rotation

To use the Drawing Foundation Library, add Drawing AP| module to a module description file:

<dependency org="ej.api"” name="drawing" rev="1.0.2"/>

Images

Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.Image.getimage() or
ej.microui.display.Resourcelmage.loadlmage() . To be displayed, these images have to be converted from their
source format to the display raw format. The conversion can either be done at:

« build-time (using the image generator tool),
« run-time (using the relevant decoder library).

Images that must be processed by the image generator tool are declared in MicroEJ Classpath *.images. list files.
Thefile formatis a standard Java properties file, each line representing a / separated resource path relative to the
MicroEJ classpath root referring to a standard image file (e.g. .png, .Jjpg). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImagel.png

# The following image is embedded
(continues on next page)

! These APIs were formerly included in MicroUl 2.x
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(continued from previous page)

# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage?2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

Configuration File

Here is the format of the *.images.list files.

ConfigFile ::= Line [ 'EOL' Line Jx

Line ::= ImagePath [ ':' ImageOption Jx
ImagePath ::= Identifier [ '/' Identifier Jx
ImageOption =N EA

Identifier ::= Letter [ LetterOrDigit J*
Letter := 'a-zA-Z_$'

LetterOrDigit ::= 'a-zA-Z_%$0-9'

Images Heap

The images heap is used to allocate the pixel data of:
+ mutable images (i.e. Bufferedimage instances)
« images which are not byte-addressable, such as images opened with an input stream
+ images which are byte-addressable but converted to a different output format
In other words, every image which can not be retrieved using Image.getimage() is saved on the images heap.

The size of the images heap can be configured with the ej.microui.memory.imagesheap.size property.

Output Formats
Without Compression

When no output format is set in the images list file, the image is embedded without any conversion / compression.
This allows you to embed the resource as well, in order to keep the source image characteristics (compression, bpp,
etc.). This option produces the same result as specifiying an image as a resource in the MicroEJ launcher.

Advantages:

+ Preserves the image characteristics;

« Preserves the original image compression.
Disadvantages:

+ Requires an image runtime decoder;

+ Requires some RAM in which to store the decoded image;

+ Requires execution time to decode the image.
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imagel

Standard Output Formats

Depending on the target hardware, several generic output formats are available. Some formats may be directly
managed by the BSP display driver. Refer to the platform specification to retrieve the list of natively supported
formats.

Advantages:
+ The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side;
« Drawing an image is very fast when the display driver recognizes the format (with or without transparency);
« Supports or not the alpha encoding: select the most suitable format for the image to encode.
Disadvantages:

+ No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
bits-per-pixel;

+ Slower than display format when the display driver does not recognize the format: a pixel conversion is
required at runtime.

Select one the following format to use a generic format among this list: ARGB8888, RGB888, ARGB4444 , ARGB1555
, RGB565, A8, A4, A2, A1, C4, C2, C1, AC44, AC22 and AC11. The following snippets describe the color
conversion for each format:

« ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

int convertARGB8888toRAWFormat(int c){
return c;

3

RGB888: 24 hits format, 8 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return c & Oxffffff;

3

« ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

int convertARGB8888toRAWFormat(int c){
return 0

| ((c & 0xf000E00) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x0000000) >> 4)

3

« ARGBI1555: 16 bits format, 1 bit for transparency, 5 per color.

int convertARGB8888toRAWFormat(int c){
return @
| (((c & 0xff00000R0) == Oxff0O000RR) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)

(continues on next page)
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(continued from previous page)
| ((c & 0x0000f8) >> 3)

’

RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return @
| ((c & 0xf80000) >> 8)
| ((c & 0x00fco0) >> 5)
| ((c & 0x0000f8) >> 3)

’

« A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return oxff - (toGrayscale(c) & 0xff);

}

« A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0xff)) / ox11;
3

« A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0xff)) / 0x55;
3

« Al 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / oxff;
3

« C4: 4 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0Oxff) / 0x11;

3

« C2: 2 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0Oxff) / 0x55;
}

« C1:1bit format with grayscale conversion. Image is always fully opaque.
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int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0Oxff) / 0Oxff;

3

+ AC44: 4 bits for transparency, 4 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return 0
| ((color >> 24) & 0xf0)
| ((toGrayscale(color) & oxff) / ox11)

’

« AC22: 2 bits for transparency, 2 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return @
| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & oxff) / 0x55)

’

3

« AC11: 1 bit for transparency, 1 bit with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return @
| ((c & 0xff000000) == 0xff000000 ? 0x2 : 0x0)
| ((toGrayscale(color) & oxff) / oxff)

’

Examples:

image1:ARGB8888
image2:RGB565
image3:A4

Display Output Format

This format encodes the image into the exact display memory representation. If the image to encode contains
some transparent pixels, the output file will embed the transparency according to the display’s implementation
capacity. When all pixels are fully opaque, no extra information will be stored in the output file in order to free up
some memory space.

Note: When the display memory representation is standard, the display output format is automatically replaced
by a standard format.

Advantages:
« Drawing an image is very fast because no pixel conversion is required at runtime;
« Supports alpha encoding when display pixel format allow it.

Disadvantages:

+ No compression: the image size in bytes is proportional to the number of pixels.
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imagel:display

RLE1 Output Format

Theimage engine can display embedded images that are encoded into a compressed format which encodes several
consecutive pixels into one or more 16-bit words. This encoding manages a maximum alpha level of 2 (alpha level
is always assumed to be 2, even if the image is not transparent).

« Several consecutive pixels have the same color (2 words):

- First 16-bit word specifies how many consecutive pixels have the same color (pixels colors converted in
RGB565 format, without opacity data).

- Second 16-bit word is the pixels’ color in RGB565 format.
« Several consecutive pixels have their own color (1 + n words):
- First 16-bit word specifies how many consecutive pixels have their own color;
- Next 16-bit word is the next pixel color.
» Several consecutive pixels are transparent (1 word):
- 16-bit word specifies how many consecutive pixels are transparent.
Advantages:
« Supports fully opaque and fully transparent encoding.
« Good compression when several consecutive pixels respect one of the three previous rules.
Disadvantages:
« Drawing an image is slightly slower than when using Display format.

« Not designed for images with many different pixel colors: in such case, the output file size may be larger than
the original image file.

imagel:RLE1

Image Generator Error Messages

These errors can occur while preprocessing images.
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Table 14: Static Image Generator Error Messages

ID | Type Description

0 | Error The image generator has encountered an unexpected internal error.

1 Error The images list file has not been specified.

2 | Error The image generator cannot create the final, raw file.

3 | Error The image generator cannot read the images list file. Make sure the system allows reading of
this file.

4 | Warning The image generator has found no image to generate.

5 | Error The image generator cannot load the images list file.

6 | Warning The specified image path is invalid: The image will be not converted.

7 | Warning There are too many or too few options for the desired format.

8 | Error The display format is not generic; a MicroUIRawImageGeneratorExtension implementation is
required to generate the MicroUl raw image.

9 | Error The image cannot be read.

10 | Error The image generator has encountered an unexpected internal error (invalid endianness).

11 | Error The image generator has encountered an unexpected internal error (invalid bpp).

12 | Error The image generator has encountered an unexpected internal error (invalid display format).

13 | Error The image generator has encountered an unexpected internal error (invalid pixel layout).

14 | Error The image generator has encountered an unexpected internal error (invalid output folder).

15 | Error The image generator has encountered an unexpected internal error (invalid memory
alignment).

16 | Error The input image format and / or the ouput format are not managed by the image generator.

17 | Error The image has been already loaded with another output format.

Fonts
Overview

Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont(). To be displayed,
these fonts have to be converted at build-time from their source format to the display raw format by the font gener-
ator tool. Fonts that must be processed by the font generator tool are declared in MicroEJ Classpath *. fonts.list
files. The file format is a standard Java properties file, each line representing a / separated resource path relative
to the MicroEJ classpath root referring to a MicroEJ font file (usually witha .ejf file extension). The resource may
be followed by optional parameters which define :

« some ranges of characters to embed in the final raw file;
« the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depthis 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:1latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2
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MicroEJ font files conventionally end with the .ejf suffix and are created using the Font Designer (see Font De-
signer).

Configuration File

Here is the format of the *.fonts.list files.

ConfigFile ::= Line [ 'EOL' Line J*

Line ::= FontPath [ ':' [ Ranges 1 [ ':' BitsPerPixel ] ]
FontPath ::= Identifier [ '/' Identifier Jx
Ranges ::= Range [ ';' Range J*

Range ::= CustomRangelList | KnownRange
CustomRangelist ::= CustomRange [ ',' CustomRange J*
CustomRange ::= Number | Number '-' Number
KnownRange ::= Name [ SubRangelList 1?
SubRangeList ::= "(' SubRange [ ',' SubRange 1* ')'
SubRange ::= Number | Number - Number
Identifier c:= 'a-zA-Z_$' [ 'a-zA-Z_$0-9' Ix
Number ::= Number16 | Number1@

Number16 ::= 'Ox' [ Digitli6e I+

Number10 ::= [ Digitle J+

Digit16 ::= 'a-fA-F0-9'

Digitl1o = '0-9'

BitsPerPixel = "1 2t ] 4t '8!

Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. If unspecified, all characters of the font are embedded.

Several ranges can be specified, separated by ; . There are two ways to specify a character range: the custom range
and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.
Examples:
« myfont:0x21-0x49 : Defines one range: embed all characters from 0x21 to 0x49 (included);

« myfont:0x21-0x49,0x55-0x75 : Defines a set of two ranges: embed all characters from 0x21 to 0x49 and
from 0x55 to 0x75.

« myfont:0x21-0x49,0x55 : Defines a set of one range and one character: embed all characters from 0x21 to
0x49 and character 0x55.

Known Range

A known range is a range available in the following table.
Examples:

« myfont:basic_latin:Embed all Basic Latin characters;
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« myfont:basic_latin;arabic: Embed all Basic Latin characters, and all Arabic characters.

The following table describes the available list of ranges and sub-ranges (processed from the “Unicode Character
Database” version 9.0.0 available on the official unicode website https://www.unicode.org).

Table 15: Ranges

Name Tag Start End
Basic Latin basic_latin 0x0 ox7f
Latin-1 Supplement latin-1_supplement 0x80 Oxff
Latin Extended-A latin_extended-a 0x100 ox17f
Latin Extended-B latin_extended-b 0x180 | Ox24f
IPA Extensions ipa_extensions 0x250 | Ox2af
Spacing Modifier Letters spacing_modifier_letters 0x2b0 | Ox2ff
Combining Diacritical Marks combining_diacritical_marks 0x300 | Ox36f
Greek and Coptic greek_and_coptic 0x370 0x3ff
Cyrillic cyrillic 0x400 | Ox4ff
Cyrillic Supplement cyrillic_supplement 0x500 | Ox52f
Armenian armenian 0x530 | Ox58f
Hebrew hebrew 0x590 | Ox5ff
Arabic arabic 0x600 | Ox6ff
Syriac syriac 0x700 | OxT74f
Arabic Supplement arabic_supplement 0x750 | Ox77f
Thaana thaana 0x780 | Ox7bf
NKo nko 0x7c0 | Ox7ff
Samaritan samaritan 0x800 | 0x83f
Mandaic mandaic 0x840 | 0x85f
Arabic Extended-A arabic_extended-a 0x8a0 | Ox8ff
Devanagari devanagari 0x900 | 0x97f
Bengali bengali 0x980 | Oxoff
Gurmukhi gurmukhi 0xa00 | OxaT7f
Gujarati gujarati 0xa80 | Oxaff
Oriya oriya 0xb00 | Oxb7f
Tamil tamil 0xb80 | Oxbff
Telugu telugu 0xc00 | Oxc7f
Kannada kannada 0xc80 | Oxcff
Malayalam malayalam 0xd00 | Ooxd7f
Sinhala sinhala 0xd80 | Oxdff
Thai thai 0xe00 | OxeT7f
Lao lao 0xe80 | Oxeff
Tibetan tibetan 0xf00 Oxfff
Myanmar myanmar 0x1000 | 0x109f
Georgian georgian 0x10a0 | Ox10ff
Hangul Jamo hangul_jamo 0x1100 | Ooxnff
Ethiopic ethiopic 0x1200 | 0x137f
Ethiopic Supplement ethiopic_supplement 0x1380 | 0x139f
Cherokee cherokee 0x13a0 | Ox13ff
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics 0x1400 | Ox167f
Ogham ogham 0x1680 | 0x169f
Runic runic 0x16a0 | Ox16ff
Tagalog tagalog 0x1700 | ox171f
Hanunoo hanunoo 0x1720 | 0x173f

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End
Buhid buhid 0x1740 | 0x175f
Tagbanwa tagbanwa 0x1760 | 0x177f
Khmer khmer 0x1780 | ox17ff
Mongolian mongolian 0x1800 | Ox18af
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics_extended| 0x18b0 | 0x18ff
Extended

Limbu limbu 0x1900 | 0x194f
Tai Le tai_le 0x1950 | Ox197f
New Tai Lue new_tai_lue 0x1980 | Ox19df
Khmer Symbols khmer_symbols 0x19e0 | Ox19ff
Buginese buginese 0x1a00 | Oxlalf
Tai Tham tai_tham 0x1a20 | Oxlaaf
Combining Diacritical Marks Extended | combining_diacritical_marks_extended Ox1ab0 | Oxlaff
Balinese balinese 0x1b00 | Ox1b7f
Sundanese sundanese 0x1b80 | Ox1bbf
Batak batak 0x1bcO | Ox1bff
Lepcha lepcha 0x1c00 | Ox1c4f
Ol Chiki ol_chiki 0x1c50 | Ox1c7f
Cyrillic Extended-C cyrillic_extended-c 0x1c80 | Ox1c8f
Sundanese Supplement sundanese_supplement 0x1ccO | Oxlccf
Vedic Extensions vedic_extensions 0x1cdO | Oxlcff
Phonetic Extensions phonetic_extensions 0x1d00 | Ox1d7f
Phonetic Extensions Supplement phonetic_extensions_supplement 0x1d80 | Ox1dbf
Combining Diacritical Marks Supple- | combining_diacritical_marks_supplement 0x1dc0 | oxidff
ment

Latin Extended Additional latin_extended_additional 0x1e00 | Oxleff
Greek Extended greek_extended 0x1fo0 | Oxifff
General Punctuation general_punctuation 0x2000 | 0x206f
Superscripts and Subscripts superscripts_and_subscripts 0x2070 | 0x209f
Currency Symbols currency_symbols 0x20a0 | 0x20cf
Combining Diacritical Marks for Sym- | combining_diacritical_marks_for_symbols 0x20d0 | Ox20ff
bols

Letterlike Symbols letterlike_symbols 0x2100 | 0x214f
Number Forms number_forms 0x2150 | 0x218f
Arrows arrows 0x2190 | Ox21ff
Mathematical Operators mathematical_operators 0x2200 | 0x22ff
Miscellaneous Technical miscellaneous_technical 0x2300 | Ox23ff
Control Pictures control_pictures 0x2400 | 0x243f
Optical Character Recognition optical_character_recognition 0x2440 | 0x245f
Enclosed Alphanumerics enclosed_alphanumerics 0x2460 | 0x24ff
Box Drawing box_drawing 0x2500 | 0x257f
Block Elements block_elements 0x2580 | 0x259f
Geometric Shapes geometric_shapes 0x25a0 | 0x25ff
Miscellaneous Symbols miscellaneous_symbols 0x2600 | Ox26ff
Dingbats dingbats 0x2700 | 0x27bf
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-a 0x27c0 | Ox27ef
Symbols-A

Supplemental Arrows-A supplemental_arrows-a 0x27f0 | Ox27ff
Braille Patterns braille_patterns 0x2800 | Ox28ff

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End
Supplemental Arrows-B supplemental_arrows-b 0x2900 | 0x297f
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-b 0x2980 | 0Ox29ff
Symbols-B

Supplemental Mathematical Opera- | supplemental_mathematical_operators 0x2a00 | Ox2aff
tors

Miscellaneous Symbols and Arrows miscellaneous_symbols_and_arrows 0x2b00 | Ox2bff
Glagolitic glagolitic 0x2c00 | 0x2c5f
Latin Extended-C latin_extended-c 0x2c60 | Ox2cTf
Coptic coptic 0x2c80 | Ox2cff
Georgian Supplement georgian_supplement 0x2d00 | 0x2d2f
Tifinagh tifinagh 0x2d30 | ox2d7f
Ethiopic Extended ethiopic_extended 0x2d80 | 0x2ddf
Cyrillic Extended-A cyrillic_extended-a 0x2de0 | Ox2dff
Supplemental Punctuation supplemental_punctuation 0x2e00 | Ox2e7f
CJK Radicals Supplement cjk_radicals_supplement 0x2e80 | Ox2eff
Kangxi Radicals kangxi_radicals 0x2f00 | Oox2fdf
Ideographic Description Characters ideographic_description_characters 0x2ff0 | Ox2fff
CJK Symbols and Punctuation cjk_symbols_and_punctuation 0x3000 | 0x303f
Hiragana hiragana 0x3040 | 0x309f
Katakana katakana 0x30a0 | 0x30ff
Bopomofo bopomofo 0x3100 | 0x312f
Hangul Compatibility Jamo hangul_compatibility_jamo 0x3130 | 0x318f
Kanbun kanbun 0x3190 | 0x319f
Bopomofo Extended bopomofo_extended 0x31a0 | 0x31bf
CJK Strokes cjk_strokes 0x31c0 | Ox31ef
Katakana Phonetic Extensions katakana_phonetic_extensions 0x31f0 | Ox31ff
Enclosed CJK Letters and Months enclosed_cjk_letters_and_months 0x3200 | Ox32ff
CJK Compeatibility cjk_compatibility 0x3300 | 0x33ff
CJK Unified Ideographs Extension A cjk_unified_ideographs_extension_a 0x3400 | Ox4dbf
Yijing Hexagram Symbols yijing_hexagram_symbols 0x4dcO | Ox4dff
CJK Unified Ideographs cjk_unified_ideographs 0x4e00 | 0xofff
Yi Syllables yi_syllables 0xa000 | Oxa48f
Yi Radicals yi_radicals 0xa490 | Oxa4cf
Lisu lisu 0xa4d0 | Oxa4ff
Vai vai 0xa500 | Oxa63f
Cyrillic Extended-B cyrillic_extended-b 0xa640 | 0xa69f
Bamum bamum 0xa6a0 | Oxa6ff
Modifier Tone Letters modifier_tone_letters 0xa700 | OxaT71f
Latin Extended-D latin_extended-d 0xa720 | Oxa7ff
Syloti Nagri syloti_nagri 0xa800 | Oxa82f
Common Indic Number Forms common_indic_number_forms 0xa830 | Oxa83f
Phags-pa phags-pa 0xa840 | 0xa87f
Saurashtra saurashtra 0xa880 | Oxa8df
Devanagari Extended devanagari_extended 0xa8e0 | Oxa8ff
Kayah Li kayah_li 0xa900 | Oxa92f
Rejang rejang 0xa930 | 0xa95f
Hangul Jamo Extended-A hangul_jamo_extended-a 0xa960 | 0xa97f
Javanese javanese 0xa980 | 0xa9df
Myanmar Extended-B myanmar_extended-b 0xa9e0 | Oxaoff

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End
Cham cham 0xaa00 | Oxaasf
Myanmar Extended-A myanmar_extended-a Oxaa60 | OxaaT7f
Tai Viet tai_viet Oxaa80 | Oxaadf
Meetei Mayek Extensions meetei_mayek_extensions Oxaae0 | Oxaaff
Ethiopic Extended-A ethiopic_extended-a 0xab00 | Oxab2f
Latin Extended-E latin_extended-e Oxab30 | Oxabéf
Cherokee Supplement cherokee_supplement 0xab70 | Oxabbf
Meetei Mayek meetei_mayek OxabcO | Oxabff
Hangul Syllables hangul_syllables 0Oxac00 | Oxd7af
Hangul Jamo Extended-B hangul_jamo_extended-b 0xd7b0 | Oxd7ff
High Surrogates high_surrogates 0xd800 | 0xdb7f
High Private Use Surrogates high_private_use_surrogates 0xdb80 | Oxdbff
Low Surrogates low_surrogates 0xdc00 | oxdfff
Private Use Area private_use_area 0xe000 | Oxf8ff
CJK Compatibility Ideographs cjk_compatibility_ideographs 0xf900 | Oxfaff
Alphabetic Presentation Forms alphabetic_presentation_forms 0xfb00 | Oxfb4f
Arabic Presentation Forms-A arabic_presentation_forms-a 0xfb50 | Oxfdff
Variation Selectors variation_selectors 0xfe00 | OxfeOf
Vertical Forms vertical_forms 0xfe10 | Oxfelf
Combining Half Marks combining_half_marks 0xfe20 | Oxfe2f
CJK Compatibility Forms cjk_compatibility_forms 0xfe30 | Oxfe4f
Small Form Variants small_form_variants 0xfe50 | Oxfe6f
Arabic Presentation Forms-B arabic_presentation_forms-b 0xfe70 | Oxfeff
Halfwidth and Fullwidth Forms halfwidth_and_fullwidth_forms 0xffoo | Oxffef
Specials specials Oxfffo | Oxffff

Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8). If unspecified, the encoded

transparency levelis 1 (does not depend on transparency level encoded in EJF file).

Examples:

« myfont:latin:4:Embed all latin characters with 16 levels of transparency

« myfont::2:Embed all characters with 4 levels of transparency
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Font Generator Error Messages

Table 16: Static Font Generator Error Messages

ID | Type Description

0 Error The font generator has encountered an unexpected internal error.

1 Error The Fonts list file has not been specified.

2 Error The font generator cannot create the final, raw file.

3 Error The font generator cannot read the fonts list file.

4 | Warning The font generator has found no font to generate.

5 Error The font generator cannot load the fonts list file.

6 Warning The specified font path is invalid: The font will be not converted.

7 Warning There are too many arguments on a line: the current entry is ignored.

8 Error The font generator has encountered an unexpected internal error (invalid output format).
9 | Error The font generator has encountered an unexpected internal error (invalid endianness).
10 | Error The specified entry is invalid.

11 | Error The specified entry does not contain a list of characters.

12 | Error The specified entry does not contain a list of identifiers.

13 | Error The specified entry is an invalid width.

14 | Error The specified entry is an invalid height.

15 | Error The specified entry does not contain the characters’ addresses.

16 | Error The specified entry does not contain the characters’ bitmaps.

17 | Error The specified entry bits-per-pixel value is invalid.

18 | Error The specified range is invalid.

19 | Error There are too many identifiers. The output RAW format cannot store all identifiers.

20 | Error The font’s name is too long. The output RAW format cannot store all name characters.
21 | Error There are too many ranges. The output RAW format cannot store all ranges.

22 | Error Output list files cannot be created.

23 | Error Dynamic styles are not supported. Only a PLAIN font can be encoded.

24 | Error Underlined style is not supported. Only a BOLD and ITALIC font can be set.

Font Designer

Principle

The Font Designer module is a graphical tool (Eclipse plugin) that runs within the MicroEJ IDE used to build and
edit MicroUl fonts. It stores fonts in a platform-independent format.
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Functional Description
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Fig. 64: Font Generation

Font Management
Create a MicroEJ Font

To create a MicroEJ font, follow the steps below:
1. Open the Eclipse wizard: File > New > Other... > MicroEJ > MicroEJ Font .
2. Select a directory and a name.
3. Click Finish.

Once the font is created, a new editor is opened: the MicroEJ Font Designer.

Edit a MicroEJ Font

You can edit your font with the MicroEJ Font Designer (by double-clickingona =.ejf file or after running the new
MicroEJ Font wizard).

This editor is divided into three main parts:
+ The top left part manages the main font properties.
« The top right part manages the character to embed in your font.

« The bottom part allows you to edit a set of characters or an individual character.

Main Properties

The main font properties are:
« fontsize: height and width (in pixels).

« baseline (in pixels).
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« space character size (in pixels).
« styles and filters.
« identifiers.

Refer to the following sections for more information about these properties.

Font Height

A font has a fixed height. This height includes the white pixels at the top and at the bottom of each character
simulating line spacing in paragraphs.

HEE

[ | [ |
Al neight
L] [ ]

Fig. 65: Font Height

Font Width: Proportional and Monospace Fonts

A monospace font is a font in which all characters have the same width. For example a ‘!’ representation will be
the same width as a ‘w’ (they will be in the same size rectangle of pixels). In a proportional font, a ‘w’ will be wider
thana ‘!’

A monospace font usually offers a smaller memory footprint than a proportional font because the Font Designer
does not need to store the size of each character. As a result, this option can be useful if the difference between the
size of the smallest character and the biggest one is small.

Baseline

Characters have a baseline: an imaginary line on top of which the characters seem to stand. Note that characters
can be partly under the line, for example, ‘g’ or }.

[T 1] L[] (][] (1] 1 1]
| | - - L] - - ] - ] | ] L1} L -
.. _EEE L] m _IN LIl N L N (WEE . .

L L1 [LL LI | L] L L] . .. . L]
| . _ . ] [ ] L] L1l . = N EEEE (111} .
L L] L] L u L Ll u L] 1 | L] L]

Fig. 66: The Baseline

Space Character

The Space character (0x20) is a specific character because it has no filled pixels. From the Main Properties Menu
you can fix the space character size in pixels.

Note: When the font is monospace, the space size is equal to the font width.
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Styles

Font Designer allows to create a font file which holds several combinations of built-in styles (styles hardcoded in
pixels map) and runtime styles (styles rendered dynamically at runtime). However, since MicroUl 3, a MicroUI font
holds only one style: PLAIN, BOLD, ITALIC or BOLD + ITALIC.Byconsequence,the styles option must be left to
the default option.

Font Designer features three drop-downs, one for each of BOLD, ITALIC and UNDERLINED . Each drop-down has
three options: None, Built-in and Dynamic. Use only None option. Otherwise an error at MicroEJ application
compiletime will occur (incompatible font file).

Identifiers

A number of identifiers can be attached to a MicroUl font. At least one identifier is required to specify the font.
Identifiers are a mechanism for specifying the contents of the font - the set or sets of characters it contains. The
identifier may be a standard identifier (for example, LATIN) or a user-defined identifier. Identifiers are numbers,
but standard identifiers, which are in the range 0 to 80, are typically associated with a handy name. A user-defined
identifier is an identifier with a value of 81 or higher.

Character List

The list of characters can be populated through the import button, which allows you to import characters from
system fonts, images or another MicroEJ font.

Import from System Font

This page allows you to select the system font to use (left part) and the range of characters. There are predefined
ranges of characters below the font selection, as well as a custom selection picker (for example 0x21 to Oxfe for
Latin characters).

The right part displays the selected characters with the selected font. If the background color of a displayed char-
acter is red, it means that the character is too large for the defined height, or in the case of a monospace font, it
means the character is too high or too wide. You can then adjust the font properties (font size and style) to ensure
that characters will not be truncated.

When your selection is done, click the Finish button to import this selection into your font.

Import from Images

This page allows the loading of images from a directory. The images must be named as follows: 0x[UTF-87.
[extension].

When your selection is done, click the Finish button to import the images into your font.

Character Editor

When a single character is selected in the list, the character editor is opened.
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Fig. 67: Character Editor

You can define specific properties, such as left and right space, or index. You can also draw the character pixel by
pixel - a left-click in the grid draws the pixel, a right-click erases it.

The changes are not saved until you click the Apply button. When changes are applied to a character, the editor
shows that the font has changed, so you can now save it.

The same part of the editor is also used to edit a set of characters selected in the top right list. You can then edit
the common editable properties (left and right space) for all those characters at the same time.

Working With Anti-Aliased Fonts

By default, when characters are imported from a system font, each pixel is either fully opaque or fully transparent.
Fully opaque pixels show as black squares in the character grid in the right-hand part of the character editor; fully
transparent pixels show as white squares.

However, the pixels stored inan ejf file can take one of 256 grayscale values. A fully-transparent pixel has the value
255 (the RGB value for white), and a fully-opaque pixel has the value 0 (the RGB value for black). These grayscale
values are shown in parentheses at the end of the text in the Current alpha field when the mouse cursor hovers over
a pixel in the grid. That field also shows the transparency level of the pixel, as a percentage, where 100% means
fully opaque.

Itis possible to achieve better-looking characters by using a combination of fully-opaque and partially-transparent
pixels. Thistechniqueis called anti-aliasing. Anti-aliased characters can be imported from system fonts by checking
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the anti aliasing box in the import dialog. The ‘&’ character shown in the screenshot above was imported using anti
aliasing, and you can see the various gray levels of the pixels.

When the Font Generator converts an ejf file into the raw format used at runtime, it can create fonts with char-
acters that have 1, 2, 4 or 8 bits-per-pixel (bpp). If the raw font has 8 bpp, then no conversion is necessary and the
characters will render with the same quality as seen in the character editor. However, if the raw font has less than
8 bpp (the default is 1 bpp) any gray pixels in the input file are compressed to fit, and the final rendering will be of
lower quality (but less memory will be required to hold the font).

Itis useful to be able to see the effects of this compression, so the character editor provides radio buttons that allow
the user to preview the characterat 1, 2, 4, or 8 bpp. Furthermore, when 2, 4 or 8 bpp is selected, a slider allows the
user to select the transparency level of the pixels drawn when the left mouse button is clicked in the grid.

Previewing a Font

You can preview your font by pressing the Preview... button, which opens the Preview wizard. In the Preview
wizard, press the Select File button, and select a text file which contains text that you want to see rendered using
your font. Characters that are in the selected text file but not available in the font will be shown as red rectangles.
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Fig. 68: Font Preview

3.12. Graphical User Interface 182



MicroEJ Documentation, Revision ed46acae

Removing Unused Characters

In order to reduce the size of a font file, you can reduce the number of characters in your font to be only those char-
acters used by your application. To do this, create a file which contains all the characters used by your application
(for example, concatenating all your NLS files is a good starting point). Then open the Preview wizard as described
above, selecting that file. If you select the check box Delete unused on finish, then those characters that are in the
font but not in the text file will be deleted from the font when you press the Finish button, leaving your font contain-
ing the minimum number of characters. As this font will contain only characters used by a specific application, it is
best to prepare a “complete” font, and then apply this technique to a copy of that font to produce an application
specific cut-down version of the font.

Use a MicroEJ Font

A MicroEJ Font must be converted to a format which is specific to the targeted platform. The Font Generator tool
performs this operation for all fonts specified in the list of fonts configured in the application launch.

Dependencies

No dependency.

Installation

The Font Designer module is already installed in the MicroEJ environment.

Use

Create anew ejf fontfile or open an existing one in order to open the Font Designer plugin.

Application Options

MicroUl libraries and its tools provide a set of options. See Application Options to have more information about the
application options.
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Category: Libraries

w Libraries
w Micrell
Font
Image

Category: MicroUl

w Libraries Memary
v Microll
Font Pump events (inputs and display) queue size (in number of events): | 100 ‘
Image

Pump events thread priority: |3

Images heap size (in bytes): | 131072

Group: Memory
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Option(text): Pump events (inputs and display) queue size (in number of events)

Option Name: ej.microui.memory.queue.size
Default value: 100
Description:

Specifies the size of the pump events queue.

Option(combo): Pump events thread priority

Option Name: com.microej.library.microui.pump.priority
Default value: 5

Available values: 1 to 10

Description:

Specifies the priority of the pump events queue.

Option(text): Images heap size (in bytes)

Option Name: ej.microui.memory.imagesheap.size
Default value: 131072
Description:

Specifies the size of the images heap. This heap is used to store the dynamic user images, the decoded images
and the working buffers of embedded image decoders (for instance the PNG decoder). A too small value can cause
OutOfMemory errors and incomplete drawings.
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Category: Font

v Libraries Fonts to Process
~ Micrell X i i i X
Font List the fonts for the font pre-processing tool. This tool will convert them into
an internal memory format at build time,
Image

Activate the font pre-processing step

Fonts list file which will be linked (after pre-processing step) into the CPU
address space range (internal device memories, external parallel memories).

[[] Define an explicit list file

m
a
e

Group: Fonts to Process

Description:

This group allows to select a file describing the font files which need to be converted into a RAW format. At Mi-
croUl runtime, the pre-generated fonts will be read from the flash memory without any modifications (see MicroUl
specification).

Option(checkbox): Activate the font pre-processing step

Option Name: ej.microui.fontConverter.uselt
Default value: true
Description:

When checked, enables the next option Fonts 1list file. When the next option is disabled, there is no check on
the file path validity.

Option(checkbox): Define an explicit list file

Option Name: ej.microui.fontConverter.file.enabled
Default value: false
Description:

By default, list files are loaded from the classpath. When checked, only the next option Fonts list fileis processed.
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Option(browse):

Option Name: ej.microui.fontConverter.file
Default value: (empty)
Description:

Browse to select a font list file. Refer to Font Generator chapter for more information about the font list file format.

Category: Image

v Libraries Images to Process
~ Micrall X X X i i i X
Font List the images for the image pre-processing tool. This tool will convert them into
| the display memory format (BPP, layout) at build time.
mage

Activate the image pre-processing step

Images list file which will be linked (after pre-processing step) into the CPU
address space range (internal device memories, external parallel memories).

[] Define an explicit list file

m
a
e

Group: Images to Process

Description:

This group allows to select a file describing the image files which need to be converted into a RAW format. At
MicroUl runtime, the pre-generated images will be read from the flash memory without any modifications (see
MicroUl specification).

Option(checkbox): Activate the image pre-processing step

Option Name: ej.microui.imageConverter.uselt
Default value: true
Description:

When checked, enables the next option Images list file. When the next option is disabled, there is no check on
the file path validity.
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Option(checkbox): Define an explicit list file

Option Name: ej.microui.imageConverter.file.enabled
Default value: false
Description:

By default, list files are loaded from the classpath. When checked, only the next option Images list fileis pro-
cessed.

Option(browse):

Option Name: ej.microui.imageConverter.file
Default value: (empty)
Description:

Browse to select an image list file. Refer to Image Generator chapter for more information about the image list file
format.

Debug Traces
MicroUl logs several actions when traces are enabled. This chapter explains the traces identifiers. Some events
data are described in next tables.
[TRACE: MicroUI] Event AA(BBLCC],DDLEE])
where:
« AAis the event identifier. See next table.
+ BBis the first event data.
« CCisthefirst event data number (0x0).
+ DD is the second event data.
« EE isthe second event data number (0x1).

« etc.
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Table 17: MicroUl Traces

Event | Description End of event
ID
0x0 Execute EventGenerator event %0% (see Event Type). Generatoridis | End of %0% (see Event Type).
(0) %1% and datais %2%.
0x1(1) | Drop event %0%.
0x2 (2) | Execute native inputevent %0% (see Event Type). Generatoridis %1% | End of %0% (see Event Type).
and datais %2%.
0x3 (3) | Execute display event %0% (see Event Type). Eventis %1%. End of %0% (see Event Type).
0x4 (4) | Execute user event %0%. End of %0%.
0x5 (5) | Create new image using %0% algorithm (see Create Image). Image created, image identi-
fieris %0%.
0x6 (6) | New image characteristics %0% (see Image Type), identifier is %1%
and memory size is %2% .
Oxa Flush back buffer; position ( %0%, %1% ) size ( %2% * %3%).
(10)
Oxb Flush done.
(1)
0xc Start internal drawing operation %0% (see Drawing Type). End of drawing %0% (see
(12) Drawing Type)
0xd Start drawing operation %0% (see Drawing Type). End of drawing %0% (see
(13) Drawing Type)
Oxe Unknown event.
(14)
oxf Asynchronous drawing operation done.
(15)
0x14 Invalid input event %0%.
(20)
0x15 Event queue is full, cannot add event %0%.
(21)
0x16 Add event %0% atindex %1% ; queue length is %2%.
(22)
0x17 Replace event %0% by %1% atindex %2%; queue length is %3%.
(23)
0x18 Read event %0% atindex %1%.
(24)
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Table 18: Event Type

Event ID | Description
0x0 (0) Event “Command”
0x1 (1) Event “Button”
0x2 (2) Event “Pointer”
0x3 (3) Event “State”
0x4 (4) Event “Unknwon”
0x5 (5) Event “Call Serially”
0x6 (6) Event “MicroUl Stop”
0x7 (7) Event “Input”
0x8 (8) Event “Show Displayable”
0x9 (9) Event “Hide Displayable”
Oxb (11) Event “Pending Flush”
Oxc (12) | Event “Force Flush”
0xd (13) | Event “Repaint Displayable”
Oxe (14) | Event “Repaint Current Displayable”
0xf (15) Event “KF Stop Feature”
Table 19: Create Image
Event ID | Description
0x0 (0) Create Bufferedlmage
0x1(1) Create Image from path
0x2 (2) Create Image from InputStream
Table 20: Image Type
EventID | Description
0x0 (0) New Bufferedimage
0x1 (1) Load MicroEJ Image from RAW file
0x2 (2) New MicroEJ Image from encoded image
0x3 (3) New MicroEJ Image from RAW image in external memory
0x4 (4) New MicroEJ Image from encoded image in external memory
0x5 (5) New MicroEJ Image from memory InputStream
0x6 (6) New MicroEJ Image from byte array InputStream
Ox7 (7) New MicroEJ Image from generic InputStream
0x8 (8) Link Image

Table 21: Drawing Type

Event ID Description

0x1 (1) Write pixel

0x2 (2) Draw line

0x3 (3) Draw horizontal line
0x4 (4) Draw vertical line

0x5 (5) Draw rectangle

0x6 (6) Fill rectangle

0x7 (7) Unknown

0x8 (8) Draw rounded rectangle
0x9 (9) Fill rounded rectangle

Continued on next page
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Table 21 - continued from previous page

EventID Description

Oxa (10) Draw circle arc

Oxb (11) Fill circle arc

0xc (12) Draw ellipse arc

0xd (13) Fill ellipse arc

Oxe (14) Draw ellipse

0xf (15) Fill ellipse

0x10 (16) Draw circle

0x11 (17) Fill circle

0x12 (18) Draw ARGB array

0x13 (19) Draw image

0x32 (50) Draw polygon

0x33 (51) Fill polygon

0x34 (52) Get ARGB image data

0x35 (53) Draw string

0x36 (54) Draw deformed string

0x37 (55) Draw deformed image

0x38 (56) Draw character with rotation (bilinear)
0x39 (57) Draw character with rotation (simple)
0x3a (58) Get string width

0x3b (59) Get pixel

0x64 (100) | Draw thick faded point

0x65 (101) | Draw thick faded line

0x66 (102) | Draw thick faded circle

0x67 (103) | Draw thick faded circle arc

0x68 (104) | Draw thick faded ellipse

0x69 (105) | Draw thick line

0x6a (106) | Draw thick circle

0x6b (107) | Draw thick ellipse

0x6¢ (108) | Draw thick circle arc

0xc8 (200) | Draw image with fli

0xc9 (201) | Draw image with rotation (simple)
Oxca (202) | Draw image with rotation (bilinear)
Oxcb (203) | Draw image with scalling (simple)
Oxcc (204) | Draw image with scalling (bilinear)

The traces are SystemView compatible. The following text can be copied in a file called SYSVIEW_MicroUI.txt and
copied in SystemView installation folder.

NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType

UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent

0=COMMAND

1=BUTTON

2=POINTER

3=STATE

4=UNKNOWN
5=CALLSERIALLY
6=STOP

7=INPUT
8=SHOW_DISPLAYABLE
9=HIDE_DISPLAYABLE
11=PENDING_FLUSH
12=FORCE_FLUSH
13=REPAINT_DISPLAYABLE

(continues on next page)
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NamedType UIEvent 14=REPAINT_CURRENT_DISPLAYABLE
NamedType UIEvent 15=KF_STOP_FEATURE

NamedType UINewImage 0=MUTABLE_IMAGE
NamedType UINewImage 1=IMAGE_FROM_PATH
NamedType UINewImage 2=IMAGE_FROM_INPUTSTREAM

NamedType UIImageData O=NEW_IMAGE

NamedType UIImageData 1=LOAD_MICROEJ
NamedType UIImageData 2=NEW_ENCODED

NamedType UIImageData 3=NEW_MICROEJ_EXTERNAL
NamedType UIImageData 4=NEW_ENCODED_EXTERNAL
NamedType UIImageData 5=MEMORY_INPUTSTREAM
NamedType UIImageData 6=BYTEARRAY_INPUTSTREAM
NamedType UIImageData 7=GENERIC_INPUTSTREAM
NamedType UIImageData 8=LINK_IMAGE

NamedType GEDraw 1=WRITE_PIXEL

NamedType GEDraw 2=DRAW_LINE

NamedType GEDraw 3=DRAW_HORIZONTALLINE
NamedType GEDraw 4=DRAW_VERTICALLINE
NamedType GEDraw 5=DRAW_RECTANGLE
NamedType GEDraw 6=FILL_RECTANGLE
NamedType GEDraw 7=UNKNOWN

NamedType GEDraw 8=DRAW_ROUNDEDRECTANGLE
NamedType GEDraw 9=FILL_ROUNDEDRECTANGLE
NamedType GEDraw 10=DRAW_CIRCLEARC
NamedType GEDraw 11=FILL_CIRCLEARC
NamedType GEDraw 12=DRAW_ELLIPSEARC
NamedType GEDraw 13=FILL_ELLIPSEARC
NamedType GEDraw 14=DRAW_ELLIPSE
NamedType GEDraw 15=FILL_ELLIPSE
NamedType GEDraw 16=DRAW_CIRCLE
NamedType GEDraw 17=FILL_CIRCLE
NamedType GEDraw 18=DRAW_ARGB

NamedType GEDraw 19=DRAW_IMAGE

NamedType GEDraw 50=DRAW_POLYGON

NamedType GEDraw 51=FILL_POLYGON

NamedType GEDraw 52=GET_IMAGEARGB

NamedType GEDraw 53=DRAW_STRING

NamedType GEDraw 54=DRAW_DEFORMED_STRING
NamedType GEDraw 55=DRAW_IMAGE_DEFORMED
NamedType GEDraw 56=DRAW_CHAR_ROTATION_BILINEAR
NamedType GEDraw 57=DRAW_CHAR_ROTATION_SIMPLE
NamedType GEDraw 58=STRING_WIDTH

NamedType GEDraw 59=GET_PIXEL

NamedType GEDraw 100=DRAW_THICKFADEDPOINT
NamedType GEDraw 101=DRAW_THICKFADEDLINE
NamedType GEDraw 102=DRAW_THICKFADEDCIRCLE
NamedType GEDraw 103=DRAW_THICKFADEDCIRCLEARC
NamedType GEDraw 104=DRAW_THICKFADEDELLIPSE
NamedType GEDraw 105=DRAW_THICKLINE

NamedType GEDraw 106=DRAW_THICKCIRCLE
NamedType GEDraw 107=DRAW_THICKELLIPSE

(continued from previous page)

(continues on next page)
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(continued from previous page)

NamedType GEDraw 108=DRAW_THICKCIRCLEARC

NamedType GEDraw 200=DRAW_FLIPPEDIMAGE

NamedType GEDraw 2071=DRAW_ROTATEDIMAGENEARESTNEIGHBOR
NamedType GEDraw 202=DRAW_ROTATEDIMAGEBILINEAR
NamedType GEDraw 203=DRAW_SCALEDIMAGENEARESTNEIGHBOR
NamedType GEDraw 204=DRAW_SCALEDIMAGEBILINEAR

#

# MicroUI

#

0 UI_EGEvent (MicroUI) Execute EventGenerator event %UIEvent (generatorID = %u,.
—data = %p) | (MicroUI) EventGenerator event %UIEvent done

1 UI_DROPEvent (MicroUI) Drop event %p

2 UI_InputEvent (MicroUI) Execute native input event %UIEvent (generatorID = %u, event =
—%p) | (MicroUI) Native input event %UIEvent done

3 UI_DisplayEvent (MicroUI) Execute display event %UIEvent (event = %p) o
< | (MicroUI) Display event %UIEvent done

4 UI_UserEvent (MicroUI) Execute user event %p o
— | (MicroUI) User event %p done

5 UI_OpenImage (MicroUI) Create %UINewImage -
. | (MicroUI) Image created; id = %p

6 UI_ImageData (MicroUI) %UINewImage ( %UIImageData ): id = %p; size = %d*%d

#

# MicroUI Graphics Engine
#

10 GE_FlushStart
11 GE_FlushDone

12 GE_DrawInternal
13 GE_Draw

14 GE_Unknown

15 GE_GPUDrawDone
#

# MicroUI Input Engine
#

20 IE_InvalidEvent
21 IE_QueueFull

22 IE_AddEvent

23 IE_ReplaceEvent
<~>%U)

24 IE_ReadEvent

Error Messages

(MicroUI GraphicalEngine) Flush back buffer (%u,%u) (%u*%u)

(MicroUI GraphicalEngine) Flush done

(MicroUI GraphicalEngine) Drawing operation %GEDraw [
—(MicroUI GraphicalEngine) Drawing operation %GEDraw done

(MicroUI GraphicalEngine) Drawing operation %GEDraw [
<»(MicroUI GraphicalEngine) Drawing operation %GEDraw done

(MicroUI GraphicalEngine) Unknown event

(MicroUI GraphicalEngine) Asynchronous drawing operation done

(MicroUl
(MicroUI
(MicroUI
(MicroUl

(MicroUI

Input Engine) Invalid event: %p

Input Engine) Queue full, cannot add event %p

Input Engine) Add event %p (index = %u / queue length = %u)

Input Engine) Replace event %p by %p (index = %u / queue length =

Input Engine) Read event %p (index %u)

When an exception is thrown by the implementation of the MicroUl API, the exception MicroUlException with the
error message MicroUI:E=<messageld> is issued, where the meaning of <messagelId> is defined in following

table:
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Table 22: MicroUl Error Messages

Message ID Description

1 Another EventGenerator cannot be added into the system pool (max 254).

0 [platform issue] Result of MicroUl static initialization step seems invalid. MicroUl cannot
start. Please fix MicroUl static initialization step (see Static Initialization) and rebuild the
platform.

-1 MicroUl is not started; call MicroUl.start() before using a MicroUl API.

-2 Unknown event generator class name.

-3 Deadlock. Cannot wait for an event in the same thread that runs events. Display.
waitFlushCompleted() must not be called in the MicroUl thread (for example in render
method).

-4 Resource’s path must be relative to the classpath (start with ‘/’) or resource is not available.

-5 The resource data cannot be read for unknown reason.

-6 The resource has been closed and cannot be used anymore.

-7 Out of memory. Not enough memory to allocate the Image ’s buffer. Try to close some
uselessimages and retry opening the new image, orincrease the size of the MicroUl images
heap.

-8 The platform cannot decode this kind of image, because the required runtime image de-
coder is not available in the platform.

-9 This exception is thrown when the FIFO of the internal MicroUl thread is full. In this case,
no more event (such as requestRender , input events, etc.) can be added into it.

Most of time this error occurs when:
« Thereis a user thread which performs too many calls to the method requestRender
without waiting for the end of the previous drawing.
« Too many input events are pushed from an input driver to the MicroUl thread (for
example some touch events).
-10 There is no display on the platform.
-n There is no font (platform and application).

3.12.2 MWT (Micro Widget Toolkit)
Introduction

MWT is a toolkit that simplifies the creation and use of graphical user interface widgets on a pixel-based display.

The aim of this library is to be sufficient to create complex applications with a minimal framework. It provides the
main concepts without managing particular needs. Specific needs can be met by a MWT expert by creating new
widgets, adding more complex concepts, etc. The flexibility of the MWT open framework allows the selection of
only what is necessary for the application in order to guarantee lightweight applications and fast execution.

To use the MWT library, add the following line to a module description file:

<dependency org="ej.library.ui” name="mwt" rev="3.1.0"/>

Concepts
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Graphical Elements

C Displayable

C Desktop

@ EventDispatcher getEventDispatcher()
@ void requestLayut()

@ boolean handleEvent|int event)

@ Stylesheet getStylesheet(}

widget
A Widget
O intx
2 inty
o intwidth
© int height

< woid onLaidOut()

< woid onAttached()

<* void onDetached()

<* void onShown()

“» woid onHidden()

@ woid requestLayOut()

< void computeCantentOptimalSize[Size size)
@ void requestRender()

© boolean handleEvent(int event)

> void renderContent(GraphicsContext g, Size size)
@ Style getStyle()

boolean hasClassSelector(int classSelector)

]
@ boolean isinstateint state)

children

A Container

——————————————<yeidlayOutChildrenfint contentifiathint contentHeight)
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Widget

Awidget is an object that is intended to be displayed on a screen. A widget occupies a specific region of the display
and holds a state. A user may interact with a widget (using a touch screen or a button for example).

Widgets are arranged on a desktop. A widget can be part of only one desktop hierarchy, and can appear only once
on that desktop.

Container

A container follows the composite pattern: it is a widget composed of other widgets. It also defines the layout
policy of its children (defining their bounds). The children’s positions are relative to the position of their parent.
Containers can be nested to design elaborate user interfaces.

By default, the children are rendered in the order in which they have been added in the container. And thus if the
container allows overlapping, the widgets added last will be on top of the widgets added first. A container can also
modify how its children are rendered.

Desktop

A desktop is a displayable intended to be shown on a display (cf. MicroUl). At any time, only one desktop can be
displayed per display.

A desktop contains a widget (or a container). When the desktop is shown, its widget (and all its hierarchy for a
container) is drawn on the display.

Rendering

Anew rendering of a widget on the display can be requested by calling its requestRender () method. The render-
ing is done asynchronously in the MicroUl thread.

When a container is rendered, all its children are also rendered.

A widget can be transparent, meaning that it does not draw every pixel within its bounds. In this case, when this
widget is asked to be rendered, its parent is asked to be rendered in the area of the widget (recursively if the parent
is also transparent). Usually a widget is transparent when its background (from the style) is transparent.

A widget can also be rendered directly in a specific graphics context by calling its render(GraphicsContext)
method. It can be useful to render a widget (and its children) in an image for example.

Render Policy

Arender policy is a strategy that MWT uses in order to repaint the entire desktop or to repaint a specific widget.

The most naive render policy would be to render the whole hierarchy of the desktop whenever a widget has
changed. However DefaultRenderPolicy is smarter than that: it only repaints the widget, and its ances-
tors if the widget is transparent. The result is correct only if there is no overlapping widget, in which case
OverlapRenderPolicy should be used instead. This policy repaints the widget (or its non-transparent ancestor),
then it repaints all the widgets that overlap it.

When using a partial buffer, these render policies can not be used because they render the entire screen in a single
pass. Instead, a custom render policy which renders the screen in multiple passes has to be used. Refer to the
partial buffer demo for more information on how to implement this render policy and how to use it.
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The render policy can be changed by overridding Desktop.createRenderPolicy() .

Lay Out

All widgets are laid out at once during the lay out process. This process can be started by Desktop.
requestlLayOut (), Widget.requestlLayOut() . The layoutis also automatically done when the desktop is shown (
Desktop.onShown() ). This process is composed of two steps, each step browses the hierarchy of widgets following
a depth-first algorithm:

« compute the optimal size for each widget and container (considering the constraints of the lay out),
+ set position and size for each widget.

Once the position and size of a widget is set, the widget is notified by a call to onLaidOut() .

Event Dispatch

Events generated in the hardware (touch, buttons, etc.) are sent to the event dispatcher of the desktop. It is then
responsible of sending the event to one or several widgets of the hierarchy. A widget receives the event through
its handleEvent(int) method. This method returns a boolean that indicates whether or not the event has been
consumed by the widget.

Widgets are disabled by default and don’t receive the events.

Pointer Event Dispatcher

By default, the desktop proposes an event dispatcher that handles only pointer events.

Pointer events are grouped in sessions. A session starts when the pointer is pressed, and ends when the pointer is
released or when it exits the pressed widget.

While no widget consumes the events, they are sent to the widget that is under the pointer (see Desktop.
getWidgetAt(int, int)),then sentto allits parent hierarchy recursively.

Once a widget has consumed an event, it will be the only one to receive the next events during the session.

Pointer released within widget bounds - DRAGGED event

< Pointer dragged or released consumed by another widget - EXITED event | ——
NOT PRESSED STATE g3 PRESSED STATE __ Pointer dragged within widget bounds - DRAGGED event
< Pointer dragged or released outside widget bounds - EXITED event

H“-\-\.

~—___ Pointer pressed within widget bounds - PRESSED event 7_;_-/

A widget can redefine its reactive area by subclassing the contains(int x, int y) method. Itis useful when a
widget does not fill fully its bounds.

Style

A style describes how widgets must be rendered on screen. The attributes of the style are strongly inspired from
CSS.
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Dimension

The dimension is used to constrain the size of the widget.
MWT provides multiple implementations of dimensions:

+ NoDimension does not constrain the dimension of the widget, so the widget will take all the space granted
by its parent container.

« OptimalDimension constrains the dimension of the widget to its optimal size, which is given by the
computeContentOptimalSize() method of the widget.

« FixedDimension constrains the dimension of the widget to a fixed absolute size.

« RelativeDimension constrains the dimension of the widget to a percentage of the size of its parent con-
tainer.

Alignment

The horizontal and vertical alignments are used to position the content of the widget within its bounds.

The alignment is used by the framework to position the widget within its available space if the size of the widget
has been constrained with a Dimension.

The alignment can also be used in the renderContent() method in order to position the drawings of the widget
(such as a text or an image) within its content bounds.

Outlines

The margin, border and padding are the 3 outlines which wrap the content of the widget. The widget is wrapped
in the following sequence: first the padding, then the border, and finally the margin.

Margin

Border
Padding

Content

MWT provides multiple implementations of invisible outlines which are usually used for margin and padding:
« NoOutline does notwrap the widgetin an outline.
« UniformOutline wraps the widget in an outline which thickness is equal on all sides.
« FlexibleOutline wraps the widgetin an outline which thickness can be configured for each side.

MWT also provides multiple implementations of visible outlines which are usually used for border:
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+ RectangularBorder draws a plain rectangle around the widget.

+ RoundedBorder draws a plain rounded rectangle around the widget.

Background

The background is used to render the background of the widget. The background covers the border, the padding
and the content of the widget, but not its margin.

MWT provides multiple implementations of backgrounds:
« NoBackground leaves a transparent background behind the widget.
+ RectangularBackground draws a plain rectangle behind the widget.
« RoundedBackground draws a plain rounded rectangle behind the widget.

« ImageBackground draws animage behinds the widget.

Color

The color is not used by the framework itself, but it may be used in the renderContent () to select the color of the
drawings.

Font

The fontis not used by framework itself, but it may be used in the renderContent() to selectthe fontto use when
drawing strings.

Extra fields

Extra fields are not used by framework itself, but they may be used in the renderContent() to customize the
behavior and the appearance of the widget.

See chapter How to Define an Extra Style Field for more information on extra fields.

Stylesheet

A stylesheet allows to customize the appearance of all the widgets of a desktop without changing the code of the
widget subclasses.

MWT provides multiple implementations of stylesheets:
« VoidStylesheet assigns the same default style for every widget.
« CascadingStylesheet assigns styles to widgets using selectors, similarly to CSS.

For example, the following code customizes the style of every Label widget of the desktop:

CascadingStylesheet stylesheet = new CascadingStylesheet();

EditableStyle labelStyle = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
labelStyle.setColor(Colors.RED);
labelStyle.setBackground(new RectangularBackground(Colors.WHITE));

(continues on next page)
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(continued from previous page)

desktop.setStylesheet(stylesheet);

Animations

MWT provides a utility class in order to animate widgets: Animator. When a widget is being animated by an anima-
tor, the widget is notified each time that the display is flushed. The widget can use this interrupt in order to update
its state and request a new rendering.

See chapter How to Animate a Widget for more information on animating a widget.

Partial buffer considerations

Rendering a widget in partial buffer mode may require multiple cycles if the buffer is not big enough to hold all the
pixels to update in a single shot. This means that rendering is slower in partial buffer mode, and this may cause
performance being significantly affected during animations.

Besides, the whole screen is flushed in multiple times instead of a single one, which means that the user may see
the display at a time where every part of the display has not been flushed yet.

Due to these limitations, it is not recommended to repaint big parts of the screen at the same time. For example, a
transition on a small part of the screen will look better than a transition affecting the whole screen. A transition will
look perfect if the partial buffer can hold all the lines to repaint. Since the buffer holds a group of lines, a horizontal
transition may not look the same as a vertical transition.

Desktop and widget states

Desktop and widgets pass through different states. Once created, they can be attached, then they can be shown.

Adesktop is attached automatically as soon asitis shown on the display. It can also be attached manually by calling
Desktop.setAttached() . It could be used to render the desktop (and its widgets) on an image for example.

A widget is considered as attached when it is contained by a desktop that is attached.

In the same way, by default, a widget is shown when its desktop is shown. But for optimization purpose, a container
can control when its children are shown or hidden. A typical use case is when the widgets are moved outside the
display.

Once awidgetis attached, it means that it is ready to be shown (for instance, the necessary resources are allocated).
In other words, once attached a widget is ready to be rendered (on an image or on the display).

Once a widget is shown, it means that it is intended to be rendered on the display. While shown, it may start a
periodic refresh or an animation.
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The following sections will present several ways to customize and extend the framework to better fit your needs.

How to Create a Widget

A widget is the main way to render information on the display. A set of pre-defined widgets is described in the
Widgets and Examples section.

If the needed widget does not already exist, it is possible to create it from scratch (or by derivating another one).

To create a custom widget, a new class should be created, extending the Widget class. Widget subclasses have to
implement two methods and may override optional methods, as explained in the following sections.

Implementing the mandatory methods
Computing the optimal size of the widget

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size
of the widget. The optimal size of the widget should be big enough to contain all the drawings of the widget.

The Size parameter of the computeContentOptimalSize() method initially contains the size available for the
widget. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the widget.

When implementing this method, the getStyle() method may be called in orderto retrieve the style of the widget.

For example, the following snippet computes the optimal size of a label:

@0verride

protected void computeContentOptimalSize(Size size) {
Font font = getStyle().getFont();
int width = font.stringWidth(this.text);
int height = font.getHeight();
size.setSize(width, height);

Rendering the content of the widget

The renderContent() method is called by the MWT framework in order to render the content of the widget.
When implementing this method, the getStyle() method may be called in orderto retrieve the style of the widget.

For example, the following snippet renders the content of a label:

@0verride

protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
Style style = getStyle();
g.setColor(style.getColor());
Painter.drawString(g, style.getFont(), this.text, 0, 0);
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Handling events

When a widget is created, it is disabled and it will not receive any event. A widget may be enabled or disabled by
calling setEnabled() . Acommon practice is to enable the widget in its constructor.

Enabled widgets can handle events by overriding handleEvent() . MicroUl event APIs may be used in order to
know more information on the event, such as its type. The handleEvent () method should return whether or not
the event was consumed by the widget.

For example, the following snippet prints a message when the widget receives an event:

@0verride

public boolean handleEvent(int event) {
System.out.println("Event type:
return false;

"

+ Event.getType(event));

Listening to the life-cycle hooks

Widget subclasses may override the following methods in order to allocate and free the necessary resources:
* onAttached()
» onDetached()
e onLaidOut()
« onShown()
» onHidden()

For example, the onAttached() may be overridden to load an image:

@Override
protected void onAttached() {
this.image = Resourcelmage.loadImage(this.imagePath);

}

Likewise, the onDetached() method may be overridden to close the image:

@Override
protected void onDetached() {
this.image.close();

}

For example, the onShown() may be overridden to start an animation:

@Override

protected void onShown() {
Animator animator = ServiceFactory.getService(Animator.class);
animator.startAnimation(this);

Likewise, the onHidden() method may be overridden to stop an animation:

@0verride
protected void onHidden() {
Animator animator = ServiceFactory.getService(Animator.class);
(continues on next page)
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(continued from previous page)

animator.stopAnimation(this);

How to Create a Container

To create a custom container, a new class should be created, extending the Container class. This new class may
define a constructor and setter methods in order to provide a way for the user to configure the container, such
as its orientation. Container subclasses have to implement two methods and may override optional methods, as
explained in the following sections.

Implementing the mandatory methods

This section explains how to implement the two mandatory methods of a container subclass.

Computing the optimal size of the container

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size
of the container. The optimal size of the container should be big enough so that each child can be laid out with a
size at least as big as its own optimal size.

The container is responsible for computing the optimal size of every child. To do so, the
computeChildOptimalSize() method should be called for every child. After this method is called, the opti-
mal size of the child can be retrieved by calling getWidth() and getHeight() on the child widget.

The Size parameter of the computeContentOptimalSize() method initially contains the size available for the
container. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the container.

For example, the following snippet computes the optimal size of a simple wrapper:

@0verride

protected void computeContentOptimalSize(Size size) {
Widget child = getChild(0);
computeChildOptimalSize(child, size.getWidth(), size.getHeight());
size.setSize(child.getWidth(), child.getHeight());

Laying out the children of the container

The layOutChildren() method is called by the MWT framework in order to lay out every child of the container,
i.e. to set the position and size of the children. If a child is laid out outside the bounds of the container (partially or
fully), only the part of the widget which is within the container bounds will be visible.

The container is responsible for laying out each child. To do so, the layOutChild() method should be called for
every child. Before this method is called, the optimal size of the child can be retrieved by calling getWidth() and
getHeight() on the child widget.

When laying out a child, its bounds have to be passed as parameter. The position will be interpreted as relative to
the position of the container content. This means that the position should not include the outlines of the con-
tainer. This means that the (0, ©) coordinates represent the top-left pixel of the container content and the
(contentWidth-1, contentHeight-1) coordinates represent the bottom-right pixel of the container content.
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For example, the following snippet lays out the children of a simple wrapper:

@0verride

protected void layOutChildren(int contentWidth, int contentHeight) {
Widget child = getChild(0);
layOutChild(child, @, @, contentWidth, contentHeight);

Managing the visibility of the children of the container

By default, when a container is shown, each of its children is shown too. This behavior can be changed by over-
riding the setShownChildren() method of Container.Whenimplementing this method, the setShownChild()
method should be called for each child which should be shown when the container is shown.

At any time while the container is visible, children may be shown or hidden by calling setShownChild() or
setHiddenChild() .

When a container is hidden, each of its children is hidden too (unless it is already hidden). It is not necessary to
override setHiddenChildren() , except for optimization.

Providing APIs to change the children list of the container

The Container classintroduces protected APlsin orderto manipulate the list of children of the container. These
methods may be overridden in the container subclass and set as public in order to make these APIs available for
the user.

Each of the following methods may be overridden individually:
« addChild()
o removeChild()
o removeAllChildren()
e insertChild()
e replaceChild()
o changeChildIndex()

For example, the following snippet allows the user to call the addChild() method on the container:

@Override

public void addChild(Widget child) {
super.addChild(child);

3

How to Animate a Widget

Starting and stopping the animation

To animate awidget,an Animator instanceisrequired. Thisinstance can be passed in the constructor of the widget
or be fetched from a service provider. Make sure that your widget subclass implements the Animation interface
so that it can be used with an Animator.

An animation can be started at any moment, provided that the widget is shown. For example, the animation can
start on a click event. Likewise, an animation can be stopped at any moment, for example a few seconds after the
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animation has started. Once the widget is hidden, its animation should always be stopped to avoid memory leaks
and unnecessary operations.

To start the animation of the widget, callthe startAnimation() method of the Animator instance. To stop it, call
the stopAnimation() method of the same Animator instance.

For example, the following snippet starts the animation as soon as the widget is shown and stops it once the widget
is hidden:

public class MyAnimatedWidget extends Widget implements Animation {
private final Animator animator;

private long startTime;
private long elapsedTime;

public MyAnimatedWidget(Animator animator) {
this.animator = animator;

b

@Override

protected void onShown() {
this.startTime = System.currentTimeMillis();
this.animator.startAnimation(this);

b

@override
protected void onHidden() {
this.animator.stopAnimation(this);

3

Performing an animation step

The tick() method is called by the animator in order to update the widget. It is called in the Ul thread once the
display has been flushed. This method should not render the widget but should update its state and request a new
render if necessary. The tick() method should return whether or not the animation should continue after this
increment.

For example, the following snippet updates the state of the widget when it is ticked, requests a new render and
keeps the animation going until 5 seconds have passed:

@Override

public boolean tick(long currentTimeMillis) {
// update widget state
this.elapsedTime = currentTimeMillis - this.startTime;
// request new render
requestRender();
// return whether to continue or to stop the animation
return (this.elapsedTime < 5_000);

The renderContent() method should render the widget by using its current state (saved in the fields of the wid-
get). This method should not call methods such as System.currentTimeMillis() because the widget could be
rendered in multiple passes, for example if a partial buffer is used.

For example, the following snippet renders the current state of the widget by displaying the time elapsed since the
start of the animation:
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@0verride

protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
Style style = getStyle();
g.setColor(style.getColor());
Painter.drawString(g, Long.toString(this.elapsedTime), style.getFont(), 0, 0);

How to Define an Outline or Border

To create a custom outline or border, a new class should be created, extending the Outline class. Outline sub-
classes have to implement two methods, as explained in the following sections.

Applying the outline on an outlineable object

The apply(Outlineable) method is called by the MWT framework in order to subtract the outline from a Size
or Rectangle object.

The Outlineable parameter of the method initially contains the size or bounds of the box, including the outline.
Before the method returns, the outlineable object should be modified by subtracting the outline. In order to remove
the outline from the object, the removeOutline() method of Outlineable should be used, passing as argument
the thickness on each side.

For example, the following snippet applies an outline of 1 pixel on every side:

@0verride
public void apply(Outlineable outlineable) {
outlineable.removeOutline(1, 1, 1, 1);

}

Applying the outline on a graphics context

The apply(GraphicsContext, Size) method is called by the MWT framework in order to render the outline (only
relevant if it is a border) and to update the translation and clip of a graphics context.

The Size parameter of the method initially contains the size of the box, including the outline. Before the method
returns, the size object should be modified by subtracting the outline. In order to remove the outline from the
object, the removeOutline() method of Outlineable should be used, passing as argument the thickness on
each side.

For example, the following snippet applies an outline of 1 pixel on every side:

@Override

public void apply(GraphicsContext g, Size size) {
size.removeOutline(1, 1, 1, 1);
g.translate(1, 1);
g.setClip(0@, 0, size.getWidth(), size.getHeight());

How to Define a Background

To create a custom background, a new class should be created, extending the Background class. Background
subclasses have to implement two methods, as explained in the following sections.
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Informing whether the background is transparent

The isTransparent() method is called by the MWT framework in order to know whether or not the background is
transparent. A background is considered as transparent if it does not draw every pixel with maximal opacity when
itis applied.

For example, the following snippet informs that the background is completely opaque regardless of its size:

@Override
public boolean isTransparent(int width, int height) {
return false;

3

Applying the background on a graphics context

The apply(GraphicsContext g, Size size) method is called by the MWT framework in order to render the
background and to set or remove the background color of subsequent drawings.

For example, the following snippet applies a white background:

@Override

public void apply(GraphicsContext g, Size size) {
g.setColor(Colors.WHITE);
Painter.fillRectangle(g, 0, 0, size.getWidth(), size.getHeight());
g.setBackgroundColor(Colors.WHITE);

How to Create a Desktop Event Dispatcher

Creating a custom event dispatcher can help you address two use cases:

« [Dispatch] Extending an EventDispatcher is used to dispatch the events. For example, the FocusEventDis-
patcher will send the events to the widget owning the focus.

« [Handle] Overriding the desktop is used to directly trigger a behavior. For example “BACK” command shows
the previous page.

To create a custom event dispatcher, a new class should be created, extending the EventDispatcher class. Event
dispatcher subclasses have to implement a method and may override optional methods, as explained in the fol-
lowing sections.

Dispatching the events to the widgets

The dispatchEvent() methodis called by the MWT framework in order to dispatch a MicroUl event to the widgets
of the desktop. The getDesktop() method may be called in order to retrieve the desktop with which the event
dispatcher is associated. This is useful in order to browse the widget hierarchy of the desktop, for example by using
the getWidget() and getWidgetAt() methods of Desktop.

In order to send an event to one of the widgets of the hierarchy, the sendEventToWidget() method should be
used. The dispatchEvent() method should return whether or not the event was dispatched and consumed by a
widget.

For example, the following snippet dispatches every event to the widget of the desktop:
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@0verride
public boolean dispatchEvent(int event) {
Widget desktopWidget = getDesktop().getWidget();
if (desktopWidget != null) {
return sendEventToWidget(desktopWidget, event);
} else {
return false;
}
3

In addition to dispatching the provided events, an event dispatcher may generate custom events. This may be done
by using a DesktopEventGenerator . Its buildEvent() method allows to build an event which may be sentto a
widget using the sendEventToWidget() method.

Initializing and disposing the dispatcher

EventDispatcher subclasses may override the initialize() and dispose() methods in order to allocate and
free the necessary resources.

Forexample,the initialize() method maybeoverriddento create an event generatorand to add it to the system
pool of MicroUl:

@Override

public void initialize() {
this.eventGenerator = new DesktopEventGenerator();
this.eventGenerator.addToSystemPool();

3

Likewise, the dispose() method may be overridden to remove the event generator from the system pool of Mi-
croUl:

@Override
public void dispose() {
this.eventGenerator.removeFromSystemPool();

}

How to Define an Extra Style Field

Extra style fields allow to customize a widget by configuring graphical elements of the widget from the stylesheet.
Extra fields are only relevant to a specific widget type and its subtypes. A widget type can support up to 7 extra
fields. The value of an extra field may be represented asan int,a float orany object, and it can not be inherited
from parent widgets.

Defining an extra field ID

The recommended practice is to add a public constant for the ID of the new extra field in the widget subtype. This
ID should be an integer with a value between ¢ and 6.

Every extra field ID has to be unique within the widget type. However, two unrelated widget types may define an
extra field with the same ID.

For example, the following snippet defines an extra field for a secondary color:
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public static final int SECONDARY_COLOR_FIELD = 0;

Setting an extra field in the stylesheet

The value of an extra field may be set in the stylesheet in a similar fashion to built-in style fields, using one of the
setExtraxxX() methodsof EditableStyle.

For example, the following snippet sets the value of an extra field for all the instances of a widget subtype:

EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(MyWidget.class));
style.setExtraInt(MyWidget.SECONDARY_COLOR_FIELD, Colors.RED);

Getting an extra field during rendering

The value of an extra field may be retrieved from the style of a widget in a similar fashion to built-in style fields,
using one of the getExtraxxX() methodsof Style.When calling one of these methods, a default value has to be
given in case the extra field is not set for this widget.

For example, the following snippet gets the value of an extra field of the widget:

Style style = getStyle();

int secondaryColor = style.getExtralnt(SECONDARY_COLOR_FIELD, Colors.BLACK);
3.12.3 Widgets and Examples

Widget library

The widget library provides very common widgets with basic implementations. These simple widgets may not
provide every desired feature, but they can easily be forked since their implementation is very simple.

The widget library does not provide any example. However, the widget demo provides examples for these widgets.

Source

To use the widgets provided by the widget library, add the following line to a module description file:

<dependency org="ej.library.ui"” name="widget"” rev="3.1.0"/>

To fork one of the provided widgets, duplicate the associated Java class from the widget library JAR into the source
code of your application. It is recommended to move the duplicated class to an other package and to rename the
class in order to avoid confusion between your forked class and the original class.

Provided widgets

Widgets:
« Label : displays a text.
« ImageWidget : displays an image which is loaded from a resource.

« Button: displays a text and reacts to click events.
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+ ImageButton: displays animage which is loaded from a resource and reacts to click events.
Containers:

« List:lays out any number of children horizontally or vertically.

+ Flow: lays out any number of children horizontally or vertically, using multiple rows if necessary.

+ Grid:lays out any number of children in a grid.

« Dock : lays out any number of children by docking each child one by one on a side.

« SimpleDock : lays out three children horizontally or vertically.

« OverlapContainer: lays out any number of children by stacking them.

+ Canvas: lays out any number of children freely.

Widget demo

The widget demo provides some widget implementations as well as usage examples for these widgets and for the
widgets of the Widget library. The widgets and usage examples are intended to be duplicated by the developers in
order to be adapted to their use-case.

Source

To use the widgets provided by the widget demo, clone the following GitHub repository: https://github.com/
MicroEJ/Demo-Widget. You can then import the com.microej.demo.widget projectinto your workspace to see
the source of the widgets and their associated examples.

Each subpackage contains the source code for a specific widget and for a page which showcases the widget. For ex-
ample, the com.microej.demo.widget.checkbox package containsthe Checkbox widgetand the CheckboxPage

Provided widgets

Widgets:
« Checkbox : displays a text and a square which can be checked or unchecked.
« RadioButton: displays a text and a circle which can be checked or unchecked.

+ ProgressBar : displays an animated bar indicating that the user should wait for an estimated amount of
time.

« IndeterminateProgressBar : displays an animated bar indicating that the user should wait for an indeter-
minate amount of time.

« Toggle: displays a text and a switch that can be checked or unchecked.
Containers:
« Split:laysouttwo children horizontally or vertically, by giving each child a portion of the available space.

« Scrollablelist : lays out its widgets the same way as a regular list, but provides an optimization when
added to a scroll.
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MWT examples

The MWT Examples repository provides various examples which extend or customize the MWT framework.

Source

To run the examples and read the source code of these examples, clone the following GitHub repository: https:
//github.com/MicroEJ/ExampleJava-MWT. You can then import the multiple project into your workspace to see
the source of each example and to run it on Simulator or on your board.

Provided examples

« com.microej.example.mwt.attribute: showshow to customize the style of widgets using attributes selec-
tors, similar to CSS.

« com.microej.example.mwt. focus :shows how to introduce focus management in your project.

« com.microej.example.mwt.lazystylesheet : shows how to use a lazy stylesheet rather than the default
stylesheet implementation.

« com.microej.example.mwt.mvc: shows how to develop responsive widgets using a MVC design pattern and
how to display a cursor image representing the pointer.

3.13 Limitations

The following table lists the limitations of MicroEJ Architectures version 7.14.0 or higher, for both Evaluation
and Production usage. Please consult the MicroEJ Architecture Release Notes for limitations changes on former
versions.

Note: The term unlimited means there is no Architecture specific limitation. However, there may be limitations
driven by device memory layout. Please refer to Platform specific documentation to get the memory mapping of
MicroEJ Core Engine sections.
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Table 23: Architecture Limitations

Item EVAL PROD
[Mono-Sandbox] Number of concrete types' 8192 8192
[Multi-Sandbox] Number of concrete types per context' 4096 4096
Number of abstract classes and interfaces unlimited unlimited
Class or Interface hierarchy depth 127 127
Number of methods unlimited unlimited
Method size in bytes 65536 65536
Numbers of exception handlers per method 63 63
Number of instance fields” (Base type) 4096 4096
Number of instance fields? (References) 31 31
Number of static fields (boolean + byte) 65536 65536
Number of static fields (short + char) 65536 65536
Number of static fields (int + float) 65536 65536
Number of static fields (long + double) 65536 65536
Number of static fields (References) 65536 65536
Number of threads 63 63
Number of held monitors® 63 63

Time limit 60 minutes unlimited
Number of methods and constructors calls 500000000 unlimited
Number of Java heap Garbage Collection 3000* unlimited

! Concrete types are classes and arrays that can be instantiated.

2 All instance fields declared in the class and its super classes.

3 The maximum number of different monitors that can be held by one thread at any time is defined by the maximum number of monitors per
thread Application option.

% The Java heap Garbage Collection limit may throw unexpected cascading java.lang.OutOfMemoryError exceptions before the MicroEJ Core
Engine exits.
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CHAPTER

FOUR

PLATFORM DEVELOPER GUIDE

4.1 Introduction

4.1.1 Scope

This document explains how the core features of MicroEJ Architecture are accessed, configured and used by the
MicroEJ Platform builder. It describes the process for creating and augmenting a MicroEJ Architecture. This doc-
ument is concise, but attempts to be exact and complete. Semantics of implemented Foundation Libraries are
described in their respective specifications. This document includes an outline of the required low level drivers
(LLAPI) for porting the MicroEJ Architectures to different real-time operating systems (RTOS).

MicroEJ Architecture is state-of-the-art, with embedded MicroEJ runtimes for MCUs. They also provide simulated
runtimes that execute on workstations to allow software development on “virtual hardware.”

4.1.2 Intended Audience

The audience for this document is software engineers who need to understand how to create and configure a Mi-
croEJ Platform using the MicroEJ Platform builder. This document also explains how a MicroEJ Application can
interoperate with C code on the target, and the details of the MicroEJ Architecture modules, including their APIs,
error codes and options.

4.2 MicroEJ Platform

4.2.1 Modules Overview
MicroEJ Architecture

MicroEJ Architecture features the MicroEJ Core Engine built for a specific instructions set (ISA) and compiler.
The MicroEJ Core Engine is a tiny and fast runtime associated with a Scheduler and a Garbage Collector.
MicroEJ Architecture provides implementations of the following Foundation Libraries :

« EDC: Embedded Device Configuration.

+ BON Beyond Profile (see [BON]).

« SNI Simple Native Interface (/SN/]).
« SP Shielded Plug (/SP]).

KF Kernel & Features (/KF]).
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The following figure shows the components involved.

YOUR APPLICATIONS

ADD-ON LIBRARIES

LIBRARIES

VIRTUALIZATION

Garbage Collector

Scheduler

LLMJVM LLKERNEL LLSP
—ABSTRACTION LAYERS

Timer BSP

RTOS/0S

PLATFORM

D PROCESSOR ]
CORE CPUFPU Memory  Peripherals

HARDWARE

Fig. 1: MicroEJ Architecture Modules

Three Low Level APIs allow the MicroEJ Architecture to link with (and port to) external code, such as any kind of
RTOS or legacy C libraries:

« Simple Native Interface (see [SNI])
+ Low Level MicroEJ Core Engine (see LLMJVM)
+ Low Level Shielded Plug (see LLSP)

See MicroEJ Architecture Import for usage.

MicroEJ Packs

On top of a MicroEJ Architecture can be imported MicroEJ Packs which provide additional features such as:

« Serial Communications,

« Graphical User Interface,

« Networking,

« File System,
 etc.

Each MicroEJ Pack is optional and can be selected on demand during the MicroEJ Platform configuration step.
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4.2.2 Process Overview

This section summarizes the steps required to build a MicroEJ Platform and obtain a binary file to deploy on a
board.

The following figure shows the overall process. The first three steps are performed within the MicroEJ Platform
builder. The remaining steps are performed within the C IDE.

1. Create a new MicroEJ Platform .
= MicroEJ Platform  =——b Il E1ile])]
configuration project project

'

3. Build the MicroEJ
Platform

MicroEJ
Architecture

2. Select and configure
— additiocnal modules

Microf MicroEJ Platform

Application code

}

4. Build the MicroEJ
Application

|

Application
library file

MicroEJ Workbench

CIDE

C application Architecture

code and Board
Support Package

library file

(microejapp.o) (microejruntime.a)

|

5. Build and link the full
application

|

Executable

application

}

6. Program and test the
application on the
board

Fig. 2: Overall Process
The steps are as follow:

1. Create a new MicroEJ Platform configuration project. This project describes the MicroEJ Platform to build
(MicroEJ Architecture, metadata, etc.).

4.2. MicroEJ Platform 216



MicroEJ Documentation, Revision ed46acae

2. Select which modules provided by the MicroEJ Architecture will be installed in the MicroEJ Platform.
3. Build the MicroEJ Platform according to the choices made in steps 1 and 2.

4. Compile a MicroEJ Application against the MicroEJ Platform in order to obtain an application file to link in
the BSP.

5. Compile the BSP and link it with the MicroEJ Application that was built previously in step 4 to produce a
MicroEJ Firmware.

6. Final step: Deploy MicroEJ Firmware (i.e. the binary application) onto a board.

4.2.3 Concepts

MicroEJ Platform

A MicroEJ Platform includes development tools and a runtime environment.
The runtime environment consists of:

« A MicroEJ Core Engine.

« Some Foundation Libraries.

+ Some C libraries.
The development tools are composed of:

« Java APIs to compile MicroEJ Application code.

« Documentation: this guide, library specifications, etc.

« Tools for development and compilation.

+ Launch scripts to run the simulation or build the binary file.

« Eclipse plugins.

MicroEJ Platform Configuration
A MicroEJ Platform is described by a .platform file. This file is usually called [name].platform,and is stored at
the root of a MicroEJ Platform configuration project called [name]-configuration.

The configuration file is recognized by the MicroEJ Platform builder. The MicroEJ Platform builder offers a visual-
ization with two tabs:
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= O

0 Overview

Platform Properties Platform Content

[General information about this platform., The content of the platform is composed of two parts:

Device: STM3IZFTA6GDISCO €2 Environment: select the architecture,

Name: example ‘¥ Modules: select modules to import in the platform.

fersion: - 72057

Version: 2.1,0-RC201604072057 Platform Configuration

Provider : Microk) Once the content of the platform is chosen, it can be configured.
Vendor URL:

#2| Configuration

Each module can be configured creating a folder with its name along
the .platform file. It could contain:

* an optional [module]. properties file,
* opticnal module specific files and folders.

Meodifying one these files requires to build the platform again,

Build
Generate and test the platform.

X Build Plstform: The new platform is now available and visible in
Available Platforms

Owverview | Content
Fig. 3: MicroEJ Platform Configuration Overview Tab

This tab groups the basic platform information used to identify it: its name, its version, etc. These tags can be
updated at any time.
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Fig. 4: MicroEJ Platform Configuration Content Tab

This tab shows all additional modules (see Modules) which can be installed into the platform in order to augment
its features. The modules are sorted by groups and by functionality. When a module is checked, it will be installed
into the platform during the platform creation.

Modules

The primary mechanism for augmenting the capabilities of a MicroEJ Platform is to add modules to it.

A MicroEJ module is a group of related files (Foundation Libraries, scripts, link files, C libraries, Simulator, tools,
etc.) that together provide all or part of a platform capability. Generally, these files serve a common purpose. For
example, providing an API, or providing a library implementation with its associated tools.

The list of modules is in the second tab of the platform configuration tab. A module may require a configuration
step to be installed into the platform. The Modules Detail view indicates if a configuration file is required.

Low Level API Pattern
Principle

Each time the user must supply C code that connects a platform component to the target, a Low Level APl is defined.
There is a standard pattern for the implementation of these APIs. Each interface has a name and is specified by two
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header files:

« [INTERFACE_NAMET.h specifies the functions that make up the public API of the implementation. In some
cases the user code will never act as a client of the API, and so will never use this file.

o [INTERFACE_NAME]_impl.h specifies the functions that must be coded by the user in the implementation.

The user creates implementations of the interfaces, each captured in a separate C source file. In the simplest form
of this pattern, only one implementation is permitted, as shown in the illustration below.

Low Level API

LLXXX.h LLXXX_implL.h
void LLXXX init(); void LLXXX _TMPL init();
application.c MYIMPL.c
#tinclude "LLXXX.h" #include "LLXXX_impl.h"
Main() { Void LLXXX IMPL init() {

LLXXX_init(); // implementation code
¥ }

Fig. 5: Low Level API Pattern (single implementation)

The following figure shows a concrete example of an LLAPI. The C world (the board support package) has to imple-
ment a send function and must notify the library using a receive function.
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MicroEJ Application

Java communication library (ECOM Comm)

MicroEJ world call LLAPI
LLAPI notify library
LLCOM.h LLCOM_impl.h
void LLCOM dataReceived(..); void LLCOM IMPL sendData(..);
LLAPI
C world call LLAP! implement LLAPI
driver_interrupt.c driver.c
#include "LLCOM.h™ #include "LLCOM_IMPL.h"
IRQ data received(..) { void LLCOM IMPL sendData(..) {
LLCOM_dataReceived(..); // implementation code
1 1
J J

Fig. 6: Low Level APl Example

Multiple Implementations and Instances

When a Low Level API allows multiple implementations, each implementation must have a unique name. At run-
time there may be one or more instances of each implementation, and each instance is represented by a data struc-
ture that holds information about the instance. The address of this structure is the handle to the instance, and that
address is passed as the first parameter of every call to the implementation.

The illustration below shows this form of the pattern, but with only a single instance of a single implementation.
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Low Level API
LLXXX.h LLXXX_implL.h
void LLXXX init(LLXXX* env); void LLXXX TMPL init(LLXXX* env);

/4 /4

MYIMPL.h
#include "LLXXX.h™

typedef struct MYIMPL {
struct LLXXX header;
//specific fields defined here
} MYIMPL;
void MYIMPL_new(MYIMP* env);

application.c MYIMPL.c
#include "MYIMPL.h" #include "MYIMPL.h"
#define LLXXX_ IMPL MYIMPL
MYIMPL instance; #include "LLXXX impl.h"
Main() {
MYIMPL_new(&instance); Void LLXXX_IMPL_init(LLXXX* env) {
LLXXX init(&instance); // implementation code
} 7 } 7

Fig. 7: Low Level API Pattern (multiple implementations/instances)

The #define statementin MYIMPL.c specifies the name given to this implementation.

4.2.4 MicroEJ Platform Creation

This section describes the steps to create a new MicroEJ Platform in MicroEJ SDK, and options to connect it to an
external Board Support Package (BSP) as well as a third-party C toolchain.

MicroEJ SDK must be started on a new empty workspace.

MicroEJ Architecture Import

The first step is to choose and import a MicroEJ Architecture. MicroEJ Corp. provides MicroEJ Evaluation Ar-
chitectures for most common microcontroller instructions sets and compilers at https://repository.microej.com/
architectures/'.

MicroEJ Architecture files ends with the . xpf extension, and are classified using the following naming convention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]/[VERSION]/[UID]-[VERSION]-[USAGE].xpf

« ISA:instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32,...).

! Ifthe requested MicroEJ Architecture is not available for evaluation or to get a MicroEJ Production Architecture, please contact your MicroEJ
sales representative.
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+ TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48).

+ UID:Architecture unique ID (e.g. flopi4G25).

« VERSION: module version (e.g. 7.12.0).

« USAGE = eval for evaluation Architectures, prod for production Architectures.

For example, MicroEJ Architecture versions for Arm® Cortex®-M4 microcontrollers compiled with GNU CC toolchain
are available at https://repository.microej.com/architectures/com/microej/architecture/CM4/CM4hardfp_GCC48/
flopi4G25/.

Once you downloaded a MicroEJ Architecture file, proceed with the following steps to import it in MicroEJ SDK:
« Select File > Import > MicroEJ > Architectures .
« Browse an .xpf file or afolder that contains one or more an . xpf files.

+ Check the |agree and accept the above terms and conditions... box to accept the license.

« Clickon Finish button.

MicroEJ Pack Import

The next step is to choose and import a MicroEJ Pack. MicroEJ Corp. provides MicroEJ Packs to provide additional
features.

MicroEJ Packs are distributed in two packages:

« MicroEJ Architecture Specific Pack provided at https://repository.microej.com/modules/com/microej/
architecture.

« MicroEJ Generic Pack provided at https://repository.microej.com/modules/com/microej/pack/.

MicroEJ Architecture Specific Pack

MicroEJ Architecture Specific Packs contain compiled libraries archives and are thus dependent on the MicroEJ
Architecture and toolchain used in the MicroEJ Platform.

MicroEJ Architecture Specific Packs files ends with the .xpfp extension and are classified using the following
naming convention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]-[NAME]-pack/[VERSION]/[UID]-[NAME]-[VERSION].xpfp

« ISA:instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32,...).
+ TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48).

« UID: Architecture unique ID (e.g. flopi4G25).

« NAME : pack name (e.g. ui).

« VERSION: pack version (e.g. 13.0.4).

For example, MicroEJ Architecture Specific Pack Ul versions for Arm® Cortex®-M4 microcontrollers compiled
with GNU CC toolchain are available at https://repository.microej.com/modules/com/microej/architecture/CM4/
CM4hardfp_GCC48/flopi4G25-ui-pack/.
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MicroEJ Generic Pack

MicroEJ Generic Packs can be imported on top of any MicroEJ Architecture.

They are classified using the following naming convention:

com/microej/pack/[NAME]/[NAME]-pack/[VERSION]/

« NAME : pack name (e.g. bluetooth).
« VERSION: pack version (e.g. 2.1.0).

For example, MicroEJ Generic Pack Bluetooth versions are available at https://repository.microej.com/modules/
com/microej/pack/bluetooth/bluetooth-pack/.

Legacy MicroEJ Generic Packs files end with the . xpfp extension and can be manually imported on older MicroEJ
Platforms.

For example, the Legacy MicroEJ Generic Pack NET version 9.2.3 is available at https://repository.microej.com/
modules/com/microej/pack/net/9.2.3/net-9.2.3.xpfp.

Manual Import

This section is only relevant for older MicrokJ Platforms with no Module Description File. These Platforms are built
from MicroEJ Architecture Specific Packs and Legacy MicroEJ Generic Packs (packaged as .xpfp files) that must
be imported manually.

Once you downloaded a MicroEJ Pack file, proceed with the following steps to import it in MicroEJ SDK:
+ Select File > Import > MicroEJ > Architectures .
« Browse an .xpfp file or a folder that contains one or more an . xpfp files.

+ Check the |agree and accept the above terms and conditions... box to accept the license.

« Clickon Finish button.

MicroEJ Platform Configuration

The next step is to create a MicroEJ Platform configuration:
+ Select File > New > MicroEJ Platform Project... .
+ The Configure Target Architecture page allows to select the MicroEJ Architecture. This can be changed later.

- Clickon Browse... button to select one of the installed MicroEJ Architecture.

- Uncheck the Create from a platform reference implementation box.

« Click on Next button. The Configure platform properties page contains the identification of the
MicroEJ Platform to create. Most fields are mandatory, you should therefore set them. Note that their values
can be modified later on.

+ Click on Finish button. A new project [device]-[name]-[toolchain] is being created containing a
[name].platform file. The Platfor